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About this Book 
Altair Compose software is an environment for doing calculations, manipulating and 

visualizing data (including from CAE simulations or test results), programming and 

debugging scripts useful for repeated computations and process automation. This 

guide gives you a complete introduction of Altair Compose. Problem-based Altair 

Compose examples have been given in a simple and easy way to make your learning 

fast and effective.  

This guide has been prepared for beginners and experienced users to help them 

understand basic to advanced functions of Altair Compose. The concepts are 

explained with examples and you will also be guided with videos. So, after working 

through the examples you should be familiar with the software. 

We assume you have some knowledge of computer programming and understand 

concepts like variables, constants, expressions, statements, etc. If you have done 

programming in any other high-level language like C, C++, Java or MATLAB, then it will 

be much easier to learn Altair Compose.  

Please note that a commercially released software is a living “thing” and so at every 

release (major or point release) new methods, new functions are added along with 

improvement to existing methods. This document is written using Altair Compose 

2017.3 version. 

 

 

 

 
Disclaimer  
Every effort has been made to keep the book free from technical as well as other mistakes. However, publishers and 
authors will not be responsible for loss, damage in any form and consequences arising directly or indirectly from the 
use of this book.  
© 2018 Altair Engineering, Inc. All rights reserved. No part of this publication may be reproduced, transmitted, 
transcribed, or translated to another language without the written permission of Altair Engineering, Inc. To obtain this 
permission, write to the attention Altair Engineering legal department at:  
1820 E. Big Beaver, Troy, Michigan, USA, or call +1-248-614-2400. 
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1. Introduction to Altair 

Compose 
Altair Compose provides engineers, scientists and product creators a high level, multi-

language programming environment which enables you to efficiently perform 

numerical computations, develop algorithms, analyze & visualize various types of 

data. It supports multiple languages such as Tcl or Python and offers OML (Open 

Matrix Language) a matrix-based numerical computing language for all types of math 

from solving matrix analysis, differential equations to performing signal analysis and 

control design. It is a programming environment that allows you to build your script 

and debug them. So that you can identify errors faster and optimize algorithms faster. 

We can write the script in Altair Compose and visualize answers / results side by side. 
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 Benefits of Altair Compose  
One Product for All Types of Math 

 

The base product provides all the math functionality and there is no need of any 

additional toolboxes for signal analysis, control design, robust design, etc. 

Rapid algorithm development 

 
A comprehensive set of tools enable rapid development of custom numerical code. 

The matrix-based language, authoring and debugging tools along with access to a 

broad set of math libraries and utilities not only covers a wide range of your needs 

but also enables you to explore multiple approaches and find solutions faster than 

with spreadsheets or traditional programming languages such as C/C++. Easy 

diagnosis of code through interactive debugging reduces development effort. 
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Robust design exploration and verification 

 

 
The Open Matrix Language (OML) is not only incredibly easy to use, but also 

compatible with industry standards such as Octave. The interactive desktop 

environment in Altair Compose allows users to quickly debug code thus allowing for 

streamlined and faster troubleshooting of errors without the need to embed 

diagnostic statements or code. 

Easy engineering data access and processing 

There is a built-in suite of comprehensive engineering calculations and CAE data, 

including result readers, to provide quick access to a large set of data formats for pre- 

and post-processing needs. Data can then be exported into various formats for easy 

import into Altair HyperWorks or other third-party products. 

1.1.1 Integrated Development Environment 

Script Editor 

Modern script editor with syntax highlighting, smart indentation, collapsible sections 

including code folding, bookmarking, searching and toggling to display on/off line 

numbers. Script editor also allows you to split the screen into multiple views for more 

interactive authoring and execution. 
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Command Window 

A fully featured command window with command completion, code editing and 

display print command outputs during script execution from the editor allowing for 

visual and interactive code inspections during runtime. 

Variable Browser 

Variable browser displays all the user-generated and global workspace variables 

including their name, value, type and scope. Options to easily monitor variable values 

during debugging. 

Powerful Debugger 

Powerful debugger with options to easily monitor variable values via watch window, 

track paths traced while executing scripts via call stack window and display all 

breakpoints in the debugging session via the breakpoints window. 

Command History Window 

Command history window not only displays all commands entered while 

programming, but also enables quick execution with support for double-clicking on 

each command or drag/drop into the command window. 

File Browser 

File browser allows direct access to existing program files on disk. 

Project Browser 

Intuitive project browser with a hierarchical structure of all the scripts, plots, and 

matrices for easy navigation. 
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1.1.2 Extensive Math Libraries 

 

Altair Compose can be used as a computational tool in fields of physics, chemistry, 

math and all engineering streams. Altair Compose supports around 584 mathematical 

functions (in version 2017.3). These functions range from Differential equations, 

Signal processing, Plotting, Elementary math, Linear Algebra, Trigonometry, Data 

Structure, Statistical Analysis and Optimization, File I/O direct import of CAE Data, 

Polynomial Math, and Calculus. Etc. 

1.1.3 Data Visualization, Plotting and Reporting 

In order to be able to visualize scripts and algorithms, Altair Compose provides a rich 

set of 2D/3D visualization capabilities. Graph properties and attributes can be 

modified easily and interactively with context menus to set plot titles, labels, axis 

labels, legends, and tick mark labels. Report generation can be done. 

1.1.4 Connectivity 

Altair Compose provides tools to read and extract data from Computer Aided 

Engineering (CAE) models including Altair HyperWorks models and results 
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1.1.5 Function and Path Management 

Open Matrix Language (OML) in Altair Compose offers the ability to use variable left-

hand side (LHS) and right-hand side (RHS) for an equation giving users a lot of 

flexibility. Define functions on the fly without the need to create a function file. 

Scoping rules gives users access to all variables local to the function where they’re 

defined and assigned. 

1.1.6 Open Matrix Language (OML) Interpreter 

Interpreter for enhanced interaction to support interruption of long scripts. Provides 

an extension to the variable browser to support additional objects; includes syntax 

highlighting and auto completion and provides all the debugging features. 

1.1.7 Edit, Execute and Debug Python Scripts in Altair Compose 

Altair Compose 2017 Integrated Development Environment (IDE) supports Python as 

a new scripting language. This allows you to easily edit, execute and debug Python 

scripts directly within the Altair Compose user environment. 

1.1.8 Support for GUI Commands 

Altair Compose 2017 offers new GUI commands to create interactive UI directly from 

Open Matrix Language (OML) scripts. Standard GUI components (button, entries, list 

box, etc.) can be arranged and connected to user functions for interactive data 

processing. 

1.1.9 Interfacing with Other Languages  

Compose supports OML, Tcl and Python languages. The use of the interpreter 

language is first defined by the script being executed.  

Command Windows for either OML or TCL or Python file languages can be displayed 

and commands can be entered and executed directly.  
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The three languages are dependent and there is a communication or bridge 

between them.  

Overall Altair Compose is a language, it’s also programming environment and 

provides with whole bunches of math library along with visualization. 

 

https://www.youtube.com/watch?v=lL3neLM0Rt0 

https://www.youtube.com/watch?v=lL3neLM0Rt0
https://www.youtube.com/watch?v=lL3neLM0Rt0
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2. Starting with Altair Compose 
This section introduces the Altair Compose environment and its graphical user 

interface. 

 The Environment 
Altair Compose is an Integrated Development Environment (IDE) and can be said to 

offer several modes: Authoring, Debugging Batch and Console mode. The Authoring 

mode is active by default and is used to create, edit and execute scripts. 

The below Figure shows the Altair Compose in authoring mode. The description of 

various toolbars in the default authoring mode is described below. 

 

Figure 2.1 : Altair Compose in Authoring Mode 

The “Property Editor” is not enabled by default. To enable it, you can either click on 

“View” – “Property Editor” (see Figure 2.2) or simply press F3.  
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Figure 2.2 : Altair Compose view menu 

The Debug mode enables you to debug scripts. The debugger must be turned ON (use 

F5) on a given file. When turned on, additional components such as watch window 

are added to the environment. They are removed when the debugger is stopped.  

In addition to the graphical, interactive mode described previously, compose can also 

be used in Console mode. Console mode is basically a non-graphical mode that 

exposes, the OML command prompt in a shell. From this prompt, all 

supported OML commands can be executed, with the exception of all GUI-related 

commands, such as plots. 

Now we will look at each function in the graphical user interface, starting with the file 

toolbar, 

2.1.1 File Toolbar 

Creating a new OML file. 
 

 

Figure 2.3 : To create new oml file 
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The highlighted white paper icon indicates that a new “untitled.oml” file will be 
created. 

Opening the OML file 

 

Figure 2.4 : To open existing oml file 

The highlighted folder icon indicates that an existing. oml file will be opened. 

Saving the file 

 

Figure 2.5 : To save the oml file 

The single disc icon indicates that the current file will be saved. Three disc indicates 

saving all opened files. 

2.1.2 Debugging Toolbar 

 

Figure 2.6 : Compose debugging toolbar 

It helps in evaluating and debugging the current script file. [Refer section 9.2] 
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2.1.3 Project Browser 

 

Figure 2.7 : Altair Compose Project Browser 

The project browser contains all open files and plots of the current session. A project 

can contain multiple files, plots and editors like variable editors (variable editors open 

on a double click on a variable in a browser and allows easy visualization and edition 

of variables) One can also search for a particular file etc. by using the magnification 

glass symbol  and the find  button to search for an entity by its name or part of 

the name. 

 

2.1.4 Property Editor 

 

Figure 2.8 : Altair Compose Property Editor 

The property editor displays various information about the currently selected item in 

the Project Browser. In case of plots, it can also be used to change properties. The 

information can be viewed categorically or alphabetically by selecting the 

corresponding tab. 
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2.1.5 Session Information 

 There are two windows present in session information. 

• Command History  

• Variable Browser Window 

 

Figure 2.9 :  Altair Compose Command History & Variable browser window 

It displays all commands processed by date. It allows for quick execution of 

commands. Double clicking executes the selected command. We can also drag and 

drop commands into the command window or editor window. 

The variable browser tab lists all the variables of the session. It identifies the variables 

by their value, type and scope of the function. We can delete or modify the variables. 

We can also open a matrix in the matrix editor to modify a matrix. 

2.1.6 Editor Window 

 

Figure 2.10 : Altair Compose Editor window. 
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It allows users to create or open files for authoring and execution. It supports syntax 

highlighting, smart indentation, collapsible sections, bookmarking and displaying line 

numbers. 

2.1.7 Bookmark Window 

 

Figure 2.11 : Altair Compose Bookmark Window. 

The bookmark window displays the bookmarks in the open project. Bookmarks refer 

to certain lines in a file and can be named accordingly. 

2.1.8 OML Command Window 

 

Figure 2.12 : Altair Compose OML Command Window. 

The OML command window allows execution of Altair Compose or Tcl language 

commands. Separate command windows are available for different languages which 

are accessible from the view menu. It also displays print commands from evaluated 

scripts in editor. 
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2.1.9 File Browser 

 

Figure 2.13 : Altair Compose File Browser. 

File browser allows for browsing folder contents, adding new files and deleting 

existing files. The displayed list can be filtered by file types, or by matching a pattern. 

When right-clicking you can open files or create new scripts from them. 

2.1.10 Library Browser 

 

Figure 2.14 : Altair Compose Library Browser 
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The library browser lists all categories, for which OML commands exist that can be 

used in the command window. It is possible to drag and drop the commands from 

the library browser into the “Scripting File Window”, but not into the “Command 

Window”. 

2.1.11 Help Options 

Altair Compose comes with a knowledge base where you can search, work through 

tutorials and more. The easiest way to access it is by pressing F1 on your keyboard. 

Your web browser will open and you can access the help files and search for 

commands and/ or tutorials. 

 

Figure 2.15 : Altair Compose Help Browser 

When you search for a new command, we recommend using a few words, since 

commands might be used in different contexts than you might expect. Sometimes, it 

can be useful to use synonyms if the search is not successful at the first attempt. 

We can select objects with the right mouse button which gives help access to that 

object from within the editor or command window. It also contains other options 

depending on the object and window. See Figure 2.16. 
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Figure 2.16 : Altair Compose options on help. 
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General help can be accessed through the File > Help menu: 

 

Figure 2.17 : Altair Compose General Help Window 

2.1.12 Auto Complete Feature 

Altair Compose has an auto-complete feature for functions and arguments. When you 

type a particular function, it automatically lists all related functions.  

 

Figure 2.18 : Autocomplete feature 
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2.1.13 Drag and Drop Feature 

To quickly open files, compose includes the ability to drag and drop files from the 

file browser to the editor windows. See Figure 2.19. 

 

Figure 2.19 : Altair Compose File Drag and Drop features 

2.1.14 Case Sensitivity and First Index 

Altair Compose is case sensitive. Ending a command line with ‘;’ prevents Altair 

Compose from echoing the result of the command in the command window. 

 

Figure 2.20 : Altair Compose Case sensitive nature 

 ‘1’ is the first index of an element in an array of matrix component. 

 

Figure 2.21 : Altair Compose first index digit in an array 

 

Drag and drop 
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 Exercise 

2.2.1 Working with Altair Compose Authoring Mode and Batch 

Mode.   

This exercise will explore Altair Compose while in the Authoring and Batch modes.  

Step 1: Launch Altair Compose 

 

Figure 2.22 : Shortcut icon to Altair Compose. 

Double click on the icon. This launches the MATH GUI of Altair Compose in the 

Authoring Mode and by default a file named “Untitled1.oml” exists in the Editor 

Window.   

 

Figure 2.23 : Altair Compose GUI. 



 
 

34 
 

 

Step 2: Enter a Command into the Command Window and Execute Command from 

Command History Window 

1. In the Command Window, enter the following command: “disp(‘This is a 

tutorial’)”. The command typed above will display “This is a tutorial” in the 

Command Window.    

 

Figure 2.24 : Altair Compose “disp” command    

Tip:  The Command History Window now includes a reference to the command 

entered in Step 1 and the date the command was executed.  

 
Figure 2.25 : Command History 

Double click with the left mouse button on the command in the Command History 

Window “disp('this is a tutorial’)” 

Notice how the command and the result are printed to the Command Window.  

 

 

 

 

Figure 2.26 : Command Window 

2. Press the Up Arrow on the keyboard when in the Command Window to get the 

most recent command on the command line.    

Tip: Pressing the Up Arrow multiple times places on the command line commands 

entered further back in the command history list.  Pressing the Enter button will 

execute the current command on the command line. 
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Step 3: Drag a Command from Command History Window into the Editor Window 

1. In the Command History Window, with the left mouse button select the 

command “disp('This is a tutorial’)”.  

2. While continually holding the left mouse button drag the selected command into 

the Editor Window into “Untitled1.oml”.  

 

Figure 2.27 : Editor Window. 

3. Pressing Enter on the keyboard will add an additional line to the script 

“Untitled1.oml”.  

4. Press the Run file button, with the left mouse button to execute the commands 

in “Untitled1.oml”.  The results of the script “Untitled1.oml” are printed in the 

Command Window.  

5.     Drag a mouse over save file icon. Save your .oml file in the folder of your choice. 

Step 4: Open and Execute a Script from the File Toolbar  

1. In the File Toolbar, using the left mouse button press the Open File icon.  

Please make sure to select the folder or yellow section in the File Toolbar.   

    b  Figure 2.28 : Run button 
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Figure 2.29: To open the existing file 

If the mouse pointer is left over the folder for a brief period, an Open File message 

appears in the toolbar.  

2. In the Open File dialog box, browse to the folder location for ”*.oml “and select 

the file which has to be opened and press the Open button to open the “*. oml “ 

file script.  

Opening a new script will create a new tab in the Editor Window. 

Execute the script by pressing Evaluate File or Run file   icon with the left 

mouse button.  

Step 5: Open and Execute a Script from the File Browser  

1. As shown in Figure 2.30, verify that the path points to the folder to be opened in 

the File Browser window.  To open the Select Directory dialog box, please press 

the yellow folder icon with the left mouse button in the File Browser window.  

2. In the File Browser window, press the right mouse button on the “*. oml file” and 

select the Open command from the menu that appears as shown in the figure. 
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Figure 2.30 : To open oml file. 

 

Anywhere in the Editor Window while in the”*. oml file” tab press the right mouse button 

and select Run File from the menu that appears.  

3. To close the File Browser, press the left mouse button on the   icon in the 

upper right-hand corner of the File Browser window.  Please be sure not to select 

the icon                     in the upper right corner of the GUI which will close the entire 

application.  

4. Use the View menu and select File Browser to open the File Browser window.  

Step 6: Open a File from the File Browser Window by Dragging and Dropping it to 
the Editor Window  

1. In the File Browser, verify the path of the “*.oml file” and the folder to be opened. 

2. With the left mouse button select the “*. oml file”.  While continuing to hold 

down the left mouse button, drag and drop the file into the Editor Window area 

and release the left mouse button.  

Tip:  The Editor Window is now populated with the contents of the file new “*.oml 

file”. Executing the script “*.oml file” using the Run File button  
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Step 7: Outline Controls in Altair Compose  

1. In the Editor Window consider an example code. 

 

Figure 2.31 : Euler_spiral_example.oml 

2. Along the right side of the Editor Window there are some “-” symbols for blocks 

of code at lines 6 and 19.  Please press the “-“ icons on lines 6 and 19 using the 

left mouse button.  

Notice the “blocked” code is no longer shown between lines 7 and 15 and 

between 20 and 22.  

3. As shown in in the figure below, please go to View->Outlining->Expand All to show 

all “collapsed” programming blocks.  In this case lines 7 to 15 and 20 to 22 

“collapsed” in step 2.  
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Figure 2.32 : Altair Compose view menu. 

4. Place the curser on any line between 6 and 15 using the left mouse button.  

5. From the Outlining menu shown in step 3, please select Toggle Outlining to 

“collapse” the “function” programming block between lines 6 and 15.  

6. In the Outlining menu, please select Stop Outlining to remove the collapsible 

programming blocks.  

Similarly, in the Outlining menu, please select Start Outlining to enable Altair 

Compose to collapse programming blocks.  

Step 8: Add Bookmarks and Scroll Through the Bookmarks  

In the Editor Window, consider an example “euler_spiral_example.oml” (as shown in 

above step 7).  

1. Use your mouse and place the cursor at line 1 in the Editor Window.  

2. Go to the Edit->Bookmarks Menu and select Toggle a Bookmark as shown in the 

figure below.  
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Figure 2.33 : Altair Compose edit menu.  

Step 3 Inserts a bookmark at line 1 indicated by an    icon-a bookmark flag. 

Pressing the left mouse button when the mouse pointer is in the gray area on the 

left side of the Editor Window will produce a “break point” for debugging which 

is beyond the scope of this exercise.  

3. Repeat steps 2 and 3 on lines 19 and 29 to create additional bookmarks.   

4. In the Edit-Bookmarks menu, advance to the next book mark by selecting “Next 

Bookmark” or “Previous Bookmark” with the left mouse button or use shortcut 

keys – Ctrl+K and Ctrl +N. 

5. Launch the Bookmarks Utility window by selecting Bookmarks in the View Menu.  

The Bookmarks Utility window lists all the bookmarks in Altair Compose along 

with the file and line number associated with each bookmark.  

 

Figure 2.34 : Altair Compose Bookmark Window 



 
 

41 
 

 

6. To “disable” but not delete a bookmark at line 1 in the Bookmarks Utility, uncheck 

the box next to the bookmark for line 1. Disabling a bookmark allows Altair 

Compose to ignore the disabled bookmark when parsing though bookmarks using 

the next or previous bookmark utilities.  

7. Select Clear all Bookmarks   either in the Bookmarks Utility window or the 

Bookmarks Menu to remove all the bookmarks.    

8. Select Yes to the message which appears asking if you want to Clear all 

bookmarks.   

9. Go to the View menu and uncheck the box next to “bookmarks” to Close the 

Bookmarks Utility or by click on the  in the top right corner of the Bookmarks 

Utility window.  

 Step 9: Record and Play a Macro in the Editor Window  

1. Select the tab of the “Untitled1.oml file” in the Editor window using the left 

mouse button.  

2. Select Tools->Marco->Start Recording to start recording a macro.  

3. Click on Line 1 of Untitled1.oml  

4. Type “a = 1;” on line 1 and press Enter.  

5. Type “b = 2;” on line 2 and press Enter.  

6. Type “c = 5;” on line 3 and press Enter.  

7. Select Tools->Macros->Stop Recording in the Macros menu to stop recording the 

macro.  

8. Place the cursor on line 4 of “Untitled1.oml” and select Tools->Macro->Run 

Current Macro from the Macro menu.  

9. Notice that lines 4, 5 and 6 are populated with the following information:  

a= 1; 

b = 2; 
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c = 5; 

The macro stored the steps between your selection of Start Recording and Stop 

Recording. 

Step 10: Indent and Comment Lines in the Editor Window  

1. Press down on the left mouse button and highlight the first three lines in the 

Editor Window of “Untitled1.oml”.  

2. Right click the mouse to get the Editor Window Context Menu.  

3. From the Context Menu, select Increase Indent to indent all three lines to the 

right or use the tab button. 

4. Similar to step 1 above, highlight lines 4, 5, and 6 in the Editor Window of 

“Untitled1.oml”. 

5. Right click the mouse to get the Editor Window Context Menu and select 

Comment Selection.   

The highlighted lines have a “%” character placed at the start of the line which 

indicates the lines are “comments” in the script.  “Commented” lines are 

ignored when Altair Compose executes the commands within the script.   

Step 11: Open a New Tcl File in the Editor Window  

1. As shown in the figure below, open a Tcl script by selecting File->New->Tcl File 

with the left mouse button.  
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Figure 2.35 : To open new Tcl File. 

Notice that a new file called “Untitled2.tcl” shows in the editor window  

2. In the Tcl Editor Window (not the command window) type:  

set b 2  

puts $b  

3. Press the Run File button  to execute the contents of the Editor Window.  

Notice that in the Tcl Command Window a new line is added and shows 2  

4. Close the Tcl Window by unchecking the box next to “Tcl Window” in the View 

Menu or by selecting the  icon with the left mouse button in the top right 

corner of the Tcl Command Window. Close the Tcl file by clicking on the x next to 

the filename in the tab:   . 

Step 12: Use Tcl Command Window to Evaluate Tcl Commands  

Launch the Tcl Command Window by going to the View menu and checking the box 

next to Tcl Window with the left mouse button as shown in the figure below.  The Tcl 

Command Window executes tcl scripting commands.  
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Figure 2.36 : Tcl window 

 

1. In the Tcl Command Window, type “set a 1” and press Enter to set the value of 

“a” to 1. 

Type “puts $a” in the Tcl Command Window to print the value of “a” in the command 

window. 

Step 13: Save the Project on the Desktop  

Press the right mouse button on the tab of the “euler_spiral_example.oml” and select 

Add to Project to add the script to the current Altair Compose project.  Altair Compose 

scripts must be explicitly added to Altair Compose projects.  

1. From the File menu, select Save As.  

2. Set the Save as type to dropdown menu to Project (*.aprj).    

3. Browse to the Windows Desktop and enter a filename.  

4. Click Save to save the project.  
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Press the Yes button with the left mouse button when a window appears asking “Do 

you want to save plot(s) with the project?”.  

Step 14: Delete the Plots, Close the Altair Compose Script Files, and Close Altair 
Compose  

1. In the Project Browser, right click on the Plots folder and select Delete All. This 

deletes all the plots from the Project Browser and the Editor Window.  

2. Right click on the Files folder in the Project Browser and select Close Files.  

Notice that step 2 only closes the files in the Editor Window that are part of the 

project.  

3. Close Altair Compose either by clicking on the  in the top right corner or by 

selecting Menu>File Exit.  Left click No for any prompts to save individual "*.oml” 

files. 

Step 15: Invoke the Console in Standalone Mode  

1. From the Windows task bar select Start > All Programs > sT Compose 2017.3 > sT 

Compose 2017.3 Console which will open a new window with a black background 

and a command prompt proceeded by “>>>”.  The window opened allows direct 

interaction with the Altair Compose command interpreter.   

2. Type “a = 1” and click on Enter.  The console will print “a = 1” on the line below 

the command.  

Close the console by clicking on the  in the top right corner of the console.  

Step 16: Run Altair Compose in Batch Mode  

From the Windows Taskbar, select Start > All Programs > sT Compose 2017.3 > sT 

Compose 2017.3 Command Prompt which will open a command window which has 

all environment variables set to run Altair Compose in batch mode.  
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1. In the command window  

“compose_batch.bat 

c:\Compose_Training\chapter1\signal_processing_example.oml”  

2. Close the window by clicking on the   at the top of the window.  
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3. Basic Commands, Data Types 

and Mathematical Operators 
This section will introduce some basic concepts used in Altair compose: Basic built-in 

commands, which are most frequently used in the program. This section also explains 

different data types, which are commonly used as well as their formats. Altair 

Compose can be used as a calculator for simple Mathematical operations. 

 Basic Concepts 

1. Variable Initialization 

To store a value in a program or in any session in Altair Compose, a variable is used. 

The Variable window shows variables that have been created and their values. 

name_of_variable = value or expression 

For example, as shown below. 

 

Figure 3.1 : Variable initialization in Altair Compose 

 
2. Use of Semicolon (;) 

A semicolon (;) indicates the end of a statement. Whenever you want to suppress 

and hide the output for an expression, you can add a semicolon after the 

expression. 

 

Figure 3.2 : Semicolon used in Altair Compose 
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3. Adding Comments 

The percent symbol (%) is used for indicating a comment line. A comment is not 

executed when the script is run.  For example: 

 

Figure 3.3 : % symbol in Altair Compose 

4. Colon Notation 

The colon (:) is used to specify iterations, create vectors, subscript arrays and to 

create a vector of indices to select rows, columns or elements of arrays. Example 

shown below is for iteration. [Note: Refer to section 5 for examples on vector and 

matrix.] 

s 

Figure 3.4 : Colon natation in Altair Compose 

 Basic Commands 
Most frequently used commands related to files and directory management are 

discussed in this section. The importance of explaining these commands is to make 

the user more familiar with handling Altair Compose. Over 584 commands and 

functions are included in Altair Compose (version 2017.3). These commands can be 

separated into groups: 

• General Commands 

• System Commands 
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• Mathematical Operators 

• Mathematical Functions 

• Logical and Looping Operators and Commands 

• Plotting Commands 

• File I/O and CAE Reader Commands 

3.2.1 General Commands 

The following general commands are explained in more detail below. 

• funclist 

• clear 

• clc 

• close/close all 

• who 

• whos 

• date 

• tic/toc 

• clock 

• pause 

“funclist” 

This command generates a list of all commands supported by Altair Compose. 

 

Figure 3.5 : Altair Compose “funclist” of functions. 
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“clear” 

This command clears all variables from memory. Example is given below. 

 

Figure 3.6 : Altair Compose “clear” command 

“clc” 

This command empties out the display of the command window. Example is given 

below. 

 

 

“close/close all” 

This command closes one or all plots.  

Starting a script with the following three commands is a good programming practice.  

Example is given below. 

Figure 3.7 : Altair Compose “clc” command 
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Figure 3.8 : Compose “close all” command 

Figure 3.9 : Altair Compose editor window 
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“who” 

This command lists all variables in the current scope. Example is given below.

 

Figure 3.10 : Altair Compose “who” command 

“whos var” 

This command lists all variable names in the current scope and the variables 

size/bytes/class. If a single variable name for “var” is given, the function “whos” will 

list only the specified variable information. Example is given below. 

 

Figure 3.11 : Altair Compose “whos” command 



 
 

53 
 

 

“date” 

This command shows the current date. Example is given below. 

 

  Figure 3.12 :Altair Compose “date” command 

“tic/toc” 

This command calculates the time between the “tic” command execution and the 

“toc” command execution. Example is given below. 

 

Figure 3.13 : Altair Compose “tic/toc” command 

“clock” 

This command shows todays date and time as a vector which will be in the form of 

year, month, day, hour minute and second. It will be in 24 hr clock. Example is given 

below 

 

Figure 3.14 : Altair Compose “clock” command 

“pause” 

This command will “pause” the process for the given ‘n’ seconds. Example is given 

below. 

 

Figure 3.15 : Altair Compose “pause” command 
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3.2.2 System Commands 

System commands let you perform some of the operating system commands from 

within the context of Altair Compose. 

“path(‘string’, ‘string’, ‘…’)” 

“Path” command with zero arguments lists the current path that Altair Compose 

would use for searching the path. We can replace the path through N arguments as 

shown in the example below. 

 

 

Figure 3.16 : Altair Compose “path” command 

“add path(‘string’, ‘string’, ‘…’)” 

This command appends the argument list to the current search path list. The old path 

is searched first followed by the new directories specified by the “addpath” 

command. Example is given below. 

 

Figure 3.17 : Altair Compose “addpath” command 
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“rmpath(‘string’, ‘string’, ‘…’)” 

This command removes the directories specified from the current search path. 

Example is given below. 

 

Figure 3.18 : Altair Compose “rmpath” command 

“pwd” 

This command lists the present working directory. The “pwd” command lists the 

current working directory where Altair Compose will write/read files to/from that are 

not specified with an absolute or relative path. The value of this command is the same 

value specified at the top of the File Browser window in the Altair Compose GUI. 

Example is given below. 

 

Figure 3.19 : Altair Compose “pwd” command 

“dir” 

This command lists the files present in the working directory of MS DOS windows. 

Example is given below. 
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Figure 3.20 : Altair Compose “dir” command 

“cd string/ chdir (‘string’)” 

This command changes the present working directory. Please note ‘.’ Is the current 

directory and ‘..’ is the directory directly above the current working directory. Also 

please note that the working directory in the file browser window updates to the 

directory specified in the “cd/chdir” commands. 

“mkdir string/ mkdir(‘string’)” 

This command adds a new directory in the current directory. The return value of the 

function is an integer. 1 implies the directory is successfully created. 0 implies error 

occurred in creating directory. 

“rmdir string/ rmdir (‘string’)” 

This command removes a directory in present working directory. The return value of 

the function is an integer. 1 implies successfully removed the directory and 0 implies 

error in removing the directory.  
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“setenv string / setenv (‘string’, ‘string’)” 

This command sets or creates the Altair Compose environment variable identified in 

the first-string argument to the second-string argument. The environment variables 

created in Altair Compose only apply to the current Altair Compose session. 

“system (‘string’)”  

This command executes an operating system command in MS DOS/Windows 

command line. Any settings changed using the “system” command is permanent and 

will persist after Altair Compose is closed. Example is given below. 

 

Figure 3.21 : Altair Compose “system” command 

 Data Types 
Data is stored in the form of an array[Vector]. A single number (1,2,3…) or a letter 

(a,b,c…) is  considered as a one dimensional array of size 1. An Array may contain 

either data of the same data type (e.g. only numbers, only letters or only logical value) 
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or data of different data types (e.g. cell, structure). This section explains different data 

types which are commonly used as well as their formats.  

In Altair Compose, the different data types available are 

• Strings 

• Doubles 

• Booleans 

• Complex Numbers 

• Matrices 

• Cells 

• Structures 

3.3.1 String 

A string is saved as an array of one or more characters. Altair Compose provides 

multiple methods to store and retrieve data from a string. Example is given below. 

I method:      a=’this is a string’ 

II method:     a=char(‘this is a string’) 
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Figure 3.22 : String in Altair Compose. 

Strings are the output of many functions. Example is illustrated below. 

 

Figure 3.23 : Output as a string 

3.3.2 “double” 

A double is any real number between positive and negative infinity, any value stored 

as a double requires 64 bits, (limited to 1.79769…E308) Examples are given below. 

 

Figure 3.24 : Data type “double” in Altair Compose 

3.3.3 Complex 

A complex number is any number with a real and complex component. The complex 

component is represented by the character ‘i ‘where by definition ‘i2 is equal to -1. 

Example is illustrated below. 
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Figure 3.25 :Complex number in Altair Compose 

“real” 

This function returns the real part of a complex number. Example is illustrated below. 

 

Figure 3.26 : “real” function in Altair Compose 

“imag” 

This function returns the imaginary part of a complex number. 

 

Figure 3.27 : “imag” function in Altair Compose 

“conj” 

This function returns the complex conjugate of a complex number. 

 

Figure 3.28 : “conj” function in Altair Compose 

3.3.4 Boolean 

A Boolean is a data member that is either only “true” or “false”. In numerical form, 

a zero is false and all other values are true. booleans are generally used in logical 
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expressions for script control which is covered in later chapters. Example is illustrated 

below. 

 

Figure 3.29 : Boolean command in Altair Compose 

3.3.5 Matrix 

A matrix is a data entity that holds N Rows X M Columns  with double, boolean or 

character data. If N=M, then the matrix is known as square matrix.  Only two-

dimensional matrices are supported in this release. Example is illustrated below. 

[Note – Input to vector and Matrix refer section 5.1]. We can define a matrix with 

multiple rows and columns in Altair Compose with the following input format: 

�
1 2 3
4 5 6
7 8 9

� → "[1,2,3; 4,5,6; 7,8,9] " or   "[1 2 3; 4 5 6; 7 8 9]" 

So, the “,” or “space” operator separates columns and the “;” operator separates 

rows. Colon ‘:’ which defines the sequence of numbers ranging from 0 to 10 with 

step size .01 as shown in below figure. 
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Figure 3.30 : Matrix in Altair Compose 

Matrix command and operations are discussed in detail in section 5 

3.3.6 “cell” 

A “cell” is a two-dimensional data structure made up of matrices or cells with 

different dimensions and index lengths. Example is illustrated below. 

 

Figure 3.31 : “cell” in Altair Compose 

To assign and retrieve the data within a specific cell address use the {}. Please note 

the syntax for accessing a matrix within a “cell”. Example is illustrated below. 
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Figure 3.32 : Data retrieval from “cell” in Altair Compose 

You can create a cell directly just by using the {}. Example is illustrated below. 

 

Figure 3.33 : Creation of cell in Altair Compose 

3.3.7 Structure 

A “struct” is the highest-level data structure. The “struct” data structure can contain 

any other data type as a ‘child’ including other “struct” data structures. Data 

members of a “struct” are accessed through their associated field names using the 

‘‘.’’ operator – (no quotes). For example, if ‘a’ is a data structure and the field ‘test’ 
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has a value of 5.5, then the command to access the data member in Altair Compose 

is “a.test” as shown below.  

 

Figure 3.34 : Structure in Altair Compose 

Introduce a new name-value pair using the “.” notation to create a new data member 

in a “struct”. Example is illustrated below. 

 

Figure 3.35 : Generation of structure in Altair Compose 

Another example, to track data about students the following structure could be used. 

Student.name = ‘Harry’ 

Student.age = 22 

Student.id = 9023 
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Where student is the name of the structure and name, age and id are the fields (data 

types) of the structure. Each field has its own value which can be of any datatypes. 

 

Figure 3.36 : Structure in Altair Compose 

As shown below, a data member of a struct can also be a struct. Example is illustrated 

below. 

 

Figure 3.37 : Structure within a structure in Altair Compose 

A cell can be constructed as a data member of struct. Example is illustrated below. 
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Figure 3.38 : “cell” within a structure in Altair Compose 

The below example shows a structure with different data types 

 

Figure 3.39 : Structure with different data types in Altair Compose 
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List of other useful Commands 

dos eps rename flintmax 

delete sleep restoredefaultpath pathsep 

i uplus celldisp putenv 

j uminus complex rename 

I copyfile cputime run 

J class  datenum  

exit varlist disp  

quit vardetail realmin  

Help unix realmax  

 

 Operators  
Operators are commands which allow you to take actions with more than one data 

member. Most are applicable to multiple kinds of data types. This section will focus 

on introducing each operator and showing a simple, and a more involved example for 

each. The different operators in Altair Compose are  

+      -      *      /      .*      ./        ^        .^  

These operators are applicable for the following variable types: double, complex, 

boolean, matrix, struct members and cell members.  

https://altairuniversity.com/learning-library/getting-started-data-types/
https://altairuniversity.com/learning-library/getting-started-data-types/
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3.4.1 Simple Mathematical Operations 

Simple mathematical operations include functions and commands that are general 

math calculations which provide a foundation for user defined functions. 

Altair Compose can be used as a simple calculator. So, it can perform simple 

mathematical operations such as addition, subtraction, multiplication and divisions. 

 

Figure 3.40 : Simple addition example 

In this case “ans” is the last answer of compose which is the result of the addition. As 

an example, in the command window type “a =9” and “b= 3”  and do the following 

operation as shown below. 

 

Figure 3.41 : Operators in Altair compose 

Using Compose as a calculator, it respects the rule of multiplication and division first 

as well as parentheses rules, like the following example shows: 

 

Figure 3.42 : Simple multiplication and division example 
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You can also store values into variables for later calculation as the following example 

shows: 

 

Figure 3.43 : Simple variable example 

Besides addition, subtraction, multiplication and division, you can also use 

exponentiate and root numbers and variables. For exponentiating simply use the “^” 

operator and for the square root, you can use “sqrt(x)”. 

 

Figure 3.44 : Simple exponentiating and rooting example 

If you are not sure on how a certain function works, like “sqrt(x)”, you can check its 

functionality within the library browser. 

 

Figure 3.45 : Compose help option. 
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pi and e 

pi and e are constants. These are illustrated below. 

 

Figure 3.46 : Compose command 

 Altair compose allows the following types of elementary operations. Please watch 

the following video and try it for yourself:  

 

 

 

 

 Exercise 

3.5.1 Perform Operations on Various Data Types 

Step 1: Launch Compose  

 

Figure 3.47 : Shortcut icon to Altair Compose. 

https://altairuniversity.com/learnin

g-library/basic-introduction-in-

compose-calculator/ 

 

https://altairuniversity.com/learning-

library/getting-started-operators/ 

 

https://altairuniversity.com/learning-library/basic-introduction-in-compose-calculator/
https://altairuniversity.com/learning-library/getting-started-operators/
https://altairuniversity.com/learning-library/basic-introduction-in-compose-calculator/
https://altairuniversity.com/learning-library/basic-introduction-in-compose-calculator/
https://altairuniversity.com/learning-library/basic-introduction-in-compose-calculator/
https://altairuniversity.com/learning-library/getting-started-operators/
https://altairuniversity.com/learning-library/getting-started-operators/
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Double click on the icon. This launches the Altair Compose MATH GUI in the 

Authoring Mode and by default a file named Untitled1.oml exists in the Editor 

Window.   

 

 

Figure 3.48 : Altair Compose GUI 

Note:  Be sure to use the Command Window when requested and the Editor 

Window when requested as this exercise mixes the use of both. 

Step 2: Save File and Basic Commands 

1. Type “clc”, ”close all” and “clear all” in the editor window to close all 
plots opened, clear all variables, and remove previous command. 
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Figure 3.49 : Basic commands in Altair Compose 

1. “Save file” by selecting single folder icon as shown.  . Select the 

location where the file is to be saved, name it “Untitled.oml” and select save. 

 

Figure 3.50 : To “save file” in Altair Compose 

Step 3: Store Variables of Various Data Types 

1. In Editor Window type “a= 4”, “b= 6” and “c=” 345” as shown below figure. 

 

Figure 3.51 : Initialing of variable 
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2. Run the script and type “c“ in the Command Window to confirm the value of “c”. 

Note the semicolon at the end of the lines and the values of the variables “c” 

is populated in the Variable browser window, but the command results are 

not echoed to the command window.  

Delete the semicolons and run the script again. The variables are now displayed 

in the Command Window “c= 345” . 

3. Create a string by typing “x = ‘hello world” on the Editor Window and run the 

script using run icon. 

 

Figure 3.52 : Initialing of “string” 

4. Find the length of string and character from 3 to 8 in string. 

Type in Command Window “length(x)” and “x(3:8)” 

 

Figure 3.53 : “String” command 

5. Create a complex number. Find the real, imaginary and complex component. 

Type in Editor Window “y = 3 +5i;” and run the script. 
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Figure 3.54 : Complex Number 

In command window type “real(y)”, “imag(y)” and “conj(y)” to check the 

output real, imaginary, and complex conjugate of the imaginary number y. 

 

Figure 3.55 : Complex Number 

6. Create a matrix. 

Type “g = [a b; y c; y b]” In Editor Window and run the script. 

 

Figure 3.56 : Matrix of size 3 by 2. 

7. Create a cell array. 

Type in Editor Window “k=cell(2,3)” and run the script. This create an empty 

cell array. 
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Figure 3.57 : “Cell” array 

8. Add element to cell array. 

Type in Editor Window “k{1,1}=a”  and “k{2,3} = c”, run the script. 

 

Figure 3.58 : Add element to “cell” array 

Step 4: Create a “struct” and Store Various Name-Value Pairs in it  

1. In the Command Window, type “a = struct;” to setup the structure.  

2. At the prompt in the Command Window, type “a. var1 = 100.7;” which will 

create a “name-value pair” child of the structure “a” – var1 is the name, 100.7 is 

the value.   
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3. In the Command Window create a boolean “name-value pair” of “a” by typing 

“a.var2 = true;”.  

4. In the Command Window assign a “name-value pair” of a complex number by 

typing “a.var3 = 17.8 – 12.6i;”.  The Command Window should look like the 

figure below.  

 

Figure 3.59 :  Creating structure 

5. View the structure by typing “a” at the command window. 

 

Figure 3.60 : Structure in Compose 

6. Echo the value of var3 by typing “a.var3”. 

 

Figure 3.61: Echo the value 

7. Square the complex number stored in “a.var3” in variable c by typing 

“c =a.var3^2”. 

 

Figure 3.62 : Square the structure 

8. Add a new structure within structure “a” by typing “a.var4 = struct;” 
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Figure 3.63 : Add a new structure 

9. Set a value for a “name-value pair” under the new structure created in step h 

by typing “a.var4.bb = 74.5”.  

 

Figure 3.64 : Name-value pair  

Tip:  There is no limit to the type of sub-structuring shown in steps 8 and 9. 
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4.   Commands for Math and 

Curve Fitting 
This section covers the following categories of built-in commands: 

• General Math commands 

• Trigonometry 

• Curve Fitting 

 General Math Commands 
The following commands are applicable for scalar, complex and matrix data types. 

4.1.1 “ceil” 

This command returns the next integer greater than the given number, unless the 

number provided is an integer in which case it just returns this number. If the 

argument is complex, the function will return the next largest integer as described 

above for both the real and complex parts. Example is illustrated below. 

 

 

Figure 4.1 : “ceil” command in Altair Compose 
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4.1.2 “floor” 

This command is applicable for scalar, complex and matrix data types. This command 

returns the next integer below the given number, unless the number provided is an 

integer in which case it just returns that number. If the number is complex, the 

function will return the “floor” for both the real and imaginary parts. Example is 

illustrated below. 

 
Figure 4.2 : “floor” command in Altair Compose 

4.1.3 “round” 

This command is applicable for scalar, complex and matrix data types. For positive 

numbers, it returns the next integer above the given number if the numbers fractional 

part is between 0.5 and 0.999… It returns the next integer below the given number in 

the absolute sense if the numbers decimal portion is decimal of n.0 to n.49999… If 

the number is complex, the function will return the round value for both the real and 

imaginary parts. Example is illustrated below. 
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Figure 4.3 : “round” command in Altair Compose 

4.1.4 “mod” 

This command divides the second argument (divisor) into the first (dividend) and 

returns the remainder. If the input(s) are a matrix, the mod function is performed in 

each matrix element in order. In the case of mod, it will always return a value that is 

the same sign as the divisor. In the case where the divisor is 0, “mod” returns the 

dividend. Example is illustrated below. 

 

Figure 4.4 : “mod” command in Altair Compose 

4.1.5 “rem” 

This command divides the second argument (divisor) into the first (dividend) and 

returns the remainder. In the case of rem, it will always return a value that is the same 

sign as the dividend. If the inputs(s) are a matrix, the mod function id performed on 
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each matrix element in order. In case where the divisor is 0, rem returns the dividend. 

Example is illustrated below. 

 

Figure 4.5 : “rem” command in Altair Compose 

4.1.6 “max” 

This command returns the largest value in the vector. If given a matrix, the function 

will return a row vector with the maximum value of each respective column. If given 

2 matrices, the function will find the maximum values pairwise between the two 

matrices. There can be two outputs, the maximum value and the index of the 

maximum value for a vector. The final argument controls which dimension to find the 

maximum value in a matrix. 

1-along the column (default) or 2-along the row, Examples are illustrated below note: 

[] is an empty matrix, 
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Figure 4.6 : “max” command in Altair Compose 

4.1.7 “min”  

This command gives the smallest value of the input vector. If given a matrix, the 

function will return a row vector with the minimum value of each respective column. 

If given two matrices, the function will find the minimum values pairwise between 

the two matrices. There can be two outputs, the minimum values and the index of 

the minimum value for a vector. The final argument controls which dimension to find 

the maximum value in a matrix. 

1-along the column (default) or 2 along the row. Examples are illustrated below. 
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Figure 4.7 : “min” command in Altair Compose 

4.1.8 “abs” 

This command returns the absolute value of the number/vector. If the argument is a 

matrix the function will find the absolute value of each component individually. The 

absolute value of a complex number or an array is the square root of the sum of the 

squares of the components. Example is illustrated below. 

 

Figure 4.8 : “abs” command in Altair Compose 
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sqrt (scalar/complex/matrix) 

This command returns the square root of the number. If the argument is a matrix, the 

function returns the square root of each individual component. The square root of a 

complex number is calculated using DeMoivre’s theorem as below. DeMoivre’s 

theorem for square root is given as 

√(𝑎𝑎 + 𝑏𝑏𝑏𝑏)=√𝑟𝑟 (𝑐𝑐𝑐𝑐𝑐𝑐 𝜃𝜃/2 + 𝑏𝑏𝑐𝑐𝑏𝑏𝑖𝑖 𝜃𝜃/2). Where r = √(𝑎𝑎^2 + 𝑏𝑏^2 ), cos θ =  𝑎𝑎/𝑟𝑟, and sin 

θ = 𝑏𝑏/𝑟𝑟 

The sign of the imaginary part of the square root is the same as the sign of ‘b’ in the 

equation above. Examples for sqrt are illustrated below. 

 

Figure 4.9 : “sqrt” command in Altair Compose 

4.1.9 “sum” 

This command returns the sum of the vector components in the argument. If the 

argument is a matrix, the sum function will return a row vector with the sum of the 

components in each column – same if the second argument is 1. If the second 

argument is 2, the sum function will return a column vector with the sum of the 

components in each row. Example is illustrated below. 
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Figure 4.10 : “sum” command in Altair Compose 

4.1.10 “log” 

This function returns the natural logarithm of the input values in the matrix argument. 

Example is illustrated below. 

 

Figure 4.11 : “log” command in Altair Compose 

4.1.11 “sign” 

This command returns the unit sign (+/-) based on the sign of the scalar argument. If 

the argument is a matrix, the sign function will return the unit sign of each component 

of the matrix. If the number is complex, the “sign” function will return the complex 

number divided by the magnitude of the complex number. If the number is zero, the 

“sign” function will return zero. Example is illustrated below. 
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Figure 4.12 : “sign” command in Altair Compose 

4.1.12 “factor(N)” 

This command returns a row vector of the prime factor of the argument. If a second 

output is requested, factor() will return a row vector of the prime factors without 

repeating the factors and a second-row vector of how many times a factor is 

repeated. Example is illustrated below. 

 

Figure 4.13 : “factor” command in Altair Compose 
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 Trigonometric and Hyperbolic Built-In 

Commands 
Some of the trigonometric and hyperbolic commands are listed below: 

sin cos tanh acosd atan2 

cos atan asinh asind  

tan sinh acosh cosd  

asin cosh atanh sind  

 

These commands return the trigonometric results of the given input. If the argument 

is a matrix, then the trigonometric function is applied to all numbers in the matrix 

individually. Example is illustrated below. 

 

Figure 4.14 : Trigonometric commands in Altair Compose 

 Curve Fitting Commands 
When it comes to evaluating functions, plotting is one way of visually understanding 

what your function does. Plotting is one key feature of the Altair Compose software. 

4.3.1 “plot(x rowvex, y rowvec)” 

This command is used to plot two-dimensional plots. Consider x and y, two vector or 

sequence of number given as input. 



 
 

89 
 

 

4.3.2 “polyfit (x rowvec, y rowvec, N)” 

This command returns a vector of length N+1 with the coefficients of the polynomial 

fit. The coefficients are ordered from highest order polynomial to smallest (ie N[1] is 

the coefficient in front of the highest order polynomial) 

4.3.3 “polyval (N, x rowvec)” 

This command constructs a new vector which is based on the fit coefficients in N and 

the supplied x data. Examples are illustrated below. 

 

Figure 4.15 : Curve fitting commands in Altair Compose 

In the figure below, a blue line represents the original curve and the green line 

represents the fitted curve. 
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Figure 4.16 : Plot of curve fitting commands in Altair Compose 

4.3.4 “roots (rowvec)” 

This command returns the roots of the polynomial equation set equal to zero based 

on a supplied set of fit coefficients in a row vector. For example, a row vector of 

coefficients 

[2 0 -3] as an argument returns the roots of the equation 2x2 - 3 = 0 

 

Figure 4.17 : “root” command in Altair Compose 

4.3.5 “poly (rowvec)” 

This command returns the coefficients of the polynomial that has roots equal to the 

input argument. Consider the equation x2-9=0. Roots are 3 and -3.   Examples are 

illustrated below. 
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Figure 4.18 : “poly” command in Altair Compose 

4.3.6 “polyder (rowvec)” 

This command returns the coefficients of the polynomial that is the derivative of the 

given polynomial. The input provides the coefficients of the given polynomial. 

Examples are illustrated below. 

𝑓𝑓(𝑥𝑥) = 〖3𝑥𝑥〗^2 + 6𝑥𝑥 + 7 = 0 

𝑓𝑓΄(𝑥𝑥) = 6x + 6 = 0 

 

Figure 4.19 : “polyder” command in Altair Compose 

4.3.7 “polyint (rowvec)” 

This command returns the coefficients of the polynomial that is the integral of the 

given polynomial. The input provides the coefficients of the given polynomial. The 

constant is returned as a zero. Examples are illustrated below. 

𝑓𝑓΄(𝑥𝑥) = 3𝑥𝑥2 + 6𝑥𝑥 + 7 = 0 

𝑓𝑓(𝑥𝑥) = 𝑥𝑥3 + 3𝑥𝑥2 + 7𝑥𝑥 = 0 
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Figure 4.20 : “polyint” command in Altair Compose 

4.3.8 “spline ( rowvec, rowvec, rowvec)” 

This command returns the cubic spline interpolation based on the first two arguments 

for the values in the third argument. In other words, the vector returned is the cubic 

spline interpolation for the vector in the third argument based on the vectors in the 

first two arguments. Example is illustrated below. 

 

Figure 4.21 : “spline” command in Altair Compose 
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4.3.9 List of Other Curve Fitting Commands 

 

Log10 vertcat pow2 cond 

Isqcurvefit log2 horzcat angle 

length times primes gcd 

arg unwrap Power interp1 

fix    

 

 Exercises 

4.4.1 Consider a Matrix and Apply General Math Commands 

Step 1: Open Altair Compose 

Type “clc”, “clear all”, and “close all” in the Command Window to close all open 

plots, clear all variables, and remove previous command. 

Step 2: Different Commands Execution 

1. Define matrix “a” as shown below on Command Window and press enter. 

 

Figure 4.22 : Matrix in Altair Compose 

2. Type “ceil(a)” in the Command Window and press enter. 

The “ceil” command rounds the values in matrix “a” to the next largest integer.  

If the value is already an integer, then “ceil” does not change the value.    
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Figure 4.23 : “ceil” command 

3. Type “floor(a)” in the Command Window and press enter. 

The “floor” command rounds the values in matrix “a” to the next smallest 

integer.  If the value is already an integer, then “floor” does not change the value.  

 

Figure 4.24 : “floor”  command 

4. Type “round(a)” in the Command Window and press enter 

The “round” command rounds the values in matrix “a” to the next largest integer 

if the decimal part is 0.5 or above or to the next smallest integer if the decimal 

part is less than 0.5. For example “round (2.5)” will result in 3 but “round(-2.5)” 

will result in -3.  

 

Figure 4.25 : “round” command 

5. Type “r=real(a (1,1))” and “s= real(a(1,2))” in Command Window and press 

enter. This will return -5.32 and 3.84. 

 

Figure 4.26 : “real” command 
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6. Type “mod(floor(r), floor(s))” in Command Window. In this case, the “floor” 

functions return “-6” and “3”, so the remainder is 0. 

7. Type “mod(round(a(1,1)), round(a(2,1)))” in Command Window. In this case, 

the “round” functions return “-5” and “2”, so the remainder is 1.   

8. Type “rem (round(a(1,1)), round(a(2,1)))” in Command Window. In this case, 

the “round” functions return “-5” and “2”, so the remainder is 1.   

 

Figure 4.27 : “mod” command 

The arguments in step 7 and 8 are the same but “rem” retains the sign of the 

first argument.  If the second argument for either “rem” or “mod” is zero, then 

both functions return the first argument.  

9. Type “min(a)” in the Command Window.  

The function “min” will return a row vector with the smallest value from each 

column of matrix “a”.  If the argument to “a” is a row vector the “min” function 

would return a scalar equal to the smallest value in the vector.   

 

 

Figure 4.28 : “min” command 

10.   To find the minimum value of the real parts of the complex numbers in matrix “a”, 

use the “real” function within the “min” function as shown in the figure.  
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Figure 4.29 : “min” value and real part 

11. Type “abs(a)” in the command window to find the magnitude of the complex 

numbers in matrix “a”.  

 

Figure 4.30 : Magnitude values are found 

12. In the Command Window type “sqrt(real(a(1,1))^2 + imag(a(1,1))^2)”.  

Note the results to the command in this step are the same as the results of finding 

the absolute value of index “a(1, 1)” in the previous step.  The magnitude 

calculated by the absolute value function on a complex number is the square root 

of the sum of the squares of the complex numbers`  real and imaginary parts.  

 

Figure 4.31 : Magnitude values are found 

13. Calculate the sum of the numbers in the first row of matrix a by typing 

“sum(a(1,:)” in the Command Window.  
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Figure 4.32 : “sum” command  

14. Find the natural logarithm of each component of a by type “log(a)” in the 

Command Window.  

 

Figure 4.33 : “log” command 

15. Type “sign(a)” in the Command Window to find the sign of each component of 

matrix “a”.  The results of the “sign” function of a complex number is a complex 

number with the same sign as the original number and a magnitude of 1.  

 

Figure 4.34 : “sign” command 

16. Type “factor(21)” to find the prime factors of the integer 21 in the Command 

Window.  

 

Figure 4.35 : “factor” command 

17. Type “[n,m]=factor(21)” to find the prime factors of the integer 21 in the 

Command Window.  
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Figure 4.36 : prime factor 

4.4.2 Solve Trigonometric and Hyperbolic Commands  

• Sin-1�𝑐𝑐𝑐𝑐𝑐𝑐 5𝜋𝜋
6
� 

Use command window. 

Type “asin” for denoting sin-1 and type “(cos(5*pi)/6)”. 

 

Figure 4.37 : “asin” command in Altair Compose 

 

• Sin-1�1
2
𝑡𝑡𝑎𝑎𝑖𝑖 240°� 

Use command window. 

The input should be in radians.to convert to radians, use*pi/180. 
 

 

Figure 4.38 : Trigonometric command 

4.4.3 Consider Two Vectors and Fit a Curve to the Data 

Step1: To Plot Two Vectors 

Create a new “*.oml file” in the Editor Window using the New File  icon. 

1. Type “clc”; “close all;” “clear all;” in Editor window. 

2. Type “g = [1:1:10]” this create a row vector 1 to 10. 
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3. Type “h = [1.1 1.7 1.4 1.9 2.8 2.0 2.4 3.6 3.1 3.9]” this create a row 

vector as shown below. 

4. Type “plot(g,h)” to plot vectors “g” verse “h” and run the script. 

 

 

Figure 4.39 : Plot of two vectors 

Step 2: Fit a Curve to the Data  

1. Type “hold” to keep the curve plotted in the previous step from being replaced.  

2. In the Editor Window type “c = polyfit(g, h, 5);” to calculate the coefficients 

of a 5th order polynomial fit to the data stored in vectors “g” and “h”.  

3. In the script, determine the values based off the coefficients of the 5th order 

polynomial calculated in step 2 using the vector g as the independent values by 

typing “d = polyval(c, g);”.  

4. Type “plot (g, d);” to plot the fitted curve based off the 5th order polynomial 

coefficients in figure 1 and execute the script.  
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Figure 4.40 : Fit a curve to the data 

 

5. In the Command Window type “r = roots(c)” to calculate the roots of the 5th 

order polynomial calculated in step 2.  

6. Type “p= poly(r)” to calculate a polynomial with the same “roots” as the 

polynomial using the coefficients in the vector “c”.  If they do not match exactly, 

notice that the ratio between the coefficients is consistent.  

7. Display the values in the row vector “c” by typing c in the Command Window.  
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Figure 4.41 : "roots" and "poly" command 

Tip:  The coefficients calculated for the polynomial in vector “r” are not the 

same as the coefficients calculated for the curve fitting in step 2.  The 

discrepancy between the coefficients calculated by the “poly” and “polyfit” 

functions is caused by the “poly” function scaling the coefficients, so the 

highest order coefficient is one.  

8. To remove the discrepancy between the values for “c” and “p”, multiply the “p” 

vector by the first coefficient in the “c” vector by typing “p*c(1)” in the Command 

Window.  

 

Figure 4.42 : Remove the discrepancy 

9. Find the coefficients of the derivative polynomial calculated in step 2 by typing 

“polyder(c)” in the Command Window.  
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10. To determine the coefficients of the integral of the polynomial calculated in step 

2, type “ployint(c)” in the command window.  

 

Figure 4.43 : "polyder" and "polyint" command 

11. To create a new set of independent values to plot the polynomial calculated in 

step 3. Type “g_spline = [1, 2, 5, 8, 9, 10]; “ 

12. Determine the vector of dependent values based using the cubic spline function 

for the independent values entered step 11 by typing “d_spline = spline(g, d, 

g_spline);”.  

13. Plot the polynomial calculated in step 2 based of the spline interpolation 

calculated in step 12 by typing “plot(g_spline, d_spline)” and run the script. 

Please press the run button twice due to the “hold” on line 5.  
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Figure 4.44 : Plot of “spline” command 
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5. Vectors and Matrices 
In Altair compose, values are stored, and manipulation of data is done in array form 

(vector form). One dimensional arrays are represented as vectors. It may be a row 

vector or a column vector. Two-dimensional arrays are represented as matrices. In 

this section the input of vectors and matrices as well as operations on vectors and 

matrices are discussed. The built-in functions and commands are explained. 

 Vectors and Matrices Input 
In this section we will look on how to input sequences of numbers as well as matrices. 

You may need sequences of numbers to define what values you want to evaluate in 

your function. Let’s suppose you want to see what the plot of the function sin(2x) 

looks like. For this, you must define x as a sequence of numbers ranging from 0 to 10 

with step size 0.01 for example for the function input . 

To define a sequence of numbers within Altair Compose, you can input for example: 

 

Figure 5.1 : Input a sequence of numbers with step size 1 

which defines the sequence of numbers ranging from 2:12 with step size 1. 

Another way of defining a sequence of numbers is with the function “linspace(start, 

end,number_of_values)” 

 

Figure 5.2 : Input a sequence of numbers with linspace() 

For many types of math operations, matrices and tensors are the way to organize your 

values. The sequence of numbers stated above is stored as a one-dimensional matrix. 
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One row and N columns are referred as row vector and N rows by one column by 

column vector. Example is illustrated below. 

 

Figure 5.3 : Row and column vector in Altair Compose 

You can define a matrix with multiple rows and columns in Altair Compose with the 

following input format: 

�
1 2 3
4 5 6
7 8 9

� → [1,2,3;4,5,6;7,8,9] or [1 2 3; 4 5 6; 7 8 9] 

So, the “,” (Comma) or “space” operator separates columns and the “;” (Semicolon) 

operator separates rows, like the following Figure shows: 

 

Figure 5.4 : Matrix Input in Altair Compose 

You can also create a matrix by providing specific cell values and Altair Compose will 

setup a minimum required matrix and fill the gaps with zeros. Example is illustrated 

below. 
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Figure 5.5 : Matrix generation in Altair Compose 

For ease of use there are some special matrices which are available with one line of 

code. For example, if you want to have a matrix with zeroes, you can input “zeros(x)” 

to get a square matrix. Otherwise you can input “zeros(r,c)”, where r stands for the 

number of rows and c the number of columns. 

 

Figure 5.6 : Matrix with zeroes with the “zeros” function 

The same principles work for a matrix with just “ones”: 

 

Figure 5.7 : Matrix with ones with the “ones” function 

Other than that, you can also get the identity matrix with the “eye()” function. This 

matrix has ones on the main diagonal and zeros everywhere else. 

 

Figure 5.8 : Identity matrix with the” eye” function 

It also can be necessary to define random values within a matrix. You can accomplish 

this by using the “rand ()” function. It can be used like the other functions above 
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with either one parameter specifying the number of rows and columns or by 

separately specifying rows and columns with two parameters. The range of the values 

is between zero and one. 

 

Figure 5.9 : Generating random values in a matrix with the ”rand” function 

Please watch the following video and try to input some matrices within Altair 

Compose: 

 

https://altairuniversity.com/learning-library/basic-introduction-in-compose-vectors-

and-matrices/ 

 

 Matrix Operations, Commands and Linear 

Algebra Commands 

5.2.1 Matrix Addition and Subtraction 

Matrix addition and subtraction can be done with scalar values: 

https://altairuniversity.com/learning-library/basic-introduction-in-compose-vectors-and-matrices/
https://altairuniversity.com/learning-library/basic-introduction-in-compose-vectors-and-matrices/
https://altairuniversity.com/learning-library/basic-introduction-in-compose-vectors-and-matrices/
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Figure 5.10 : Matrix addition and Subtraction 

5.2.2 Transpose of a Matrix 

“R = transpose (matrix, matrix)” 

This command gives output of the form “R=transpose(matrix, matrix)”. This 

command returns the transpose of the input matrix. Also the ‘ operator (A’ in the 

example below) will find the transpose of the matrix. Example is illustrated below. 

 

Figure 5.11 : Transpose a Matrix with the ‘operator 

 



 
 

110 
 

 

5.2.3 Inverse of a Matrix 

“[x, rcond ] = inv ( matrix)” 

This command gives the output of the form “[x rcond] = inv(matrix)”.  This 

command returns the inverse of a square matrix if the matrix is not singular. 

(det(A)=0). You can also find the inverse of the matrix by taking the -1 power of the 

matrix. The inverse of a matrix multiplied by the original matrix is the identity matrix. 

“rcond” is a measure of the condition of the matrix. A small number means the matrix 

is ill conditioned and a number close to one means a matrix well-conditioned. An ill-

conditioned matrix allows small perturbations to lead to dramatic differences in 

answers. Example is illustrated below. 

 

Figure 5.12 : Inverting a matrix with the “inv” function 

5.2.4 Division of a Matrix 

For division of matrices there exists a left division and a right division. Dividing a 

matrix with another matrix can also be expressed by a matrix multiplication with the 

inverted form of one of the matrices. Depending on the division (left or right) it is 

determined which matrix is inverted. The right matrix division is defined with the “/” 

operator (left matrix is inverted), whereas the left matrix division is defined with the 

“\” operator (right matrix is inverted) 
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Figure 5.13 : Left and right matrix division and their matching inverted multiplication form 

 

5.2.5 Matrix Multiplication 

You can multiply each value with “prod()” function: 

 

Figure 5.14 : “prod” function on a matrix to get the product of each column 

5.2.6 Componentwise Matrix Multiplication 

If you want to perform any matrix operation componentwise, you can do this by 

adding a “.” operator before the actual matrix operation. If you want to specify that 

a matrix should be component wise multiplied with another matrix see below: 
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Figure 5.15 : Component wise matrix multiplication 

This works the same way with dividing, exponentiating, addition and subtraction. 

5.2.7 Concatenate Two Matrices 

If you want to concatenate two matrices you can do this horizontally and vertically 

with the functions “horzcat(A,B)” and “vertcat(A,B)”, where A and B are the 

matrices you want to concat. 

 

Figure 5.16 : Concat matrices 
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5.2.8 Recall Values from a Matrix 

To recall values from the matrix simply provide the requested rows and columns using 

“(r,c)” or “(r,:)” or “(:,c)” or “([range],[range])”. Example is illustrated below 

 

Figure 5.17 : Recall values from matrix 

 

5.2.9 Change Certain Values within a Matrix 

You can also change certain values within a matrix: 

A(r,c) = x  

where r and c are the values for the row and column you want to change the value 

into x. You can also change whole rows and columns or certain scopes by using the 

format “start:end”. So, for example if the first 3 rows of column 4 have to be 

changed, the syntax would be 

“A(1:3,4) = x” 

If you want to change whole rows or columns, for example all rows of column 3 you 

can input: 

“A(:,3) = x” 
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Figure 5.18 : Change values within a matrix 

 

5.2.10 Data Gathering in a Matrix 

You can also populate data in matrices by referring to existing variables. Example is 

illustrated below. 

 

Figure 5.19 : Data gathering in matrix 

5.2.11 Delete Certain Values, Rows or Columns 

If you want to delete certain values, rows or columns you can use: 

“A(r,c) = []” 

The syntax of addressing rows and columns is the same as stated above. 

Please watch the following video and try some basic matrix calculations for yourself: 
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https://altairuniversity.com/learning-library/basic-introduction-in-compose-basic-

matrix-operations/ 

 

5.2.12 Some of the Other Commands are Explained Below 

“R = dot(scalar/complex/matrix, scalar/complex/matrix, dim)” 

This command gives output of the form “R=dot(scalar/complex/matrix)”. This 

command returns the dot product of two vectors, matrices or complex numbers. If 2 

scalars are input, then “dot” multiplies the scalars. If the two arguments are matrices, 

“dot” will return the dot product of the column vectors. “Dot” will return the dot 

product of the row vectors if ‘dim’ is set to ‘2’.  Examples are illustrated below. 

 

https://altairuniversity.com/learning-library/basic-introduction-in-compose-basic-matrix-operations/
https://altairuniversity.com/learning-library/basic-introduction-in-compose-basic-matrix-operations/
https://altairuniversity.com/learning-library/basic-introduction-in-compose-basic-matrix-operations/
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“R = cross( matrix, matrix, dim)” 

This command gives output of the form “R=cross(matrix, matrix, dim)”. This 

command returns the cross product of two vectors, matrices, or complex numbers. If 

two scalars are input, then “cross” multiplies the scalars. If the two arguments are 

matrices, “cross” will return the cross product of the column vectors. Cross will return 

the cross product of the row vectors if ‘dim’ is set to ‘2’. The cross product only exists 

in 3 dimension vector space. The cross product can also be expressed as 

𝑢𝑢  × 𝑣𝑣  =  det  �
𝑏𝑏 𝑗𝑗 𝑘𝑘
𝑢𝑢₁ 𝑢𝑢₂ 𝑢𝑢₃
𝑣𝑣₁ 𝑣𝑣₂ 𝑣𝑣₃

� 

 
 

Figure 5.20 : “dot” command in Altair Compose 
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Figure 5.21 :  Cross product of two vectors using the “cross” function 

“[d rcond ] = det ( matrix)” 

This command gives the output of the form “[d rcond] = det(matrix)”. This 

command returns the determinate of the input matrix (only for square matrix). It 

outputs the ‘1-norm estimate of the reciprocal condition of the matrix’. rcond is a 

measure of the condition of the matrix. A small number means the matrix is ill 

conditioned and a number close to one means a matrix well-conditioned. An ill- 

conditioned matrix allows small perturbations to lead to dramatic differences in 

answers. Example is illustrated below. 
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“R=rank( matrix, tol)” 

This command returns the rank of the matrix. The second argument “tol” is the scalar 

threshold for rounding off near zero singular values. The default is the largest 

dimension multiplied by eps(s) where s is the largest singular value and “eps” is the 

spacing between two adjacent numbers in a machine floating point system. The 

“rank” of a matrix is the dimension of the vector space generated or spanned by the 

column vectors. Example is illustrated below. 

Figure 5.22 : “det” command 
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Figure 5.23 : “rank” command 

Please watch the video and try these functions for yourself  
 

 
https://www.youtube.com/watch?v=ALLFf9SPaD4&t=90s 

 

“true” 

This command creates Boolean values 1. Example is illustrated below. 

“false” 

This command creates Boolean values 0. Example is illustrated below. 

https://www.youtube.com/watch?v=ALLFf9SPaD4&t=90s
https://www.youtube.com/watch?v=ALLFf9SPaD4&t=90s
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Figure 5.24 : “true” and “false” command 

“[a, b, c] = intersect (matrix, matrix, ‘rows’)” 

This command returns one, two or three outputs as “[a, b, c] = intersect (matrix, 

matrix,’rows’)”. It returns the common values between the first two matrix input 

arguments. If the two input arguments are vectors, the output is in the same 

orientation as the input vector- row/column vector. Second output is the indices of 

the values returned in the first output form the first matrix. Third output is the indices 

of the values returned in the first output from the second matrix. If the “rows” 

argument is included, “intersect” will treat each row of the matrix as an individual 

entity. Examples are illustrated below. 
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Figure 5.25 :“intersect” command in Altair Compose 

Please note that when there is more than one common value, the value given in ’b’ 

and ‘c’ is for the last instance of the common value. 

“[a, b, c] = union (matrix, matrix, ‘rows’)” 

This command returns one, two or three outputs as “[a,b,c]=union (matrix, 

matrix,’rows’)”. It returns all the elements in both the matrix input arguments in 

ascending order in a non-repeated manner. If two input arguments are vectors, the 

output is in the same orientation as the input vector- row/column vector. ‘b’ contains 

the indices in the first matrix returned by ‘a’. ‘c’ contains the indices in the second 

matrix returned in ‘a’. If multiple instances of a value is present, the last instance will 

be used in both ‘b’ and ‘c’. If the ‘rows’ argument is included, “union” will treat each 

row of the matrix as an individual entity. Examples are illustrated below. 
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Figure 5.26 : “union” command in Altair Compose 

  

“[row, col, v] = find(matrix, n, ‘direction’)” 

This command returns one, two or three outputs in the form “[row, 

col,v]=find(matrix, n, ‘direction’)”. If there is one output requested, “find” will 

return the indices of the non-zero elements in the matrix. If the input argument ‘n’ is 

present, “find” will return the indices of the first ‘n’ non-zero values. The direction 

argument is either first or last to start the search for non-zero indices from the first 

or last input matrix element. ‘first’ is taken default. If two outputs are requested, 

“find” will return the row and column indices of the nonzero elements. For three 

outputs, “find” will return the ‘row’ and ‘column’ indices plus a vector of the non-

zero values. Examples are illustrated below. 
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Figure 5.27 : "find" command example 

 

Figure 5.28 : "find” command 
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“R=all (matrix, dim)” 

This command gives the output of the form “R=all(matrix,dim)” This command 

returns a Boolean of ‘1’ (true) if all the values of the vector or columns of a matrix are 

non-zero otherwise returns zero. If the ‘dim’ argument is ‘2’ then “all” will return a 

Boolean of ‘1’ if all the rows of the input matrix is non-zero- ‘dim’ of 1 is default. 

Example is illustrated below. 

 
Figure 5.29 : “all” command in Altair Compose 

“R = any (matrix)” 

This command gives the output of the form “R=any(matrix)” This command returns a 

Boolean of ‘1’ (true) if any or the elements of a vector of the column vectors of a 

matrix are non-zero. If the input argument ‘dim’ is set to 2, ‘all’ returns a Boolean of 

‘1’ if any of the row vectors of the input matrix contains non-zero values. Example: 

 
Figure 5.30 : “any” command in Altair Compose 
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“[s, idx] = sort( matrix, dim, ‘ascend/descend’)” 

This command returns one or two outputs in the form “[s, idx]=sort( matrix, dim, 

‘ascend/descend’)”. It gives a column or row vector in ascending order. If the input 

argument is a matrix, “sort” will return a matrix with the individual column vectors 

sorted. If the ‘dim’ argument is set to ‘2’ and the input is a matrix, the output is a 

matrix with the row vectors sorted in ascending order. If the last argument is 

‘descend’, sort will return the column/row vector of matrix in descending. The output 

‘idx’ is the index of the row or column of the sorted value in the original matrix or 

vector.  

 

 

“[row, col] = size( matrix, dim)” 

This command returns one or two outputs in the form “[row, column] = size(matrix, 

dim)”. It returns a vector with the number of rows/columns of a row/column vector. 

With 1 output requested, it returns a row vector with the number of rows and column 

Figure 5.31 : “sort” command in Altair Compose 
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of matrix. When 2 outputs are requested, the number of rows and columns in the 

input matrix is stored as separate scalars. With ‘dim’ specified as an input argument, 

the number of rows for ‘dim=1’ or number of columns for ‘dim=2’. Examples are 

illustrated below. 

 

Figure 5.32 : "size" command in Altair Compose 

“R=cumsum( matrix, dim)” 

This command gives the cumulative sum of the row or column vector – the sum of all 

the values of lower index in the row/column vector. If the input is a matrix, “cumsum” 

will return the cumulative sum of the columns of the input vector. If the input is a 

matrix and the ‘dim’ is ‘2’, the output is the cumulative sum of the rows of the input 

matrix- ‘dim=1’ is the default. Examples are illustrated below. 
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Figure 5.33 : “cumsum” command in Altair Compose 

“R = cumprod(matrix, dim)” 

This command gives the cumulative product of the row or column vector – the 

product of all the values of lower index in the row/column vector. If the input is a 

matrix, “cumprod” will return the cumulative product of the columns of the input 

vector. If the input is a matrix and the ‘dim’ is 2, the output is the cumulative product 

of the rows of the input matrix- ‘dim=1’ is the default. Examples are illustrated below. 

 
Figure 5.34 : “cumprod” command in Altair Compose 
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“[ C, ia,  ib] = unique ( matrix, ‘rows’, ‘first’/’last’)” 

This command gives one or two or three outputs of the form “[C ia 

ib]=unique(matrix, ‘rows’, ‘first’/’last’)”. The unique values of the 

vector/matrix in the first argument in a row/ column vector. The ‘ia’ vector relates 

the values in vector ‘C’ to the corresponding index in matrix/vector ‘A’. The ‘ib’ vector 

relates the values in vector/matrix ‘A’ to the corresponding index in vector ‘C’. As 

shown in green circles below, the third value in vector ‘ib’ is 8 and applying that index 

value to vector ‘C’ produces the third value in vector ‘A’. If the input arguments 

include ‘first’, the first index of repeated values is returned in vector ‘ia’. ‘last’ is set 

as default. Compare the ‘ia’ vector, returned in the red circles to the ‘ia’ vector 

returned in the purple circles. If ‘row’ is included in the input arguments, the unique 

row vectors of matrix A are returned in matrix C. 
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“R = diag( matrix, m, n)” 

This command gives output of the form “R=diag(matrix,m,n)” This command gives 

the diagonal of a matrix as a column vector. If the input is a vector and no other input 

arguments, the function returns a matrix with diagonal equal to the input vector. If 

the input is a matrix and ‘m’, the function will return the diagonal starting ‘m’ columns 

(or rows if ‘m’ is negative) away from the first column. When the input is a vector and 

only the ‘m’ argument is present, the function will create a matrix with the input 

vector a diagonal ‘m’ columns (or rows if ‘m’ is negative) away from the first entity. 

When the input is a vector with input arguments ‘m’ and ‘n’, the function will return 

a ‘mxn’ matrix with a diagonal equal to the input vector n – both ‘m’ and ‘n’ should 

be greater than the size of the input vector. Example is illustrated below. 

Figure 5.35 : “unique” command in Altair Compose 
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Figure 5.36 : “diag” command in Altair Compose 

http://tutorial45.com/wp-content/uploads/2015/06/matlab-matrix-operations8.png?x61285
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 “[V D]= eig(Amatrix, Bmatrix, ‘nobalance’)” 

This command returns 1 or 2 outputs. V is a matrix with columns consisting of 

components of the eigenvectors. D is the diagonal matrix with the corresponding 

Eigen values. B is the right-hand side matrix in a generalized Eigen value problem. 

‘nobalance’ disables the balancing operation when finding the Eigen values-not 

recommended. Example is illustrated below. 

 

Figure 5.37: “eig” command in Altair Compose 

List of Other Matrix and Linear Algebra Commands 

mpower lu triu numel setfield 

minus chol cat expm getfield 

mldivide conv permute ndims fieldnames 

ind2sub cinv2 pinv reshape  

sub2ind cplxpair prod schur  

balance diff Idivide setdiff  

bitor  hypot rdivide  subsref  

bitand mtimes mlock svd  

bitxor norm munlock linspace  

setxor tril repmat rmfield  
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 Exercises 
5.3.1 Basic Vector Operations 

Step 1: Open an Altair Compose GUI 

Type “clc”, “clear all”, and “close all” in the Command Window to close all 

open plots, clear all variables, and remove previous commands. 

Step 2: Create a Row Vector  

A row vector with four elements is created by typing “a = [1 2 3 4]” in the 

Command Window and press enter. 

 

Figure 5.37 : Row vector 

Step 3: Create a Column Vector  

Create a column vector with four elements by typing “a = [1;2;3;4]” in the 

Command Window and  press enter. 

 

Figure 5.38 : Column vector 

Step 4: To Refer an Element of a Vector 

 a(i) refer to ith component of vector a 

1. To Refer 2nd element of a column vector type “a(2)” in Command Window and 

press enter. 
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Figure 5.39 : To refer an element. 

2. To refer 3rd element of a row vector type “a(3)” in Command Window and press 

enter. 

 

Figure 5.40 : To refer an element in row vector 

3. A vector with a colon, such as “a(:)”, all the components of the vector are listed, 

type “a(:)” in command Window, press enter. 

 

Figure 5.41 : Colon natation 

Step 5: How to Create a New Sub Vector? 

1. Refer elements from n to m to create a sub vector. Type “a = [1;3;6;8;9];” next 

line type “sub_a = a(2:5)” in Command Window and press enter. This refer to 

element from 2 to 5 in column vector. 

 

Figure 5.42 : Sub vector 



 
 

134 
 

 

2. Type “a = [1 3 6 8 9];” next line type “sub_a = a(2:5)” in Command Window 

and press enter. This refer to element from 2 to 5 in row vector. 

 

Figure 5.43 : Sub vector form row vector 

5.3.2 Basic Matrix Operations. 

Step 1: Open an Altair Compose GUI 

Type “clc”, “clear all”, and “close all” in the Command Window to close all open 

plots, clear all variables, and remove previous commands. 

Step 2: Create a 3 by 4 matrix 

 Type “b = [3 4 5 7;6 7 8 3 2;3 4 5 6]” in command window and press enter. 

 

Figure 5.44 : Matrix of 3 by 4 

Step 3: To Refer the Element of the Matrix 

To refer an element in the mth row and nth column of a matrix, It can be written as 

b(m,n).Type matrix b as shown and type “b(3,2)” in Command Window .This refer 

the element in 3th row and 2nd column. 
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Figure 5.45 : Element of the matrix   

Step 4: Create a Row Vector from Matrix 

 (m,:) refers to all elements of the mth row. Type the matrix b as shown on Figure 5.48 

and type “b(2,:)” to refer all element in 2nd row.  

 

Figure 5.46 : Row vector from matrix 

Step 5: Create Column Vector from Matrix 

(:,n) refers to all elements of the nth column. Type the matrix b as shown and type 

“b(:,2)”.This refer all elements of the 2nd  column. 

 

Figure 5.47 : Column vector from matrix 



 
 

136 
 

 

Step 6: Create a Sub Matrix of a Matrix 

1. Type the matrix b as shown below and type “sub_b = (:,2:3)” into the 

Command Window. This refers to all elements in the 2nd to 3rd column. 

 

Figure 5.48 : Submatrix of a matrix 

2. Type matrix b as shown below and type “sub_b = (2:3,3:4)” in Command 

Window. This refer to 2nd to 3rd row and 3rd to 4th column. 

 

Figure 5.49 : Submatrix of a matrix 

Step 7: To Delete a Row or Column in Matrix 

By assigning an empty array ‘[]’ to a row or column of a matrix, that entire row or 

column can be deleted. Type matrix b as shown below in command window and type 

“b(2,:) = []”. This delete 2nd row. 

Type “b(:,3) = []”. This deletes all rows and 3rd column. 
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Figure 5.50 : Deleting row and column of a matrix 

 

5.3.3 Basic Matrix Calculations 

Step 1: Create a Matrix of 2 by 2. 

 In command window type matrix “g” of 2 by 2. 

 

Figure 5.51 : Matrix of 2 by 2 

Step 2: Matrix Addition 

Add matrix “g” to itself by typing “g + g” in the command window. 

 

Figure 5.52 : Addition of matrix. 

Step 3: Matrix Multiplication 

Multiply the individual elements of matrix “g” by themselves by typing perform “g .* 

g” in the command window.  In other words, each element of matrix g is squared in 

this step. 
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Figure 5.53 : Element Multiplication 

Step 4: Matrix Division  

Calculate the right division of two matrices by typing “g/[2*g]” in the command 

window. 

 

Figure 5.54 : Right division 

Step 5: Right Division of Two Matrices  

To calculate the right division of two matrices by typing “g\[2*g]” in the command 

window. 

 

Figure 5.55 : Right division 

Step 6: To find Element Wise Square Root 

In command window type “g.^2” to find element wise square root. 

 

Figure 5.56 : Square root 
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5.3.4 Matrix Command 

Step 1: Create a Random Integer Matrix  

1. Create a new “*.oml file” in the Editor window. 

2. In the Editor Window type “A = rand(4, 7)” to create a 4 x 7 matrix of random 

numbers and run the script.      

 

Figure 5.57 : "rand" command  

3. In the command window type “A” to display the values of the matrix created in 
the script.  

Note the numbers in matrix “A” are randomly generated so they will not be the 
same as the numbers shown in the figure below.  

 

Figure 5.58 : Matrix of 4 by 7 

4. Add a % at the start of line one in the Editor window. The comment will prevent 

line one from executing when the script is run.  

 

Figure 5.59 : Comment add to line one 

5. Type the following lines and run script. 

 

Figure 5.60 : Matrix command 

The “rand” function generates random numbers on between zero and one.  The 

lines three, four, and five above will generate a matrix with integer values 
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between zero and 50.  Line three sets the maximum value for matrix “A_norm” to 

50.  Line four divides matrix “A” element by element by the maximum value in 

Matrix “A”.  Also on line four, the normalized matrix is multiplied element by 

element by “maxInt” so all the values in matrix are between 0 and 50 with the 

maximum value equal to 50.  Finally, the “round” function rounds off the decimal 

part of each element in matrix “A_norm” to get a matrix of integer values between 

0 and 50.   

6. In the Command Window type “A_int” to display matrix “A_int”.  

 

Figure 5.61 : Matrix 4 by 7 after above command operation 

7. In the command window, type “true(4, 7)” to create a 4 x 7 matrix of boolean 

“true” values.  

8. In the command window, type “false(4, 7)” to create a 4 x 7 matrix of boolean 

“false” values.  The command window should look similar to the figure below 

 

Figure 5.62 : "true” and “false" command 
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Step 2: Create Boolean Matrices  

1. On line seven in the Editor Window type “A_bool = floor(A_int ./ maxInt);” 

and run the script.  

 

Figure 5.63 : Create boolean matrices 

The “floor” function will return the smallest integer of the matrix created by dividing 

each element in the “A_int” element by the value of “maxInt”.  In this case, any 

values integer values less than 50 in the “A_int” will become zero in matrix “A_bool”.  

2. In the Command Window, type “A_bool” to display the values of the matrix 

“A_bool”.  

3. Type “A_int” to display the “A_int” matrix.  The Command Window should look 

similar to the figure shown.  

 

Figure 5.64 : “A_bool” matrices 

4. To create a second boolean matrix of random numbers, type “A_bool_2 = 

round(rand(size(A)))”;.  
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The “rand” function will create random numbers between 0 and 1 in a matrix the 

same size as matrix “A”.  After creating the matrix of random numbers, the 

“round” command will round the random numbers generated to either 1 or 0.  

5. Run the script to create the matrix “A_bool_2”. 

 

Figure 5.65 : Second boolean matrix 

6. Type % at the start of line 8 in the Editor Window to prevent execution of the 

command on line 8 when the script is run – line 8 is now a comment.   

7. In the Command Window, type “A_bool” and “A_bool_2” on separate lines to 

display the matrices “A_bool” and “A_bool_2”.  

 

Figure 5.66 : Boolean matrix 

8. In the Editor Window on line 10, type “A_bool_swap = A_bool .* A_bool_2” to 

multiply element by element the matrices “A_bool_swap” and “A_bool”.  The 

resulting matrix “A_bool_swap” shows where both values of “A_bool” and 

“A_bool_2” are “true”.  Run the script to create the matrix “A_bool_swap”   
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Figure 5.67 : "swap" command 

9. Tpye “A-bool_swap” in command window to display matrix 

 

 

Figure 5.68 : Output of swap 

10. Creates a matrix that is “false” at all locations, where the matrix      “A_bool_swap” 

to be true – the “inverse” Boolean matrix.  To create the matrix 

“A_bool_swap_not”, type “A_bool_swap_not = not(A_bool_swap);” on line 11 in 

the Editor Window.  The “not” function will change all elements in “A_bool_swap” 

from “true” to “false” and vice-versa.  

11.  Type A_bool_swap_not in the Command Window to view the matrix.  

 

Figure 5.69 : To create matrix swap not 

Step 3: Create a Selectively Random Integer Matrix  

1. In this step, a random number is generated at the only location in which the 

matrix “A_bool_swap” is “true”.    
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2. In the Editor Window create a new random number generated matrix by typing 

“A_new_rand = rand(size(A));”.  

3. In the Editor Window, type “A_new_rand ./ max(max(A_new_rand)) * maxInt;” to 

create a new random number matrix with values between 0 and 50.  

4. Next element by element multiply the matrix “A_bool_swap” element by element 

with “A_new_rand_norm” to create a matrix with random integer numbers only at 

locations where the element value is 50 in the matrix “A_int”.  Run the script.  

 

Figure 5.70 : Matrix commands 

In the Command Window type “A_bool_maxInt_swap” to display the matrix.  The 

command window should look similar to the figure shown.  

 

Figure 5.71 : Output of A_Bool_maxInt_swap matrix 

Step 4: Modify Matrix Entries  

1. Type “A_int_2 = A_int .* A_bool_swap_not + A_bool_maxInt_swap;” in the 

Editor Window.  The command in this step will create the same random 

number matrix as created on line 5 but the numbers that are 50 are replaced 

with the random numbers of matrix “A_bool_maxInt_swap”.  Run the script.  

 
Figure 5.72 : Create A_int_2 matrix 
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2. In the Command Window, type “A_int” and “A_int_2” to view the two 

matrices created in the Editor Window.  

 

Figure 5.73 : Comparison of two matrix output 

Step 5: Query The Process   

1. To find out if there were values where “A_int” was 50 and “A_bool_2” had a 

“true” value run the “any” command on the matrix “A_bool_swap” twice by type 

the in the Command Window “any(any(A_bool_swap))”.  

The first “any” command in this case will return a row vector of “true” and 

“false” integer values depending on if there are any non-zero values in the 

matrix “A_bool_swap”.  Likewise, the second “any” command will return a “true” 

or “false” integer value depending on if any of the element of the row vector are 

non-zero.  A return value of “1” indicates there was at least 1 value in the “A_int” 

matrix that was 50 and a corresponding “true” value in the “A_bool_2”matrix.  

 

Figure 5.74 : Any command  

2. To find the indices where the where the random number is 50 in “A_int” and 

“True” in  
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“A_bool_2, type [row col] = find(A_bool_swap)” in the command window.  

The “find” command with two output arguments returns the row and column 

of any non-zero elements in the input matrix.  

 

Figure 5.75 : To find the rand number 50 

3. In the command window, type “unique(B_int_2)” to find the unique, non-

repeated, elements in matrix “B_int_2” in a column vector.  As shown in the 

figure below, in this case there 23 of the possible 24 values are unique.  

 
Figure 5.76 : To find unique elements 

 

5.3.5 Execute Linear Algebra Commands 

Step 1: Create a Matrix 

Open New “oml file” Create a Matrix as Shown. 
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Figure 5.77 : Matrix of 4 by 4 

Step 2: To Find the Determinate of Matrix 

Calculate the determinate of matrix “k” in the command window to determine if there 

is an inverse to matrix “k”.  An inverse to matrix “k” exists if and only if the 

determinate of matrix “k” does not equal zero.  

 

 

Figure 5.78 : “det” command 

Step 3: To Find the Diagonal of Matrix 

Type “diag(k)” in the command window to find the diagonal element of matrix “k” 

in a column vector. 

 

Figure 5.79 : “diag” command 

Step 4: To Find the rank of Matrix 

Type “rank(k)” in the command window to find the rank of matrix “k”.  the rank of 

the matrix is the number of dimensions in vector space the column or row vectors in 

a matrix span.  In this case all the row and column vectors span a 4-dimensional vector 

space.  
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Figure 5.80 : Rank command 

Step 5 : To Find the Eigen values of Matrix 

Type “eigs_K = eig(K);” to Store the Eigen Values of Matrix “K” in the Column Vector 

“eigs_K”.  Run the Script. Display the Result in the Command Window by Typing 

“eigs_K” and the Command Prompt. 

 

 

 

Figure 5.81 : Eigen value of matrix 

Step 6: To Find the Determinant of Matrix 

Type the Following Lines. Find the Determinant of a Matrix Calculated by Subtracting 

Matrices “M” from “K” by Typing “ee = det(K – M)” and Run the Script. 

 

 

Figure 5.82 : Determinant of a matrix 
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Step 7: Matrix Commands 

Calculate the Column Vector “x” such that F = Kx by typing “x = 

inv(K)*transpose(F);” and run the script. 

Tip:  The use of the transpose function is required to transform “F” from a row to 

column vector so “F” is dimensional compatible for matrix multiplication with the 

inverse of matrix “K”.  

 

Figure 5.83 : Matrix multiplication 

Step 8: Matrix Commands 

In the editor window, there are three row vectors named “a”, “b”, and “c”.  To find 

the volume of the parallelepiped formed by these three vectors type “v = abs(dot(a, 

cross(b, c)));” and run the script. 

 

 

Figure 5.84 : Volume of three vector 
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6. Plot Attributes and Handle 

Management 
This section covers the plotting of two-dimensional(2D) plot and three-

dimensional(3D) plot. Explains different plot types used for plotting and the ability to 

control plot attributes through handles and commands. It includes: 

• Window Management 

• Plot Types 

• Line Attributes 

• Handle Management and Plot Attributes 

Plots are considered ‘objects’ in Altair Compose. Each ‘object’ is assigned a numerical 

value named a ‘handle’. Similar to object-oriented programming, each ‘object’ has 

‘children’. Information and modification of an ‘objects’ & ‘children’ is accomplished 

through the objects ‘handle’. 

  Window Management 

Altair Compose Figure Window can contain one or more plots. When a plot is created, 

a figure window is created as well. In addition, a figure window is created manually 

using the “figure(N)” command. Example is illustrated below. The ‘figure (n)’ 

command will activate the nth window. “close(n)” command will close figure ‘n’ and 

“close all” command closes all figures. Examples are illustrated below. See also 

Figure 6.1. 
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Figure 6.1 : Window management in Altair Compose 

 

 Plotting Function 

6.2.1 “plot(x,y)” 

When it comes to evaluating functions, plotting is one way of visually understand 

what your function does. Plotting is one key feature of the Altair Compose software. 

This section will feature how you can create and edit a plot for your functions. This 

command provide two-dimensional(2D) plot. 

To plot a function, you first need a sequence of numbers for your input values, like 

for example. 

> “x = 0:0.1:20” 

which defines a sequence of numbers ranging from 0 to 20 with step size 0.1. For the 

definition of a function we take: 

𝑦𝑦 = sin�
𝑥𝑥2 − 5
𝑥𝑥 � 

>” y = sin((x.^2-5)./x)” 

Notice, how the “.” operator is used to indicate that the function is evaluated 

component wise on the input sequence. 

For plotting, we need a figure where to plot into, which is created with: 

“f = figure” 
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We then can use the plotting function: 

“plot(x,y)” 

which results in plotting y over x and displaying the output result in the figure: 

 

Figure 6.2 : Plotting result 

 

If we want to plot a second function into the same figure we can evaluate the plotting 

function a second time after specifying with “hold on” that the same figure should be 

used. 

Changing the description on the axis as well as adding a title can be done with the 

following commands 

“xlabel(‘text’)” 

“ylabel(‘text’)” 

“title(‘text’)” 

A legend can also be added to the plot: 

“Legend(‘text1’,’text2’,…)” 

where the text1 and text2 are descriptions for the first and second function plotted 

on the figure as shown. 

Figure 6.3 : “hold on” command to plot into the same figure 
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Figure 6.4 : Changing descriptions, “title” and “legend” on the plot 

If you want to save your figure, you can use the “saveas(figure,’NameOfFile’)” 

function. Figure must point to the variable of the figure. 

 
Figure 6.5 : Save a figure with the “saveas” function 

 

6.2.2 “subplot(R,C,N)” 

This command will create multiple plots within a single figure window. ‘R’ indicates 

the number of rows of subplots in the window. ‘C’ denotes the number of columns of 
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subplots in the window. ‘N’ denotes the active plot number. The plots are number 

from left to right along a row as shown in the figure below. In the example given 

below, a figure is created with 2 rows and 3 column of subplots. The first window is 

the active plot. 

 

Figure 6.6 : “subplot” command in Altair Compose 

To create a “subplot” at a location of 2nd  row & 2nd column, the following example is 

shown. 

 

Figure 6.7 : “subplot” command in Altair Compose 

Here is another example to plot a “subplot” 

 

Figure 6.8 : “subplot” within one figure with the subplot(r,c,id) function 
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You can also annotate a plot with the “text(x,y,’text’)” function, where the x and 

y values are used to position the text onto the plot and the “text” value is the text 

displayed. 

Figure 6.9: Annotating a plot with the “text" function 

Please watch the following video and try for yourself: 

Plot Types 
There are different plot types in Altair Compose. The following are a list of it. 

• plot (2D Line) & plot3 (3D Line)

• scatter (2D scatter) & ‘scatter3’ (3D Line)

• ‘surf’(3D surface)

• ‘contour’ (2D contour) & ‘countour3’ ( 3D contour)

• ‘waterfall’ (3D waterfall)

https://altairuniversity.com/learning-
library/basic-introduction-in-compose-

plotting/ 

https://altairuniversity.com/learning-
library/getting-started-basic-plot-

commands/ 

https://altairuniversity.com/learning-library/basic-introduction-in-compose-plotting/
https://altairuniversity.com/learning-library/basic-introduction-in-compose-plotting/
https://altairuniversity.com/learning-library/basic-introduction-in-compose-plotting/
https://altairuniversity.com/learning-library/basic-introduction-in-compose-plotting/
https://altairuniversity.com/learning-library/getting-started-basic-plot-commands/
https://altairuniversity.com/learning-library/getting-started-basic-plot-commands/
https://altairuniversity.com/learning-library/getting-started-basic-plot-commands/
https://altairuniversity.com/learning-library/getting-started-basic-plot-commands/
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• ‘polar’ (Polar) 

• ‘loglog’ (2D with log base 10 x & y axes) 

• ‘bar’ (Bar) 

• ‘area’ (Area) 

h = plot(x, y, ‘fmt’, x, y, ‘fmt’, property, value) 

h = plot(hAxes,…) 

This command creates a 2D plot of one or more sets of data. The “plot(y)” command 

will plot ‘y’ values on the vertical axis against the vector index on the horizontal axis. 

The “plot(x,y)” and “plot(x,y,x,y…)” will plot the ‘x’ values on the horizontal axis 

and ‘y’ values on the vertical axis. Examples are illustrated below. “fmt” denotes the 

formatted string for the line. ‘Property’ and ‘value’ controls a graphic object in a plot. 

“hAxes” handles the axis in the plot. 

 

Figure 6.10 : “plot” command in Altair Compose 
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Figure 6.11 : Plot in Altair Compose 

 

 

Figure 6.12 : “plot” command in Compose 

 

h = scatter (x, y, …, color, style, property, value) 

h = scatter(haxes, …) 

This command handles the scatter plot graphics. It creates a 2D scatter plot of the 

data in vectors x and y. “color” denotes the color of the scattered dots. “style” 

denotes the style of the scattered dots. “property” and “value” controls the graphic 

object in a plot. “haxes” handles an axis in the plot. Examples are illustrated below. 
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Figure 6.13 : ‘scatter’ command in Altair Compose 

h =  plot3(x, y, z, …, ‘fmt’, property, value)  

h = plot3(hAxes, …) 

This command returns the handle of the 3D line object. It creates a 3D line plot in 

Cartesian space based on the three input vectors “x”, “y,” and “z”. If there is a 

complex vector, the real part is plotted along the y-axis and imaginary part along the 

z-axis. If the complex input does not have vector for x, the index of the complex 

number is the value plotted along the xaxis. “fmt” denotes the formatted string of the 

line. “property” and “value” controls the graphic object in a plot. “haxes” handles the 

axis in the plot. Examples are illustrated below. 

 

Figure 6.14 : “plot3” command in Altair Compose 

 

h = surf(x, y, z, …, color, property, value) 

h = surf(hAxes, …) 

This command returns the handle of the 3D surface object. The function will create a 

surface in the form of z=f(x, y) where x and y are vectors with the same rows/columns 

as matrix z. In the case where x and y are absent, the x-axis and y-axis values 

correspond to the column and row indices of matrix z. Example is illustrated below. 
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Figure 6.15 : “surf” command in Altair Compose 

 

h = contour (z) 

h = contour (x, y, z) 

h=contour (hAxes, …) 

This command returns the handle of the 2D surface object. The contour function will 

produce a 2D contour plot. If the first argument is a matrix “z”, the x- axis values in 

the plot are the row indices of matrix “z”. When the first two arguments are vectors 

“x” and “y”, the length of “x” vector must be the same as the number of rows in 

matrix “z” and the length of the “y” vector must equal the number of columns in 

matrix “x”. If the first argument is a contour handle, the contour plot is created on 

the corresponding system. Example is illustrated below. 

 

Figure 6.16 : “contour”command in Altair Compose 

h = contour3(z) 

h = contour3(x, y, z) 

h = contour3(haxes, ..) 

This command returns the handle of the 3D surface object. The contour function will 

produce a 3D contour plot. If the first argument is a matrix “z”, the x-axis values in 
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the plot are the row indices of matrix “z” and the y-axis values are the column indices 

of matrix “z”. When the first two arguments are vectors “x” and “y”, the length of 

the “x” vector must be the same as the number of rows in matrix “z” and the length 

of the "y” vector must equal the number of columns in matrix “x”. If the first 

argument is a contour handle, the contour plot is created on the corresponding 

system. Example is illustrated below. 

 

Figure 6.17 : “contour3” command in Altair Compose 

 

h = waterfall(z) 

h =  waterfall(x, y, z, …, color, …, property, value) 

h =  waterfall(hAxes) 

This command returns the handle of the waterfall plot. It creates a 3D plot of a surface 

by determining the 2D ‘slices’ of the surface along y-axis. If the first argument is a 

matrix “z” the x-axis values in the plot are the row indices of matrix “z” and the y-axis 

values are the column indices of matrix “z”. When the first two arguments are vectors 

“x” and “y”, the length of the “x” vector must be the same as the number of rows in 

matrix “z” and the length of the vector must equal the number of columns in matrix 

“x”. If the first argument is a contour handle, the contour plot is created on the 

corresponding system. “property” and “value” denotes the property and value that 

controls a graphic object in a plot. “haxes” denotes the handle of an axis in the plot.  

Example is illustrated below. 
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Figure 6.18 : “waterfall” command in Altair Compose 

 

h = polar(theta, rho, fmt, theta, rho, fmt, …) 

h = polar(complex, fmt) 

h = polar(hAxes, …) 

This command returns the handle of the polar line. It creates a 2D polar plot of the 

vectors “theta” and angle in radians and “rho” the radius. If a complex number is the 

numerical argument, “polar” will use the real part as “theta” and imaginary part as 

“rho”. If an axes handle is the first argument, polar will plot on the input handle axes. 

“fmt” denotes the formatting string for the line. “haxes” denotes the handle of an axis 

in the plot. Example is illustrated below. 

 

Figure 6.19 : “polar” command in Altair Compose 

h = semilogy(x, y, x, y, …, fmt, property, value) 

h =  semilogy(hAxes, …) 

This command returns a row vector of line handles. It creates a 2D plot of one or more 

sets of data where the y-axis is scaled by log base10. If there is only one argument, 

the command will plot the “y” values on the vertical axis against the vector index on 
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the horizontal axis. If the first argument is an axes handle, “semilogy” will plot the 

lines on those axes.”fmt” denotes the formatting string for the line. “property” and 

“value” controls the graphic object in a plot. “haxes” denotes the handle of an axis in 

the plot. Example is illustrated below. 

 

Figure 6.20 : “semiology” command in Altair Compose 

 

h = loglog(x, y, x, y, …, fmt, property, value) 

h =  loglog(hAxes, …) 

This command returns a row vector of line handles. It creates a 2D plot of one or more 

sets of data where the both axes are scaled by log base10. If there is only one 

argument, the command will plot the “y” values on the vertical axis against the vector 

index on the horizontal axis. If the first argument is an axes handle, “loglog” will plot 

the lines on those axes. “property” and “value” controls the graphic object in a plot. 

“haxes” denotes the handle of an axis in the plot. Example is illustrated below. 

 

Figure 6.21 : "loglog" command in Altair Compose 
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Please watch the following video and try yourself: 

 

https://altairuniversity.com/learning-library/getting-started-plot-types/ 

 Line Attributes 
The default color of the first three lines in a plot is blue, green, and red. In a ‘format 

string’ after the ‘x, y’ vector input adds one of the characters above to control the line 

and marker color. 

 

 

Color Code 
Blue b 
Green g 
Red r 
Cyan c 
Magenta m 
Yellow y 
Black k 
White  w 

Figure 6.22 : Color code in plot command 

https://altairuniversity.com/learning-library/getting-started-plot-types/
https://altairuniversity.com/learning-library/getting-started-plot-types/
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Markers are at the exact locations of the values in the ‘x’ and ‘y’ input vectors. By 

default, the markers are not shown. To add marker, add one of the below characters 

to a plot format string. 

 
 

 

Figure 6.23 : “plot” options in Altair Compose 

 

By default, the line is solid. To change the line style, add one of the characters in the 

table below to the data pair’s format string. 

 

Coordinate Type Code 
Point . 
Circle O 
x-mark X 
Plus + 
Star * 
Diamond d 
Triangle(down) V 
Triangle(up) ^ 

Line Type Code 
Solid - 
Dotted : 
Dashdot -, 
Dashed -- 
(none) No line is 

produced 
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Figure 6.24 : “plot” options in Altair Compose 

 

6.4.1 List of Other Plotting Commands 

There are other line commands listed below, which were not discussed in detail in the 

section above. 

Other plot functions 

clf(N) Clears the current figure or figure specified by 

handle... 

cla(N) Clears the current axes or axes specified by handle. 

legend(‘string1’,’string2’,…) Add a legend to the plot. String1 is for the first 

function, string2 is for the second function… 

hold on/off/all Next plot command is executed on the same figure 

when hold is set to on 

line(rowvec, rowvec) Draw a line onto the plot 

grid on/off Show / Hide grid 

axes(rowvec) Create a new axes or set current axes 
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Please watch the following video and try for yourself 

 

https://altairuniversity.com/learning-library/getting-started-line-attributes/ 

 

 Handle Management and Plot Attributes 
Plots are considered “objects” in Altair Compose. Each “object” is assigned a 

numerical value named a “handle”. Like object-oriented programming, each “object” 

has “children”. Information and modification of an “objects” & “children” is 

accomplished through the objects “handle”. 

The command “gcf” gives the current figure handle.  “get” command with no second 

argument gets the handles and the values of the children of the input handle. If a 

property is included in the second argument to “get”, the handle of the child 

requested is returned. Example is illustrated below. 

 
 

https://altairuniversity.com/learning-library/getting-started-line-attributes/
https://altairuniversity.com/learning-library/getting-started-line-attributes/
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Figure 6.25  : “get”  and  “gcf” commands  in Altair Compose 

 “get” command is used to find the handles of children. “set” command is used to 

change the values of the children. You can use “get” to retrieve handles of children 

lower in the hierarchy and “set” to modify their attribute. Examples are illustrated 

below. 
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Figure 6.26 : “get” and  “set” commands in Altair Compose 

 Exercises  

6.6.1 Plot Basic Sine and Cosine Waveform in Same Figure 

Window 

Step 1: Generate Sine Wave 

• Open Untitled.oml file. 

Type “clc”, “clear all”, and “close all” in the Editor Window to close all 

open plots, clear all variables, and remove previous commands. 

• Initialize time, amplitude value and sine wave equation. 

Type “t=0:0.01:1;” “a=2;” in Editor Window. Time range from 0 to 1 with step 

difference of 0.01. 

Type “b=a*sin(2*pi*t);”. 

• To plot waveform  

Type “plot(t,b);”   

Type “xlabel('Time');” to label x axis of the graph. 

Type “ylabel('Amplitude');” to label x axis of the graph. 

Type “title ('Sine wave');” to title the graph. Click run button. 
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Figure 6.27 : Generation of sine wave 

Step 2: Use Hold Command 

To retain a sine wave in the figure use the “hold on” command. Type “hold on”. 

 

Figure 6.28 : "hold on" command 

 

Step 3: Plot Basic Cos Waveform 

• Initialize time, amplitude value and cosine wave equation. 

Type “t=0:0.01:1;” “a=2;” in Editor Window. Time range from 0 to 1 with step 

difference of 0.01. 

Type “b=a*cos(2*pi*t);”. 

• To plot waveform  

Type “plot(t,b);”   

Type “xlabel('Time');” to label x axis of the graph. 

Type “ylabel('Amplitude');” to label x axis of the graph. 

Type “title ('Cos wave');” to title the graph. Click run button. 
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Figure 6.29 : Sine and Cos wave in same figure 

 

6.6.2 Create Subplot in Single Figure Window 

 

Step 1: Open Untitled.oml file 

Type “clc”, “clear all”, and “close all” in Editor window. 
Step 2: Create Sine Wave 

 

Figure 6.30 : Create Sine wave 

Step 3: Use Subplot to Plot 1st Wave 

Type “subplot(2,1,1)”.This define 2 rows ,1 column and 1st active plot 

number. 

 

Figure 6.31 : “subplot” command 
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Step 4: To Plot Sine Wave 

 

Figure 6.32 : Plot of sine wave 

Step 5: Create Cos Wave 

 

Figure 6.33 : Create cos wave 

Step 6: Use Subplot to Plot 2nd Wave 

Type “subplot(2,1,2)”.This define 2 rows ,1 column and 2st active plot 

number. 

 

Figure 6.34 : “subplot” command 

Step 7: Plot Cos wave 

 

Figure 6.35 : Plot of cos wave 
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Result Waveform 

 

Figure 6.36 : subplot of sine and cos wave 

 

6.6.3 Create a 3d plot, add legend and find the surface, 

contour of the plot 

Step 1: Open Untitled.oml file 

Type “clc”, “clear all”, and “close all” in Editor window. 

Step 2: Plot 3d 

Type the following line to create a 3d plot of x,y,z. Run the code. 

 

Figure 6.37 : 3d plot 
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Step 3: To Find Surface and Contour of Plot 

“meshgrid” is used to obtain vectors of x and y coordinates, return matrices X 
and Y corresponding to a full 2D grid. 

“figure 2” and “figure 3” is used to open new window. 

 

 

Figure 6.38 : Surface and contour of plot 

Step 4: Add Legend 

1. Type “figure 1;” to make the 3D line plot in figure 1 the current plot.  

1. Type “hold on;” to keep the current 3D line plot in figure 1 from changing for 

any subsequent plot or editing commands. 

2. To create a line connecting the beginning to the end of the 3D line plot. Type 

“plot3([x(1), x(end)], [y(1), y(end)], [z(1), z(end)], ’r’)” 

3. Type “legend(‘path’, ‘end-to-end’)” to create a legend in the plot in figure 1. 

Run the script. 
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Figure 6.39 : Adding legend to plot 

 

6.6.4 Create a 2d Plot from Above Exercise and Set the Title 

Step 1: Create a Plot from Variables Defined in Exercise 3 

Create a new row vector “r” from row 10 of matrix “Z” and plot against 

vector “t” in figure 4. Run the script. 

 

Figure 6.40 : Row vector of 10 

 

Step 2: Create a Title for the Plot in Figure 4 Using the “get”, “gcf”, and “set” 

Functions 

1. Type “fig4 = gcf;” and run the script to set the current figure handle to the 

variable “fig4”. 
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2. To view the attributes of the object “fig4” object using the type “get(fig4)” in 

the Command Window.  

 

Figure 6.41 : Get command 

 

3. To obtain the “children” handle of figure 4, type “fig4_children = get(fig4, 

‘children’);” in Editor window and run the script.  

4. In the Command Window, please type “get(fig4_children)” to view the 

contents of the object “fig4_children”.    

 

Figure 6.42 : To get children handle 

5. To obtain the handle for the “title” of figure four, “type fig4_title = 

get(fig4_children, ‘title’); “ in Editor window and run the script.  

6. View the contents of the object “fig4_title” by type “get(fig4_title)” in the 

command window. 
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Figure 6.43 : Get title 

7. To change the title of the plot in figure 4, type “set(fig4_title, ‘string’, 

‘waveform’); “in the Editor Window.  After running the script, the plot in figure 

4 should look like the figure below.  

 

 

Figure 6.44 : Waveform title added 
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7. Expressions, Logic and 

Looping 
Whenever a task must be performed repeatedly in a systematic way, loop structures 

are used. A loop is a repeatedly executed set of code in a program. It is very imported 

to write the logic properly for the execution of the loop. An expression is one which 

evaluated result either can be true or false. This section introduces the concepts of 

expressions and how they are used in various logic and looping concepts. It includes 

• General logic commands 

• Comparison commands 

• ‘is’ check commands 

  General Commands 

7.1.1 “for” 

The “for” loop is supported in Altair Compose using the syntax and provides the 

ability to define an incremental loop. Example is illustrated below. 

 

Figure 7.1 : “for” loop in Altair Compose 
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The increment in “for” loop doesn’t have to be an integer. Example is illustrated 

below 

 

Figure 7.2 : “for” loop non-integer in Altair Compose 

7.1.2 “while” 

A “while” loop is similar to a “for” loop but this loop will continue until a condition is 

met to end. Example is illustrated below. 

 

Figure 7.3 :”while” loop in Altair Compose 
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7.1.3 “if/else/elseif/end” 

“if/else/elseif/end” make use of the following operators. Example is illustrated 

below. 

==       !=        >         <         >=          <=          &           | 

 

 

Figure 7.4 : “if/else/elseif/end” logic flow control in Altair Compose 

 Comparison Commands 
lt() - Perform less than comparison, equivalent to the <operator. 

gt() - Perform greater than comparison, equivalent to the > operator. 

eq() - Perform equality comparison, equivalent to the == operator. 

le() - Perform less than or equal comparison, equivalent to the <= operator. 

ge() - Perform greater than or equal comparison, equivalent to the >= operator. 

ne() - Perform inequality comparison, equivalent to the != operator. 

or() - Or operator. Used for logical operations. 

and() - Perform logical conjunction, the 'and' operation. 

not() - Returns the logical NOT of a. Equal to R = ~a. 
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Example illustrated below. 

 

Figure 7.5 : Comparison commands in Altair Compose 

 

 “is” Check Commands 
“is” check commands will return True if the entity entered is of the type that matches 

the function. 

 

Figure 7.6 : “is” check commands in Altair Compose 

7.3.1 List of “is” Check Commands 

is axes isdir isfinite islogical ispc isstr 

is bool isempty isglobal ismac isprime isstruct 

is cell  isequal ishandle ismatrix isreal isunix 

iscellstr ishold ismember isscalar isvarname ischar 

isfield isinf isnan issorted isvector iscomplex 

isfigure isletter isnumeric isspace   
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Please watch the following videos and try yourself 

 

 

 

 

 Exercises 
 

7.4.1 Calculate a Sum with “if” and “while” loops. Observe the 

Difference. 

Step 1: Open Untitled.oml File 

Type “clc”, “clear all”, and “close all” in Editor window. 

Step 2: Consider “if “Loop Example 

1. Initialize value for “i =100;” and “sum = 0;” 

2. Define “if” statement and add logic inside loop as shown below. If statement 

executes a block of code if a specified condition is true. In this case i is greater 

than zero condition is true, and the following codes are executed. 

 

Figure 7.7 : “if” loop 

https://altairuniversity.com/learni

ng-library/getting-started-loops/ 

 

 

https://altairuniversity.com/learni

ng-library/getting-started-flow-of-

control/ 

 

 

https://altairuniversity.com/learning-library/getting-started-loops/
https://altairuniversity.com/learning-library/getting-started-loops/
https://altairuniversity.com/learning-library/getting-started-flow-of-control/
https://altairuniversity.com/learning-library/getting-started-flow-of-control/
https://altairuniversity.com/learning-library/getting-started-flow-of-control/
https://altairuniversity.com/learning-library/getting-started-loops/
https://altairuniversity.com/learning-library/getting-started-flow-of-control/
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Step 3: Consider “while” Loop Example 

1. Initialize value for “i =100;” and “sum = 0;” 

2. Define “while” loop and add logic inside the loop as shown below. The “while” 

loop       allows code to be executed repeatedly until a boollean condition is met 

to an end. 

In this case sum operation is done until i is equal to zero. 

 

Figure 7.8 : “while” loop 

7.4.2 Compute the Factorial of a Number Using a “while” Loop 

Step 1: Open Untitled.oml File 

Type “clc”, “clear all”, and “close all” in Editor window. 

Step 2: Initialize and Define Loop 

Type the following line to Initialize and define loop with logic. Factorial value is 

calculated until i reach zero by using “while” loop. 
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Figure 7.9 : Factorial of a number 

 

 

7.4.3 Create an Array, Report Whether The Entry is Even or 

Odd 

Step 1: Open Untitled.oml File 

Type “clc”, “clear all”, and “close all” in Editor window. 

Step 2: Initialize Input and Find the Size of Array. 

1. The input array as to be enter by user type “a = input(‘   ‘);” 

2. To find size of array type “size(a)”  

3. Type “r = size(a,1)” to total row value in array. 

4. Type “c = size(a,2)” to total column value in array. 

 

 

Figure 7.10 : Initialization and find size of array 

Step 3: Define Loop and Add Logic in Loop 

Two for loop are considered: One for row wise and another one for column wise. 
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To check even or odd “mod (a(i,j),2)==0” is used. Consider the logic as shown 
below. 

 

Figure 7.11 : Logic of even and odd example 

 

7.4.4 Create a Random Integer Matrix and Modify the Code to 

Store Two Random Integer Matrices as Members of a 

Struct 

 

Step 1: Open Untitled.oml File 

Type “clc”, “clear all”, and “close all” in Editor window. 

Step 2: Create a Random Integer Matrix  

1. Type “mat = rand(4, 7);” to create a 4 x 7 matrix of random . 

2. The lines three, four, and five will generate a matrix with integer values between 

zero and 50.  Line three sets the maximum value for matrix “mat_norm” to 50.   

3. Line four divides matrix “mat” element by element by the maximum value in 

Matrix “mat”.  Also on line four, the normalized matrix is multiplied element by 

element by “maxInt” so all the values in matrix are between 0 and 50 with the 

maximum value equal to 50.   

4. Finally, the “round” function rounds off the decimal part of each element in 

matrix “mat_norm” to get a matrix of integer values between 0 and 50.   
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Figure 7.12 : Random integer matrix 

5. Loop through the rows and columns of “mat_int” to perform the same operation 

on integer value 50. That is, randomly decide to keep or replace entries with 

integer value 50.   

A nested loop is required since we are looping in two dimensions. At each sub 

iteration, nested logic is required because the random keeping/replacing should only 

be done on entries with integer value 50.   

 

Figure 7.13 : “nested loop” 

Step 3: Modify the Code 

To store two random integer matrices as members of a struct using an additional 

outer loop. 

1. These two matrices can be stored inside a structure with respective fieldnames as 

shown below. let us utilize structs and dynamic field names instead. Store a cell 

array containing two struct member names entered as strings.   

 

Figure 7.14 : Two “struct” member name 



 
 

188 
 

 

Note that curly braces are used here.   

2. Click the Run button and review this variable’s data type. The data type is not 

‘string’. Cell array entries will always be of ‘cell’ type.  

3. Add an outer loop to the set of loops above. This is highlighted below.  

 

Figure 7.15 : Add outer loop 

 

4. Just inside the outermost loop, use “mat_int” to define the first member of struct 

A, using a dynamic field expression referring to the entries of cell array “membs”. 

This is highlighted in below. The entries of “membs” must be converted from 

“cell” type to “string” type using the char command.  
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Figure 7.16 : Add structure 

5. Click the Run button. Result Display’s struct “A” in the Command Window.  

 

Figure 7.17 : Result 
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8. Strings, Files and I/O 
Strings are fundamental and important entities in programming. Strings are a series 

of characters and provide a mechanism for a script to communicate with the user or 

files. Strings are often constructed with a set of given characters along with utilizing 

the values of variables within the program.  

File input and output (file I/O) operations are used to open, print and close file of 

different file types such as spreadsheets and notepad. Data can be read from files and 

data can be written to files using appropriate commands. This chapter explains the 

string format specifiers, functions and commands for string operations and file I/o 

operations. 

 Format Specifiers in Altair Compose 
When working with strings, control of formatting is important. In Altair Compose, 

literal strings are denoted using the single quote (next to the Enter button on typical 

keyboard). 

 
Figure 8.1 : Print a String 

 

When printing a string to the screen or file there are a variety of format specifiers to 

choose from, which are discussed below. 

• %s(%N.ns) 

• %d(%Nd) 

• %f (%N.nf) 

• %e(%N.ne) 

• %g(%N.ng) 
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8.1.1 “%s (%N.ns)”  

This is used to format a string. The ‘N’ designates total columns. The string will be 

written right justified in that set of columns. The ‘n’ defines how many of the 

characters of the given string will be written (again right justified). 

 

Figure 8.2 : string operation 

8.1.2 “%d” 

This format is to create an integer. The N designates the total columns. The integer 

will be right justified. This format specifier has no ‘n’. 

 

Figure 8.3 : More String Operations 

If a real is given with a “%d” then it will be truncated. 

 

Figure 8.4 : Truncated String 

8.1.3 “%f (%N.nf)” 

This format is to format a float or real. The N designates the number of columns. The 

number will be written right justified in that set of columns. The ‘n’ defines how many 

values after the decimal will be shown.  



 
 

193 
 

 

 

Figure 8.5 : More string operations 

8.1.4 “%e (%N.ne)” 

This format is used to create an exponential based format. The N designates the 

number of columns. The number will be written right justified in that set of columns. 

The ‘n’ defines how many values after the decimal will be shown. The exponent will 

be shown in two columns.  

 

Figure 8.6 : More string operations 

8.1.5 “%g (%N.ng)” 

This format is used when a number less than one million should be printed using ‘f’ 

format and a number equal to one million or more will be printed in the e-format. 

This is most useful when you don’t know the magnitude of a value ahead of runtime 

but want to print smaller numbers in ‘f’ format. 

The N designates the number of columns. The number will be written right justified 

in that set of columns. The n defines how many values after the decimal will be shown. 

The exponent will be shown in row columns in the case where it writes in the e format.  
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Figure 8.7 : More string operations 

 

 General Commands for String Operation 

8.2.1 “stcmp(‘string1’, ‘string2’)” 

This command compares string1 and string2. If they are exactly the same, it returns 

1. (i.e. true) otherwise it returns 0. (i.e. false). 

 

Figure 8.8 : "strcmp" command 

8.2.2 “strcat(‘string1’, ‘string2’)” 

This command appends each subsequent string to form one single string. You have to 

insert blank spaces where desired. Example is illustrated below. 

 

Figure 8.9 : "strcat" command 

 

8.2.3 “strfind(‘string1’, ‘string2’)” 

This command looks to find instances of string2 inside of string1. A vector will be 

returned with each value representing the character position in string1 where 

string2 begins. Example is illustrated below. 
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Figure 8.10 : “strfind" command 

8.2.4 “strsplit(‘string’, ‘string’)” 

This command will break a string at the spaces and store each word in a position in a 

cell. You can however use an optional delimiter argument. Example is illustrated 

below. 

 

Figure 8.11 : "strsplit" command 
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8.2.5 “strjoin(cell, ‘string’)” 

The cell data members of this command should be strings. By default, this command 

will join all the cell members with as space between each. The optional string 

argument can replace the space as the item put between each data member. Example 

is illustrated below. 

 

Figure 8.12 : "strjoin" command 

8.2.6 “strtrim(‘string’)” 

This command trims the spaces on either side of the given string. Example is 

illustrated below. 

 

Figure 8.13 : "strtrim" command 

 

8.2.7 “lower (‘string’);   tolower(‘string’) / upper(‘string’);   

toupper(‘string’)” 

This command modifies the given string to be all lower or upper case. 
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Figure 8.14  : "lower" and "toupper" command 

8.2.8 “sprintf( ‘format’, number)” 

This command returns the given number as a string using the format specifier. 

Example is illustrated below. 

 

Figure 8.15 : "sprintf" command 

 

 Files & I/O 
This section introduces you to reading from files and writing to files, which is one of 

the most important capabilities of Altair Compose. There are two categories of I/O. 

• General I/O 

• Usage of Altair’s data file readers & writers (same as those in HyperGraph) 

 

8.3.1 General I/O 

General I/O consists of four steps 

• Open file in either read, write or read/write 

• Read/write data to/from file 

• ASCII & Binary 

• Close file 
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“fopen ( ‘filename’, ‘intent’)” 

File name is the name of the file you are opening to read from or write to or both. 

Intent is to designate if you are reading, writing or both. Valid options for intent 

include r, w, a, r+, w+, a+. 

File read options 

r Open existing file for reading 

w Open existing or new for writing, discard any contents already in file 

a Open existing or new for writing, append to contents already in file 

r+ Open existing file for reading and writing 

w+ Open existing or new for reading & writing, discard contents already 

in file 

a+ Open existing or new for reading & writing, append to contents 

already in file.  

 

“fprintf( fid, ‘string’)” 

This command is used to write information to a file using the same string formatting 

as discussed earlier in section 8.1. “fid” is the file id that was returned from the fopen 

command 

“fclose(fid)” 

This command is used to close the file such that all contents written to it are available 

to users. 
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Examples using ‘w’ 

 

 

 

 

 

When fopen is executed “myfile” is created in the file browser. 

Example using ‘a’  

The use of “\n” is to ensure the next text is written on a new line (typically you would 

put the “\n” at the end of the previous line). 

 

 

“fgets(fid)” 

This command reads the next line in a file as one string. Example is illustrated below. 

Consider a notepad and type as shown below and save it as color.txt. 

Figure 8.16 : File output with option w 

Figure 8.17 : File output with an option 

This opens the note pad 
named myfile 
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1. Red 
2. Orange 
3. Green      

Before trying the example check the current directory where color.txt is present. 

 

Figure 8.18 : "gets" command 

Double click on color.txt in file browser. If the directory does not match or if the 
notepad is not present it shows. 

 

Figure 8.19 : File is not open 

“fid  = -1” means file is not opened for read operation. 

A string can be converted to number in the following way. The below example shows 

how to read lines and turning them to numbers. (Change line no.2  to 15.2 in color.txt)  

 

Figure 8.20 : Conversion of string to number in Altair Compose 
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The below example shows how to read a line with several values and storing those in 
individual cells. 

 

Figure 8.21 : Conversion of string to number in Altair Compose 

 

• Basic File Operations like “fopen” ,” fprintf”, “fgets”, “fclose” watch the 

video and try it yourself. 

• Write data types like double, matrix, cell, structure, and complex number to 

csv-files. Watch the video and try it yourself. 

 

 

 

 

https://altairuniversity.com/learnin
g-library/getting-started-basic-file-

operations/ 

 

 

 

 

 

 

https://altairuniversity.com/learnin
g-library/writing-different-data-

types-to-file/ 

 

https://altairuniversity.com/learning-library/getting-started-basic-file-operations/
https://altairuniversity.com/learning-library/writing-different-data-types-to-file/
https://altairuniversity.com/learning-library/getting-started-basic-file-operations/
https://altairuniversity.com/learning-library/getting-started-basic-file-operations/
https://altairuniversity.com/learning-library/getting-started-basic-file-operations/
https://altairuniversity.com/learning-library/writing-different-data-types-to-file/
https://altairuniversity.com/learning-library/writing-different-data-types-to-file/
https://altairuniversity.com/learning-library/writing-different-data-types-to-file/
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• Read data types like double, matrix, cell, structure, and complex number from 
csv-files. Watch the video and try 

 

. 

 

 HyperGraph 
            There are several commands which can be leveraged to import data from files 

with formats that HyperGraph can read (examples include most CAE solvers on the 

market). When HyperGraph readers are used, they bin the data from the file into the 

following groups where each group has the ‘children’ shown below it: 

• Subcase 

• Type 

• Request 

• Component 

Here is an example of a file read into HyperGraph 

 

Figure 8.22 : HyperGraph Build Plots Panel 

 

https://altairuniversity.com/learnin
g-library/getting-started-reading-

different-data-types/ 

 

https://altairuniversity.com/learning-library/getting-started-reading-different-data-types/
https://altairuniversity.com/learning-library/getting-started-reading-different-data-types/
https://altairuniversity.com/learning-library/getting-started-reading-different-data-types/
https://altairuniversity.com/learning-library/getting-started-reading-different-data-types/


 
 

203 
 

 

8.4.1 “getrequestname(‘filename’, subcase, typeindex, 

reqindex)” 

This command is used to retrieve the string of the request for the selected type and 

request index (for a selected subcase index).  

 

 

 

 

 

Figure 8.23 : To get title and request name 

8.4.2 “getcompname(‘filename’, subcase, typeindex)” 

This command is used to retrieve the string of the component for the selected type 

index. Example is illustrated below. 

 

Index 1  

Index 3 
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Figure 8.24 : “getcompname” command in Altair Compose 

8.4.3 “readvector(‘filename’, subcase, typeindex)” 

This command is used to retrieve an array of values from the given filename for its 

corresponding type/request/component. 

 

Figure 8.25 : “readvector” command in Altair Compose 

 

 

 

 

 

. 
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 Exercise:  

8.5.1 Strings and File IO 

For example, consider the following data and save them in a notepad. Save it as 

“in_temp.txt”. 

 

Figure 8.26 : Values in notepad 
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Step 1: Open the File “in_temp.txt” in File Browser. 

In file browser click on yellow folder (right side) to select the path where the file is 

saved. 

Step 2: Read in the Data in the in_temp.txt File  

1. Begin with the clear all and close all lines.  

2. Use fopen to open the in_temp.txt file in the current directory, using the pwd 

command and strcat.  

3. Read in all fixed-point values line by line in the open file using fscanf. The fixed-

point value specifier is “%f”. 

 

Figure 8.27: Open .txt file 

 

Step 3: Process the Data in a Function  

1. Scale the temperature by the factor ‘a’ and offset by a value of ‘b’.  

2. Spread these values across a dependent range of 1-1000. 

3. Enclose the data processing in a function. Call it “revalue”, with inputs “(a, b)” 

and outputs [temp_in, d].  
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Figure 8.28 : Define function 

Step 4: Call the Function  

1. Use “[a, b] = [1.1,300]” as the input.  
 

 

Figure 8.29 : Call the function 

  

Step 5: Plot the Processed Data  

1. Title it with the max and min values in the data using “num2str”, max, min, and 

strjoin. One way of respecting spaces at the ends of strings is through the use of 

curly braces.   
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Figure 8.30 : Plot data 

8.5.2 Using HyperGraph Readers for IO  

In this exercise, importing data using Altair HyperGraph Readers is introduced. The 

displacement results from a RADIOSS simulation will be plotted.  

Note:  Be sure to use Command Window when requested and Editor Window when 

requested as this exercise mixes the use of both. You should copy the file: testT01   

Step 1: Open the File “testT01” in File Browser. 

In file browser click on yellow folder (right side) to select the path where the file is 

saved. 

Step 2: Store the Result File Name as a String  

1. This will be used in commands to extract the data. Be sure that the file is located 

in the current directory, which can be displayed/set with the pwd command.  

 

Figure 8.31 : Result file 

2. Run the script.    

Step 3: Review How the Data is Binned in the File  

1. Use “getsubcaselist(fileName)” to list the subcases in a vector.  
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Figure 8.32 : To list the subcases in a vector  

There are no subcases in this result file.  

2. Use “gettypelist(fileName)” to see the children of the specified subcase.  

 

Figure 8.33 : To list the type in a vector 

 
3. Use “getreqlist(fileName, gettypename(fileName,3))” to see the available 

requests for the Node/displacement type.  

 

Figure 8.34 : To get request list 

  
4. Use “getcomplist(fileName, gettypename(fileName,3))” to see the available 

components for the Node/displacement type.  
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Figure 8.35 : To get components list 

Step 4: Store the Group Names as Strings in Different Variables  

1. Store Node/displacement Type group as a string using “gettypename”.  

 

Figure 8.36 : To get Node/displacement type 

  
2. Store the 5455707 Request group as a string using “getreqname” . 

 

Figure 8.37 : To get request name 

  
3. Store the DX-X Displacement Component group as a string using “getcompname”.  

 

Figure 8.38 : To get component name  

Step 5: Store the Component Group Values in a Vector  

1. Use “readvector” to store these values in a variable.   
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Figure 8.39 : To store value in variable 

Step 6: Store the Group Names as Strings in Different Variables and Component 
Group Value in a Vector 

To store type, request, component group for time and use “readvector” to store 

these values in a variable. 

  

Figure 8.40 : To store group name 

  
Step 7: To Plot Time Verse DX-X Displacement 

 

 

Figure 8.41 : To obtain a plot 

 

Figure 8.42 :Results 
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9. Functions and Debugging 
Functions are relatively small programs that use a combination of the commands 

presented to achieve a specific purpose. When your scripts become larger, it is 

sometimes hard to maintain the overview on where the code does what. One way of 

organizing your code is by using functions within Compose.  

Functions can be designed to take in “arguments” when called and can be designed 

to return information to it’s calling context. Functions can be stored in files and 

accessed by scripts outside the file where the function is stored. Functions can be 

understood as portions of the code which are packed together and have both some 

input and output values. 

 Syntax and Scoping 

9.1.1 Syntax to Define a Function 

 

Figure 9.1 : Define a function 

Let’s assume, you frequently have to apply this function to a number: “Take the 

square root of the number times 2 plus 10”. Instead of writing the equation each 

time, we can use a function for this.  

For the simple example from above, it would look like this: 

 

Figure 9.2 : Simple example for a function 

We must save the function within the file editor as an “.oml file” and run this file 

before we can use the function. One way to use this function is within the created 
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file, another way is to use it in the oml- command window. A function is called by 

using its name and specifying the input variable within the brackets. For our example 

this looks like this: 

 

Figure 9.3 : Function example 

Functions can have multiple input variables. There are two ways how to define your 

input variables. One way is to specify them directly. For example let’s assume, we 

want to specify the division as a function.  

 

Figure 9.4 : Function for the division 

As it is displayed in Figure 9.4, both the numerator and denominator are specified. 

Another way of specifying multiple input arguments is by using the varargin variable. 

This variable is predefined by Altair Compose and can be understood as an array of 

input arguments. So varargin{1} would refer to the first input argument specified, 

varargin{2} to the second and so on. Our division function would look like this, if we 

used the varargin approach: 

 

Figure 9.5 : Function for the division with varargin 
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To test these functions the following code is used: 

 

Figure 9.6 : Testing the before mentioned functions 

Note: Run all the functions shown in Figure 9.2, Figure 9.4 and Figure 9.5 before trying 

the code from Figure 9.6. 

9.1.2 Syntax to Call a Function 

[res1, ... , resN] = function_name(argument1, ..., argumentN) 

Note - Brackets can be omitted, when only one value is returned. 

9.1.3 Example of Syntax 

 

 

function_name  

Figure 9.7 : To call a function 

Example 1 

This function uses the value input passed in to assign a discrete value to W. 
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Figure 9.8 : Function example 

 Example 2 

This function returns a vector of data. 

 

Figure 9.9 : Function example 2 

 Scoping 
Variables which are defined inside a function are valid only within that function. This 

is known as having ‘local scope’. Although not typically a good practice, variables 

declared outside the function with a global statement can be accessed inside the 

function. Example is illustrated below. 



 
 

217 
 

 

 

Figure 9.10 : Scoping example 

9.2.1 Storing Functions in Files 

The typical use of functions is that they will be defined in one file but used by other 

files, or the command window. The recognition of the functions is based on the path 

command that was listed in the chapter ‘Commands & data types’.  

 Commands Applicable for Functions 
There are several commands that apply to functions as shown below. 

9.3.1 “builtin(arg1, arg2,…)” 

This command is used in the case where you have overloaded a function that also 

exists in the core product, you can access the function in the core product using this 

command. Example is illustrated below. 

 

Figure 9.11 : “builtin” command in Altair Compose 

9.3.2 “cellfun(‘func’, cell)” 

This command calls the function ‘func’ as many times as there are entries in cell, each 

time using a single cell entry. 
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Figure 9.12 : “cellfun” command in Altair Compose 

9.3.3 “error(‘string’); warning(‘string’)” 

This command echo’s a string in the user defined context. The string also provides 

information about the function where it is being called from. Example is illustrated 

below. 

 

Figure 9.13 : Error example 

9.3.4 “nargin(‘[string]’)” 

This command provides the number of arguments passed onto the function. Optional 

string allows you to provide function name and will provide the number of arguments 

listed by the function definition. Example is illustrated below. 

 

Figure 9.14 : “nargin” command in Altair Compose 
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9.3.5 “feval( ‘string’, arg1, arg2, …)” 

This command evaluates the function listed by string by passing the arguments of 

arg1, arg2, etc. Example is illustrated below. 

 

Figure 9.15 : “feval” command in Altair Compose 

 

9.3.6 List of Other Commands Related to Functions 

Lasterr Narginchk Extract 

Lastwarn Natgoutchk  

Assignin Nargout  

Funcount addtoolbox  

 

 
https://altairuniversity.com/learning-library/functions/ 

 

https://altairuniversity.com/learning-library/functions/
https://altairuniversity.com/learning-library/functions/
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 Debugging 
The most common use of the product is to develop scripts and run them. This is 

where the Altair Compose Debugging capability can be an essential tool. 

 

When you invoke the debugging mode, additional windows will appear to assist 

with the debugging process (they can be turned off in debugging mode). The 

additional windows appearing during debugging mode is illustrated below. 

 

 

Figure 9.17 : Additional windows during debugging mode 

Figure 9.16 : Debugging toolbar 
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Break points are central to debugging as they enable you to stop a script at any point 

and monitor the script output and internal variables. You can add/manage 

breakpoints through the debug menu or context menu’s in the edit area or the debug 

window shown below. 

 

 

Figure 9.18 : Adding break point 

 

Another way of adding breakpoint 

 

Figure 9.19 : Adding break point 
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Example: 

 

Figure 9.20 : Breakpoint example 

The most convenient way to add and delete breakpoint is to mouse click on the grey 

bar left from the Edit window next to the chosen code line 

Table of Debugging Buttons- 

 
This button is known as ‘step over’ which is used to execute next 

line. Arrow in margin indicates the movement to next point. 

 
This button is known as ‘continue’ which is used to resume 

execution until the next breakpoint 

 
This button is known as ‘step Into’ which is used to enter a 

function. 

 
This button is known as ‘Step Out’ which is used to exit a 

function and moves to point where function was called. 

 
This button is known as ‘Step Until’ which is used to executes 

until line where the cursor is located.  

 



 
 

223 
 

 

9.4.1 Watch Window 

 

Figure 9.21 : Watch Window in debugging mode 

The watch window enables you to watch values of variables in real time. The values 

will update as the script moves forward. As shown in the figure below, you can add 

variables in a couple of ways. One is to highlight and drag from the edit window. 

Another is to type in the variable where it says ‘click to add new item’. The variable 

can be overridden in the watch window and the value will hold until the script 

overloads that new value.  

 

Figure 9.22 : Add and remove variables in Watch Window 

 

9.4.2 Call Stack Window 

 

Figure 9.23 : Call Stack Window in debugging mode 

The Call Stack gives you the context of the breakpoint in terms of functions that have 

been called to that point. For example, if function A calls function B and B calls C, when 

your breakpoint in C is hit, you will see a call stack showing main, A, B, C in that order.  
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Figure 9.24 : Call Stack operation in debugging mode 

Watch the videos below and try it yourself. 

 

 

  

 

 

 Exercises 

9.5.1 Write a Function to Calculate the Roots of a Polynomial 

Step 1: Open Untitled.oml File 

Type “clc”, “clear”, and “close all” in Editor window. 

Step 2 : Define a Function 

1. Use a simple quadratic equation. Name it quadratic. 

2. Make the function inputs the coefficients of the quadratic equation. Input ‘a’ 

corresponds to the coefficient of the second order variables, ‘b’ to the first, 

and so on.   

https://altairuniversity.com/learning-
library/basic-introduction-in-compose-

debugging/ 

https://altairuniversity.com/learning-

library/getting-started-debugging/ 

 

https://altairuniversity.com/learning-library/basic-introduction-in-compose-debugging/
https://altairuniversity.com/learning-library/basic-introduction-in-compose-debugging/
https://altairuniversity.com/learning-library/basic-introduction-in-compose-debugging/
https://altairuniversity.com/learning-library/basic-introduction-in-compose-debugging/
https://altairuniversity.com/learning-library/getting-started-debugging/
https://altairuniversity.com/learning-library/getting-started-debugging/
https://altairuniversity.com/learning-library/getting-started-debugging/
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3. Calculate the roots.  

4. Save this “*.oml”. as “quadratic.oml”. The name of the file must match the 

function name if it is to be called in a separate “*.oml”. file.  

 

Figure 9.25 : Define a function 

Note: A function will work only if it was previously executed, i.e. run the function file 

before the calling program to be executed. 

Step 3: Call the Function 
In new “*.oml”. get the output of “quadratic” in two variables using 

“(a,b,c) = (1,0,-4)” 

 

Figure 9.26 : Call the function 

Step 4: Result 

 

Figure 9.27 : Value of X1 and X2 

9.5.2 Debugging the Program to Obtain Correct Value of pi 

Step 1: Open Untitled.oml File 

1. Type “clc”, “clear all”, and “close all” in Editor window. 

2. Type the following code.This code is to find the pi value. 
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Figure 9.28 : To find pi value 

Step 2: Click the Run Button  

The following should be displayed:  

 

Figure 9.29 : Pi value is shown as a symbol 

Step 3: Fix the Output Sentence Using Debug Mode  

1. Enter Debug Mode by clicking Debug > Start Debugging.  

2. In Step 2, we see that pi is displayed as some symbol. This is because it needs to 

be of string type. Change it to string type by using “num2str”.  

 

Figure 9.30 : “numstr” command used for pi 

3. Add a break point at the line of code preceding and click run. Display the value 

of pi in the Command Window.  

 

Figure 9.31 : Pi value 

The value of pi is outputted properly but the value is still incorrect.  
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4. The section of code below correctly corresponds to this equation to calculate pi 

assuming pi is properly initialized.  

𝜋𝜋
4

= � (−1)𝑘𝑘+1

2 𝑘𝑘−1

∞

𝑘𝑘=1
 = 1 − 1

3
+ 1

5
− ⋯. 

5. What is the value of pi after the first loop iteration? Check this by adding a  

line of code to display the value of pi after the summation, and a break point at 

this line.   

Save the oml file and click on debug, start debug this show the window below, 

select “New Breakpoint…”, type the line number (6) and press ok. 

This add the breakpoint at line 6. 

 

 

Figure 9.33 : To add breakpoint 

 

6. Select debug, watch and add the value pi. Click Run and watch the values of pi 

change with each iteration (click). The value of pi after the first iteration is 4.0082.  

Figure 9.32 : Logic of “for” loop 
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Figure 9.34 : Watch window 

7. From the equation on the left in Step 3:4, the value of pi after the first iteration 

should be 1. This means that pi was initialized at 3.14159, not 0 as it should be. 

The initialized value of pi was not in scope. Make it in scope. 

 

Figure 9.35 : To find the value of pi 

8. Exit Debug Mode and click Run with N=1000. The sentence should now be 

correct.  

9. This approximated value of pi overloaded the built-in pi value. Reset the value of 

pi with the built-in value using builtin.  

 

Figure 9.36 : “builtin()” of pi 
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10.  Higher Level Commands 
This section covers the following categories of built in commands: 

• Differential Equations 

• Numerical Integration 

• Signal Processing  

 Differential Equations:   
Many problems in all branches of science and engineering are expressed using 

mathematical terms. The mathematical equation which define the relation between 

function (physical quantities) with its derivatives (rates of change) is called as 

differential equation 

A set of commands for solving Ordinary Differential Equations is included with  

“ode45”; “ode113”; “ode15i”; “ode15s”; “odeset”.  

Let’s consider some exercise on differential equations 

10.1.1 Exercises 

1. Compute Numerical Differentiation of the Row Vector 

Step 1: Open untitled.oml flie. 

Type “clc”, “clear all”, and “close all” in the Command Window to close 

all open plots, clear all variables, and remove previous commands. 

Step 2: Consider a Row Vector  

Type “x = [3 5 7 1]” in Command Window. Type “x1 = diff(x)”. This returns 

n-1 vector. 

 

Figure 10.1 : Numerical differentiation 
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[Note – The function “diff(x)” returns a vector of n-1 elements, not n elements.] 

 

2. System Dynamics: Model and simulate the dynamics of a spring-mass-damper 

system to a unit force input. 

This exercise explains, how to solve a classical mass damper system subject to a unit 

input with the Runge-Kutta-Fehlberg 45 solver. The general equation for this system 

can be written as: 

𝑚𝑚 ⋅
𝑑𝑑2𝑥𝑥
𝑑𝑑𝑡𝑡2

+ 𝑐𝑐 ⋅
𝑑𝑑𝑥𝑥
𝑑𝑑𝑡𝑡

+ 𝑘𝑘 ⋅ 𝑥𝑥 = 𝐹𝐹(𝑡𝑡) 

For the meaning of the variables, please refer to Figure 10.2. A second order 

differential equation is used for illustration purposes as they are more common. 

The equation is reduced to first order (This is a required step since the ODE solvers 

can only solve first order explicit equations) by introducing a second variable to create 

a system of two equations. We take x1 to be the position of the mass and x2 to be the 

velocity of the mass. Position and velocity are linked together with the following 

equation: 

𝑑𝑑𝑥𝑥1
𝑑𝑑𝑡𝑡

= 𝑥𝑥2 

Inserting the variables in the general equation above and solving for the second order 

derivative leads to: 

𝑑𝑑2𝑥𝑥2
𝑑𝑑𝑡𝑡

= 𝐹𝐹(𝑡𝑡) − 𝑐𝑐 ⋅ 𝑥𝑥2 − 𝑘𝑘 ⋅ 𝑥𝑥1 

Let’s look that the following step in Altair Compose. 

1. Model the differential equation(s) of the system using numerical math language. 

2. Solve the equation using a Runge-Kutta-Fehlberg 45 solver. 

3. Visualize the results (in this example - velocity & position). 
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4. Modify the parameters (damping, stiffness, etc.) to understand the change in 

system dynamics. 

 

Figure 10.2 : Simple mass oscillator system and its differential equation 

Step1: Open a untitled.oml File 

Type “clc”, “clear all”, and “close all” in the Editor Window to close all 

open plots, clear all variables, and remove previous commands. 

 

Step 2: Define the ODE (Ordinary Differential Equation) System Function 

A differential equation of the system function is defined by typing the 

following lines into the Editor Window.  

Note that in Altair Compose, this definition must be done before it is used in 

proceeding lines or next steps. 

 

Figure 10.3 : Function definition 
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The system function implements the two equations derived above. The first 

argument is the current time, and the second argument contains the values 

of the state variables in a vector. 

Step 3: Solve the System Using the ODE Solver 

1. Solve the system by using Runge-Kutta-Fehlberg 45 solver (“ode45” function) 

as shown below in Editor Window with the inputs as follows. 

 

Figure 10.4 : "ode45" command 

The first argument is for the ODE system function. The second argument is 

the vector of times at which to solve the equation. The third argument is the 

initial condition vector for the state variables. The default tolerances are 

explicitly specified in the options argument for illustration. 

The time vector is reproduced as the first output argument. It is identical to 

the input for this case. The second output argument, x, contains the values of 

x1 and x2 by the column at each time in vector t. 

Step 4: Plot the Results 

Visualize the results by a plot of time versus position and plot of time versus 

velocity. Type the following lines in Editor Window. Type run icon to execute 

code, notice the change in results when the damping value is set to 1(c = 1) 

in the second plot below. 
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Figure 10.5 : Plot of solution 

3. Nonlinear First Order ODE of the Bernoulli Form 

Step 1: Open untitled.oml File 

Type “clc”, “clear all”, and “close all” in the Editor Window to close all 

open plots, clear all variables, and remove previous commands. 
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Step 2: Function Definition  

A nonlinear first order ODE of the Bernoulli form is defined by typing the 

following lines into the Editor Window. This equation will be solved in the 

successive steps. 

Note that in Altair Compose, this definition must be done before it is used in 

proceeding lines or next steps. 

 

Figure 10.6 : Function definition 

Step 3: Define Initial Values  

Define the boundary values as shown below in the Editor Window.  

 

Figure 10.7 : Initial values 

Step 4: Solve the Equation and Plot the Solution  

Store the solution in new variables [T,Y] and solve the equation using the 

ODE45 command in the Editor Window and plot the solution. 
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Figure 10.8 : Plot of equation 

Any time-history can be defined by a sum of sine waves (w) each with a 

weighting factor (A): 

Step 6: Solve the Equation with a Different Solver and Plot the Solution  

In the Editor Window, use the ODE113 command to solve/plot the solution 

with a blue line. The inputs are the same. Run the code. 

 

 

Figure 10.9 : ODE113 command 
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4. Find Impulse Response of the Difference Equation 

While designing some systems or filters it is required to know the impulse response 

of the system so that it is easy to characters the system. In Altair Compose we can 

calculate the impulse response by know the coefficient value of numerator and 

denominator of the equation. For example, let’s consider Difference equation as 

shown.   y(n) - 1
2
𝑦𝑦(𝑖𝑖 − 1) =  1

2
𝑥𝑥(𝑖𝑖) +  1

2
𝑥𝑥(𝑖𝑖 − 1)  

• Get Input coefficient of numerator and denominator 

• Get the length of impulse response sequence 

• Find the output using “impz(b,a,N)” 

• Plot output 

• Let’s look that the step in Altair Compose. 

 

Step 1: Open untitled.oml flie 

Type “clc”, “clear all”, and “close all” in the Editor Window to close all 
open plots, clear all variables, and remove previous commands. 

[following step are done in editor Window]. 

Step 2: Define Inputs 

Type “b”,“a”  and “N” as shown below. This defines the input coefficients. 

 

Figure 10.10 : Defining Input. 

Step 3: To find Impulse Response 

 Type “[h,t] = impz(b,a,N)” to find impulse response. This defines number of 

samples of impulse response. 
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Figure 10.11 : “impz” command 

Step 4: To Plot Output Sequence 

“Stem” is used to plot the output. Type the proceeding line as shown below. 

This define the title, label of x axis and y axis.  

 

Figure 10.12 : Plot of output 

 

Figure 10.13 : Output impulse sequence 
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 Numerical Integration 

The numerical value of an integral can be calculated using a broad family of 

algorithms. This process in numerical analysis is called numerical integration. This is 

also referred to as the numerical solution of the differential equation. The aim of 

numerical integration is to compute an approximate solution to a definite 

integral.∫ 𝑓𝑓(𝑥𝑥)𝑑𝑑𝑥𝑥2
1  

 

Figure 10.14 : Numerical integration 

10.2.1 Exercise  

1. Solve    f(x) = 𝒆𝒆−𝒙𝒙𝟐𝟐(𝐥𝐥𝐥𝐥𝒙𝒙)𝟐𝟐 
 
• We define “fun” to be the function to integrate. In this, “y” is the variable to 

be integrated. Type the equation as shown below in the Command Window 

• The “quad” command is used to calculate numerical integration. Type “q = 

quad(fun,0,inf)” The first argument is the function to integrate, second 

argument is the lower integration limit (in this case is zero)and third 

argument is the upper integration limit.(in this case is positive infinity). 
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Figure 10.15 : “quad” command 

 

2. ∫ 𝒙𝒙√𝟏𝟏 + 𝟐𝟐𝒙𝒙 𝒅𝒅𝒙𝒙𝟎𝟎
𝟒𝟒  

 
• “fun” is the function to integrate. In the function, “x” is the variable to 

be integrated. Type the equation as shown in the Command Window 

• Evaluate integration from 4 to 0. 

• Type the following line. 

 

 

Figure 10.16 : “quad” command 

 Signal Processing 
A signal is a function which is used to convey information from one end to another 

end. The Science of studying, synthesizing and altering of signals is called “Signal 

processing”. Signal quality, storage efficiency and ease transmission can be improved 

by signal processing. Further, detection, isolation and enhancement of component of 

interest can also be done using signal processing techniques  

Signal processing has numerous field applications, some are Digital signal processing 

(DSP), Audio signal processing, Image Processing etc. In DSP (digital signal processing) 

signals are converted from time domain to frequency domain for better signal analysis 

(refer exercise 10.3.3).  To do the conversion, foruier transformation is used. Discrete 

Fourier Transform (DFT) and Fast Fourier transform (FFT) are used for this propose. 

Another important concept is eliminating unwanted signal from the original signal this 

is done with the help of filters. Some filters are Low pass filters, High pass filters, 
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Bandpass filters, Bandstop filters, All pass filters, Butterworth filter, Chebyshev filter 

(type I and type II), Bessel filter etc. Altair Compose supports nearly 20 commands 

dedicated to signal processing. It includes 

freq filter butterd cheb1ord 
freqs filtfilt besself cheb2ord 
freqz cheby1 blackman normalize 
fft cheby2 ellip  
ifft   butter ellipord  

 

First, let’s consider an exercise to generate the basic signals, how to compute Discrete 

Fourier Transform (DFT) for the given sequence and how to convert a signal from time 

domain to frequency domain, design a filter to remove desired frequency content 

from the original data. 

10.3.1 Exercise: Generate the Basic Signals 

Basic signals are the building blocks for many complex signals, these are used to test 

a system. Hence, they play a very important role in the study of signals and systems. 

Let’s generates the basic signals like the sinusoidal wave, cosine wave, square 

waveform, exponential waveform, sawtooth waveform, triangle waveform, ramp 

waveform, unit step signal and unit impulse. 

1. Sine Wave 

Step 1: Open Untitled.oml File 

Type “clc”, “clear all”, and “close all” in the Editor Window to close all open plots, 

clear all variables, and remove previous commands. 

Step 2: Initialize Time, Amplitude Value and Sine Wave Equation 

1. Type “t=0:0.01:1;” “a=2;” in Editor Window. This defines a time range from 

0 to 1 with step difference of 0.01 and a constant “a” with value 2. 

2. Type “b=a*sin(2*pi*t);”. 
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Step 3: To Plot Waveform  

1. Type plot(t,b);   

2. Type xlabel('Time'); to label x axis of the graph. 

3. Type ylabel('Amplitude'); to label y axis of the graph. 

4. Type title ('Sine wave'); to title the graph. Click run button. 

 

2. Cosine Wave 

Step 1: Open Untitled.oml File 

Type “clc”, “ clear all”, and “close all” in the Editor Window to close all 

open plots, clear all variables, and remove previous commands. 

Step 2: Initialize Time, Amplitude Value and Cos Wave Equation 

1. Type “t=0:0.01:1;” “a=2;” in Editor Window. This defines a time range from 

0 to 1 with step difference of 0.01 and a constant “a” with value 2. 

2. Type “b=a*cos(2*pi*t);”. 

Step 3: To Plot Waveform  

Type the following line from 5 to 8 as shown below to plot and label the 

waveform and click run. 

Figure 10.17 : Generation of sine 
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Figure 10.18 : Generation of cos wave 

3. Square Waveform 

Step 1: Open Untitled.oml File 

Type “clc”, “clear all”, and “close all” in the Editor Window to close all 

open plots, clear all variables, and remove previous commands. 

Step 2: Initialize Time, Amplitude Value 

Type “t=0:0.01:1;” “a=2;” in Editor Window. This defines a time range from 

0 to 1 with step difference of 0.01 and a constant “a” with value 2. 

Step 3: Define Function  

Type the function as shown below and Type “b=a* square(t);”.  

Step 4: To Plot Waveform  

Type the following lines from 9 to 12 as shown below to plot and label the  

waveform and click run. 
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Figure 10.19 : Generation of square wave 

4. Exponential Waveform 

Step 1: Open Untitled.oml File. 

Type “clc”, “clear all”, and “close all” in the Editor Window to close all 

open plots, clear all variables, and remove previous commands. 

Step 2: Initialize Time, Amplitude Value and Exponential Wave Equation 

1. Type “t=0:0.01:1;” “a=2;” in Editor Window. This defines a time range from 

0 to 1 with step difference of 0.01 and a constant “a” with value 2.. 

2. Type “b=a*exp(2*pi*2*t);”. 

Step 3: To Plot Waveform  

Type the following line from 5 to 8 as shown below to plot and label the 

waveform and click run. 

 

 

Figure 10.20 : Generation of Exponential wave 



 
 

244 
 

 

5. Sawtooth Waveform 

Step 1: Open Untitled.oml File 

Type “clc”, “clear all”, and “close all” in the Editor Window to close all 

open plots, clear all variables, and remove previous commands. 

Step 2: Initialize Time, Amplitude Value 

1. Type “t=0:0.01:1;” “a=2;” in Editor Window. This defines a time range from 

0 to 1 with step difference of 0.01 and a constant “a” with value 2. 

2. Enter the frequency, type “f=input ('enter the frequency')”. 

Step 3: Define Function  

Type the function as shown and Type “c=a* sawtooth(t,f);”.  

Step 4: To Plot Waveform  

Type the following line from 10 to 13 as shown below to plot and label the  

waveform and click run. 
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Figure 10.21 : Generation of sawtooth wave 

6. Triangle Waveform 

Step 1: Open Untitled.oml File 

Type “clc”, “clear all”, and “close all” in the Editor Window to close all 

open plots, clear all variables, and remove previous commands. 

Step 2: Initialize Time Duration 

Enter time duration “n = input ('Enter time duration of signal ');” 

Step 3: Define Function   

Type the function as shown and Type “y= triangle(n)” 

Step 4: To Plot Waveform  

Type the following line from 9 to 12 as shown below to plot and label the 

waveform and click run. 

 

 

Figure 10.22 : Generation of triangle wave 
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7. Ramp Waveform 

Step 1: Open Untitled.oml File 

Type “clc”, “clear all”, and “close all” in the Editor Window to close all 

open plots, clear all variables, and remove previous commands. 

Step 2: Initialize Value 

1. Enter the end value of the sequence “n1 = input('Enter the end value the 

sequence ');” 

2. Type “x= 0:n1;”. 

Step 3: To Plot Waveform  

Type the following line from 4 to 8 as shown below to plot and label the 

waveform and click run. 

 

 

Figure 10.23 : Generation of ramp sequence 

8. Unit Step Signal 

Step 1: Open Untitled.oml File 

Type “clc”, “clear all”, and “close all” in the Editor Window to close all 

open plots, clear all variables, and remove previous commands. 



 
 

247 
 

 

Step 2: Initialize Value 

1. Type “n = -5:5;”. This define the time interval from -5 to 5. 

2. Type “a = [zeros(1,5),ones(1,6)];” .This define time interval from -5 to -1 

amplitude is zero and the time interval from 0 to 5 amplitude is one. 

Step 3: To Plot Waveform  

Type the following line from 4 to 7 as shown below to plot and label the 
waveform and click run. 

 

Figure 10.24 : Generation of unit step signal 

9. Unit Impulse 

Step 1: Open Untitled.oml File 

Type “clc”, “clear all”, and “close all” in the Editor Window to close all 

open plots, clear all variables, and remove previous commands. 

Step 2: Initialize Value 

1. Type “n = -5:5;”. This defines the time interval from -5 to 5. 

2. Type “a = [zeros(1,5),ones(1,1).zeros(1,5)];” .This defines a time interval 

from -5 to -1. The amplitude is zero for the beginning 5 intervals, then the 

amplitude changes to one for one interval and is zero again for the rest of the 

time . 

Step 3: To Plot Waveform  

Type the following line from 4 to 7 as shown below to plot and label the 

waveform and click run. 
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Figure 10.25 : Generation of unit impulse 

10.3.2 DFT (Discrete Fourier Transform) 

The number of samples in the given signal N will be equal to the finite number of 

samples in DFT. Computationally efficient algorithms for implementing the DFT go by 

the generic name of Fast Fourier transform (FFTs). 

Consider a discrete time signal x(n) having a finite duration, say in the range 0 ≤ n ≤ N 

The DTFT (discrete time fourier transform) of this signal is  

𝑋𝑋(𝜔𝜔) = � x(n)𝑒𝑒−𝑗𝑗𝑗𝑗𝑗𝑗
𝑁𝑁−1

𝑗𝑗=0

 

Where  𝜔𝜔 = 𝜔𝜔𝑘𝑘 = 2𝜋𝜋𝑘𝑘
𝑁𝑁

  0 ≤ k ≤ N-1 

DFT of this signal is  

𝑋𝑋(𝑘𝑘) = � x(n)𝑒𝑒−𝑗𝑗𝑗𝑗𝑘𝑘n 
𝑁𝑁−1

𝑗𝑗=0

 

Substitute 𝜔𝜔𝑘𝑘 
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𝑋𝑋(𝑘𝑘) =  � x(n)𝑒𝑒−𝑗𝑗
2𝜋𝜋𝑘𝑘𝑗𝑗
𝑁𝑁

𝑁𝑁−1

𝑗𝑗=0

 

This is known as N-point DFT analysis equation. Commonly represented as 

X(k) = DFT{x(n)} =  ∑ 𝑥𝑥(𝑖𝑖)𝑁𝑁−1
𝑗𝑗=0 𝑊𝑊𝑁𝑁

𝑘𝑘𝑗𝑗,  0 ≤ k ≤ N-1 

Inverse DFT 

The DFT values(X(k), 0 ≤ k ≤ N-1), uniquely define the sequence x(n) through the 

inverse DFT formula  

x(n) = IDFT{X(k)} = 1/N� �X(k)𝑊𝑊𝑁𝑁
⎻𝑘𝑘𝑗𝑗�𝑁𝑁−1

𝑘𝑘=0     0 ≤ n ≤ N-1 

 

Exercise: Compute the 4-point DFT of the Sequence x(n) = [1 2 3 4] 

Consider the equation of DFT with the interval 0 to 3 

X(k) = DFT{x(n)} = ∑ 𝑥𝑥(𝑖𝑖)3
𝑗𝑗=0 𝑊𝑊4

𝑘𝑘𝑗𝑗,  0 ≤ k ≤ 3 

 

𝑊𝑊𝑁𝑁
𝑘𝑘𝑗𝑗 = 𝑒𝑒−𝑗𝑗

2𝜋𝜋𝑘𝑘𝜋𝜋
𝑁𝑁   

 

�

𝑋𝑋(0)
𝑋𝑋(1)
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The program to compute DFT in Altair Compose. 

Step 1: Open untitled.oml File 

Type “clc”, “clear all”, and “close all” in the Editor Window to close all 

open plots, clear all variables, and remove previous commands. 

Step 2: Define Input 

Consider the input sequence typed by the user. length is calculated based on 

input sequence. 

 

Figure 10.26 : Enter the input sequence 

Step 3: To Find DFT 

DFT is computed by fft (Fast Fourier Transform) . 

 

Figure 10.27 : Computation of FFT 

 

Step 4: To Plot Output 

The output has complex valued samples, for this reason typically it is 

considered with magnitude and phase. To find magnitude and phase and to 

plot output of DFT. Type the following lines. 
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Figure 10.28 : Plot of magnitude and phase 

10.3.3 Exercise: Processing of Data in the Frequency Domain 

Including the use of Filters 

Signal is converted from time to frequency domain because in the time domain the 

output will be a combination of all signal and it’s difficult to identify which all 

frequency signals are present and their amplitude. whereas in frequency domain we 

can find the different signal with their respectively frequency and amplitude. hence 

frequency domain is easier to analysis signal. 

In this exercise three signals are considered s1, s2, s3. Add all three signals and the 

total signal is named as S in the time domain. Converted this signal to the frequency 

domain by applying Fast Fourier transform, followed by the filter to obtain the 

desired signal.  

Here Low Pass Butterworth Filter is used. There are cases when we need the flat 

response after filtration. The signal processing filter which is designed to output a 

relatively flat response is the Butterworth filter. It is also called the maximally flat 

magnitude filter. 

The frequency response of the Butterworth Filter approximation function is also often 

referred to as “maximally flat” (no ripples) response because the passband is designed 
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to have a frequency response which is as flat as mathematically possible from 0Hz 

(DC) until the cut-off frequency at -3dB with no ripples. Higher frequencies beyond 

the cut-off point rolls-off down to zero in the stop band at 20dB/decade or 

6dB/octave. This is because it has a “quality factor”, “Q” of just 0.707. 

Let’s look that the following steps in Altair Compose. 

1. Import the data (CAE/Test/Excel) or create your own sample data. 

2. Convert to frequency domain. Inspect the frequency content of the data. 

3. Design a filter to remove desired frequency content from the original data. 

4. Convert the filtered data to frequency domain. Verify the updated (/removed) 

frequency content. 

 

Figure 10.29 : User scenario of signal processing by using Altair Compose 

Step 1: Open Untitled.oml File 

Type “close all”, “clear”, and “clc” in the Command Window to close all 

open plots, clear all variables, and remove previous commands in the Editor 

Window. 

Step 2: Initialize the Input Values  

Type the input values of Direct current signal, two sinusoidal signals with 

parameters like amplitude, frequency, and phase. Sampling frequency and 

sampling numbers and sample time range as shown below in Editor Window. 
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Figure 10.30 : Initialize input 

Step 3: Signal Definitions s1, s2, and s3  

1. s1 is a direct current signal. 

s2 is first sinusoidal signals with amplitude A1, frequency F1, phase P1. 

s3 is second sinusoidal signals with amplitude A2, frequency F2, phase P2.  

S is the total of these signals.  Type “s1,s2,s3,S” as shown in Editor Window. S is 

signal in time domain. 

 

Figure 10.31 : Signal definitions 

 These signals are plotted in Figure 1.  

2. Note the method used to title the subplots. In previous chapters, plot attributes 

were controlled through handles using the set and get commands. Here, the title 

command is used yet another shortcut. The sprintf command prints strings with 

the ability to embed variables as a string type.  Type the following commands in 

Editor window to plot the graph. 
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Figure 10.32 : Plot of signal in time domian 

In time domain all 3 signal are combined and its difficult to identify which all 

frequency signals are present and their strength(amplitude) so this is limitation of 

time domain. 

A “%conversion_type” is used to mark the embedded variable locations. In the 

case of the above, ‘d’ is the integer conversion type. 

Step 4: Compute the FFT  

Apply fft to the signal to convert from time domain to frequency domain, here 

S is the total signal and N is the number of samples previously defined in the 

variable. Type “y = fft(S,N)”; in Editor window. 

 

Figure 10.33 : Computation of “fft” 
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Store the power density by taking the absolute value of Y and plot it. This will 

show if any frequencies are dominant.   

 

 

Figure 10.34 : Plot of FFT 

The above plot is in frequency domain, we can find that there are three signal and at 

different frequency and different amplitude. hence in frequency domain we can 

analysis signal easily. 

Step 5: Amplitude-Frequency Plotting  

Some basic arithmetic is performed on data resulting from preceding lines to 

produce the amplitude-frequency plot. Refer to the comments in this section 

of the code for more details.   

1. Type “Ayy = AYY/(N/2);” in Editor Window. This transfer to actual modal 

value by divide N by 2 since fft is a two-side spectrum.  

2. Type “Ayy(1) = Ayy(1)/2;” in Editor Window. This refer to first dot stands for 

DC which does not need to divide 2. 

3. Type “F = ([1:N]-1)*Fs/N;” in Editor Window. This calculate frequency range 

according to sample rate. 

4. Type “subplot(2,1,2); plot(F([1:N/2]),Ayy([1:N/2]));” in Editor Window. 

Only plot the first half part. 
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Figure 10.35 : Plot of Amplitude frequency 

Step 6: Calculate Phase from the fft Output 

Type the following parameters shown below as the inputs in Editor window, 

to calculate phase of the fft output.  

 

 

Figure 10.36 : Calculate phase of fft output 

Step 7: Design a Low Pass Butterworth Filter  

1. Use the “buttord” command, and the “filter” command to filter the total 

signal, “S”. Use the parameters shown below as the inputs to the “buttord” 

command.  
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Figure 10.37 : Low pass Butterworth filter 

2. In a new variable, store the FFT of the filtered total signal from above step 

using the “fft” command. As shown below. 

 

Figure 10.38: “fft” command 

Step 8: Amplitude and Frequency Plot for New Filtered Signal 

Use the parameters shown below as the inputs to Calculate and plot 

amplitude and frequency of the signal. From the plot, we could notice s3 

frequency is filtered. 
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Figure 10.39 : Amplitude and frequency plot 

Refer for more example on Signal Processing to the below link. 

https://altairuniversity.com/learning-library/vtu-syllabus-dsp-lab-manual-

and-model-files-using-compose/ 

  

https://altairuniversity.com/learning-library/vtu-syllabus-dsp-lab-manual-and-model-files-using-compose/
https://altairuniversity.com/learning-library/vtu-syllabus-dsp-lab-manual-and-model-files-using-compose/
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11.   Statistics  
Statistical analysis is science of drawing conclusion based on limited qualitative data. 

This involves collection of data in a scientific manner, analysis of data to understand 

trends and patterns, manipulation of data for further use and summarizing data in 

terms of charts and graphs for easy interpretation to draw meaningful inferences. The 

key enablers to understand different data are mean and standard deviation. These 

are called statistical indexes.  

In this section, we discuss Probability density functions and cumulative distributive 

functions. Any continuous random variable can be mathematically represented as a 

function. Probability density function is a function whose integration yields the 

probability of the value of the variable lying in the same interval. The Cumulative 

distribution function is a function whose integration from 0 to x yields the probability 

of the random variable taking a value less than or equal to x. 

 

 

Altair Compose has over 85 commands to support statistical processing. A list of 

general statistical commands is given below. 

mean;    median;   meandev;   pdf;    rms;    std;   rand;   randn;    var;   

cdf;    corr;   cov;   erf; icdf;   normcdf;    cpsd;    detrend;   fullfact;    

geomean;    icdf;   bbdesign;   random;   rcond; regres;   skewness;    ttest;   

ttest2;   vartest;   vartest2;   ztest;    beta;   betacdf;   betafit;   

betainv;   betapdf;   betarnd;   chi2cdf;   chi2inv;   chi2pdf;   chi2rnd;    

expcdf; expcurvefit;   exppdf;   expfit;   expinv;   fcdf;   fpdf;   finv;   

frnd;   gamcdf;   gamfit;   gaminv;   gamma; gampdf;   gamrnd;   logncdf;   

lognfit;   logninv;   lognpdf;   lognrnd;    normcdf;   normfit; norminv;   

normpdf;   normrnd;  poisscdf;   poissfit;   poissinv;   poisspdf ;   poissrnd;   

tcdf; tinv;   tpdf;   trnd;   unifcdf;   unifffit;   unifinv;   unifpdf;  

unifrnd;   wblcdf;   wblfit;   wblinv; wblpdf;   wblrnd;   weibcdf;   weibfit;   

weibinv;   weibpdf;   weibrnd      
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 Example 1 
For the parameter ‘k’, selected as 1,2,3,4,5 draw the Probability density 

functions and cumulative distributive functions of 𝑥𝑥2  distributions.  

 

 

Figure 11.1 : PDF’s and CDF’s of x^2distribution 

 Example 2  
Generate a set of 30000 normally distributed random numbers and find the 

mean, variance and standard deviation  

 

Figure 11.2 : To find mean variance and standard deviation 
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 Example 3  
Assume that the linear regression model is y=x1 - 1.232x2+2.23x3 + 2x4 + 4x5 + 

3.792 x6. Calculate the output vector y with 120 measured data points. Also 

find the undetermined parameters aint within the given confidence level.  

 

 

Figure 11.3 : To find the undetermined parameters 

  Example 4  

For the parameter, Ⲗ selected as Ⲗ =1,2,5,10. Draw the PDF’s and CDF’s of the 

poison’s distributions.  
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Figure 11.4 : Probability density function and Cumulative distribution function using 

Poisons distribution 

   

 Example 5  
Solving Van Der Pol Oscillator System  

The van Der Pol oscillator is a non-conservative oscillator with non-linear 

damping. It evolves in time according to the second-order differential 

equation.  

𝑥𝑥 − 𝜇𝜇(1 − 𝑥𝑥)2𝑥𝑥 + 𝑥𝑥 + 0 where x is the position coordinate which is a function 

of the time t, and 𝜇𝜇 is a scalar parameter indicating the nonlinearity and the 

strength of the damping. This differential equation is solved in Altair Compose 

as given below.  
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Figure 11.5 : Plot Vander Pol Oscillator  system 
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12.   Control Systems 
A system output is controlled by varying input, to get desired behavior of the system 

is known as control system. A mathematical model of system is set up first followed 

by the analysis and design of the system, which is important to improve the speed of 

response, accuracy and stability of system. Here we consider a case of step response 

of a second order system. 

 Step Response of a Second Order System 
When output changes from one state to another in a very short time for the 

corresponding change in input, then it is called step response. The highest degree of 

derivative of a variable present in a differential equation denotes the order of the 

equation. A second order system will have a second order differential equation to 

represent the relationship between input and output. Consider the second order 

transfer function as shown below. 

2010
1)( 3 ++

=
ss

sG  

In general transfer functions are expressed as a ratio of two polynomials. The roots 

of the numerator are called zeros and roots of the denominator are called poles. The 

system performance and stability of a system are indicated by the values of poles and 

zeros. By assigning specific values to poles and zeros, control systems can be designed 

to meet the requirements. 

The following code is used to find step response for the given equation by using Altair 

Compose. 

Software code:  

clc; clear; close all;  

sys.num = [1];                       % Numerator 

sys.den = [1 10 20];              % Denominator 

sys1=tf(sys.num,sys.den);                          % Finding transfer function 
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kp=dcgain(sys.num,sys.den)                      % gain when frequency is 

zero(s=0) 

ess=1/(1+kp)                         % Steady state error 

w = sqrt (sys.den(3))                   % Finding natural frequency 

zeta = sys.den(2) / (2*w)             % Damping ratio 

TD=(1+0.7*zeta)/w               % Delay time 

TS = 4/ (zeta*w)                     % Settling time    

TP = pi/ (w*sqrt(1-zeta^2))     % Peak Time 

TR=(pi-atan((sqrt(1-zeta^2))/zeta))/(w*sqrt(1-zeta^2))    % Rise Time 

Percentovershoot= exp(-zeta*pi/ sqrt(1-zeta^2))*100      % Overshoot 

subplot(2,2,1) 

[z,t]=step(sys.num,sys.den);          % Step response 

plot(t,z); 

title('Step response'); 

xlabel('Time (sec)'); 

ylabel('Amplitude');grid on; 

subplot(2,2,2) 

pzmap(sys.num,sys.den);           % Pole zero plot 

title('Pole zero map of the given system') 

grid on; 

%% Adding Zero to the given system 

sys.num = conv(sys.num,[1 1]);       

sys2=tf(sys.num,sys.den) 

[f,t]=step(sys.num,sys.den); 

subplot(2,2,3) 

plot(t,f); 

title('Step response after addition of zero') 

xlabel('Time (sec)'); 

ylabel('Amplitude');grid on; 

subplot(2,2,4) 

pzmap(sys.num,sys.den)  % Pole zero plot when zero is added 

title('Pole zero map when zero is added') 

grid on; 

Simulation Results: 

sys1 =      1 

        --------------      

       1s^2+10s+20 

sys2 = 1s+1 
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         ------------- 

       1s^2+10s+20 

kp = 0.05                  ( DC gain) 

ess = 0.952380952   ( Steady state error) 

w = 4.47213595        (Natural frequency) 

zeta = 1.11803399    (Damping ratio) 

TD = 0.398606798    (Delay time) 

TS = 0.8                    (Settling Time) 

TP = 0 - 1.40496295i      (Peak Time) 

TR = -0.21520447 - 1.40496295i    (Rise Time) 

Percent overshoot = 73.7368878 + 67.5490294i    (Percent Overshoot) 

 

Figure 12.1 : Step Response and addition of zero to the given system 

The following functions are created for finding pole zero map, transfer 

function, step response, to find state space matrices and dc gain of the system. 

Function created to find the pole zero map of the system 

function pzmap(varargin) 

if length(varargin)==1 

sys=varargin{1};    % assigning structure to variable ‘sys’ 

num=sys.num;     %Numerator 

den=sys.den;   % Denominator 

end 

if length(varargin)==2 

num=varargin{1};     % Numerator 
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den=varargin{2};        % Denominator 

end 

z=roots(num);    % Finding zeros  

p=roots(den);     % Finding poles 

%%% …………….For Plotting poles 

for i=1:length(p)  

R=isreal(p(i));  % Check whether the poles are real or not 

switch (R) 

case 1        % case when Poles are real 

p1=[p(i),0];     % Defining first point for plotting poles  

p2=[p(i),0];    % Defining second point for plotting poles 

theta = atan2( p2(2) - p1(2), p2(1) - p1(1));       % Finding slope 

r = sqrt( (p2(1) - p1(1))^2 + (p2(2) - p1(2))^2); % Finding the length between 

the first and second point 

line = 0:0.01: r; 

x = p1(1) + line*cos(theta);  % set of x coordinates to plot 

y = p1(2) + line*sin(theta);   % set of y coordinates to plot 

plot(x,y,'x');     % Plotting poles 

hold on; 

case 0                              % Case when poles are imaginary. 

p1=[real(p(i)),imag(p(i))];       

p2=[real(p(i)),imag(p(i))];      % Since both points(p1 &p2) are equal, it 

plots only the specified point 

theta = atan2( p2(2) - p1(2), p2(1) - p1(1)); 

r = sqrt( (p2(1) - p1(1))^2 + (p2(2) - p1(2))^2); 

line = 0:0.01: r; 

x = p1(1) + line*cos(theta); 

y = p1(2) + line*sin(theta); 

plot(x,y,'x'); 

hold on; 

end 

end 

%%%%-----------------For Plotting Zeros 

for i=1:length(z) 

S=isreal(z(i))   % Check whether the zeros are real or not 

switch (S) 

case 1            % case when Poles are real 

q1=[z(i),0]; 

q2=[z(i),0]; 
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theta = atan2( q2(2) - q1(2), q2(1) - q1(1)); 

r = sqrt( (q2(1) - q1(1))^2 + (q2(2) - q1(2))^2); 

line = 0:0.01: r; 

a = q1(1) + line*cos(theta); 

b = q1(2) + line*sin(theta); 

plot(a,b,'o'); 

hold on; 

case 0                        % Case when zeros are imaginary. 

q1=[real(z(i)),imag(z(i))]; 

q2=[real(z(i)),imag(z(i))]; 

theta = atan2( q2(2) - q1(2), q2(1) - q1(1)); 

r = sqrt( (q2(1) - q1(1))^2 + (q2(2) - q1(2))^2); 

line = 0:0.01: r; 

a = q1(1) + line*cos(theta); 

b = q1(2) + line*sin(theta); 

plot(a,b,'o');                      % plotting zeros 

hold on; 

end 

end; end 

Function created to find Transfer function 

function [sys]=tf(varargin) 

if length(varargin)==1 

 sys=varargin{1}; 

 b=sys.num; 

 a=sys.den; 

end 

if length(varargin)==2 

 b=varargin{1}; 

 a=varargin{2}; 

end 

 

[fopen_fileID] = fopen('testfile.txt', 'w'); 

l=length(b);              % Number of numerator coefficients 

m=length(a);              % Number of denominator coefficients 

%%%%-----------Numerator 

if length(b)==1           % Check the numerator has only one coefficient  

fprintf(fopen_fileID, '  %g\n',b(1));    % Print numerator 
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fprintf(fopen_fileID,'     %s','-----------');       % to draw the seperation 

b/w numerator and denominator 

end 

 

if length(b)==2           % Check the numerator has two coefficients  

c{1}=sprintf('%g%s',b(1),'s');   % store first numerator coeeficient in a cell 

'c{1}' 

c{2}=b(end);                     % store second numerator coeeficient in a 

cell 'c{2}' 

fprintf(fopen_fileID, '%s',c{1});       % print numerator 

if b(end)>0 

fprintf(fopen_fileID, '%s','+'); 

end 

fprintf(fopen_fileID, '%g\n',c{end}); 

fprintf(fopen_fileID,'     %s','-----------');             % to draw the 

seperation b/w numerator and denominator 

end 

 

if length(b)>2             % Check the numerator has more than two coefficients  

 i=l-1;                 % Initialising value of i to print the 

exponential term 

 for k=1:l-2            % Loop defined for the numerator cofficients 

excluding the last and second last coefficient  

 h=sprintf('%g%s%g',b(k),'s^',i);   % Print numerator coefficient 

and storing to the variable 'h' 

 c{k}=h;                %store the numerator coefficeint in a cell 

'c' 

 i=i-1;                 % Decrementing the power of i for printing 

the exponential terms in the correct way 

end 

 c{k+1}=sprintf('%g%s',b(k+1),'s');      % store the second last coefficient 

in 'c' 

 c{k+2}=b(end);                          % store last coefficient in 'c' 

 c; 

for t=1:length(c)-1 

 fprintf(fopen_fileID, '%s',c{t});        % Print the numerator coefficients 

except the last coefficient of the transfer function 

 R=cell2mat(c(t+1)); 
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 T=strcmp(R(1),'-'); 

if (t~=(length(c)-1)) 

 if T==0 

 fprintf(fopen_fileID, '%s','+'); 

 end 

 end 

 end 

 if b(end)>0 

 fprintf(fopen_fileID, '%s','+'); 

 end 

fprintf(fopen_fileID,'%g\n',c{end});         % Print the last numerator 

coefficient of the transfer function 

fprintf(fopen_fileID,'     %s','-----------'); 

end 

 

%------------Denominator 

if length(a)==1 

fprintf(fopen_fileID, '\n         %g\n',a(1)); 

end 

 

if length(a)==2 

f{1}=sprintf('\n        %g%s',a(1),'s'); 

f{2}=a(end); 

fprintf(fopen_fileID, '%s',f{1});       % print numerator 

if a(end)>0 

fprintf(fopen_fileID, '%s','+'); 

end 

fprintf(fopen_fileID, '%g\n',f{end}); 

end 

 

if length(a)>2 

 j=m-1; 

 for g=1:m-2 

 e=sprintf('%g%s%g',a(g),'s^',j); 

 f{g}=e; 

 j=j-1; 

end 

 f{g+1}=sprintf('%g%s',a(g+1),'s'); 

 f{g+2}=a(end); 
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 f; 

fprintf(fopen_fileID, '\n      %s',f{1}); 

R2=cell2mat(f(2)); 

 

 T2=strcmp(R2(1),'-'); 

if T2==0 

 fprintf(fopen_fileID, '%s','+'); 

 end 

for u=2:length(f)-1 

 fprintf(fopen_fileID, '%s',f{u}); 

 R1=cell2mat(f(u+1)); 

 

 T1=strcmp(R1(1),'-'); 

if (u~=(length(f)-1)) 

 if T1==0 

 fprintf(fopen_fileID, '%s','+'); 

 end 

 end 

 end 

 if a(end)>0 

 fprintf(fopen_fileID, '%s','+'); 

 end 

end 

fprintf(fopen_fileID, '%g\n',f{end}); 

fclose(fopen_fileID); 

content = type('testfile.txt');                 

sys=content{1,1} ; 

Function created to find step 

function [z,t]= step(varargin) 

if length(varargin)==1 

 sys=varargin{1}; 

 num=sys.num; 

 den=sys.den; 

 t=0:0.1:25;   % Plotting time length 

end 

if length(varargin)==2 

 num=varargin{1}; 

 den=varargin{2}; 

 t=0:0.1:25;      % Plotting time length 
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end 

if length(varargin)==3 

 num=varargin{1}; 

 den=varargin{2}; 

 t=varargin{3}; 

end 

 

[A,B,C,D]=tf2ss(num,den);  %Finding state space matrices 

f=length(A);               %A matrix length 

U=1;                        

K=[1]; 

if det(A)==0 

for i=1:length(t) 

h{i}=[-0 0 0]*(e^(A*t(i))-eye(f))*B*K +D*K*U; 

end 

end 

if det(A)~=0 

for i=1:length(t) 

h{i}=C*(A^-1)*(e^(A*t(i))-eye(f))*B*K +D*K*U; 

end 

end 

z=cell2mat(h); 

m=length(z)/length(h); 

% if m==1 

% plot(t,z) 

% end 

% if m>1 

% j=1; 

% % for i=1:length(z)/m 

% % l(i)=z(j); 

% % j=j+2; 

% % end 

% % j=2; 

% % for i=1:length(z)/m 

% % g(i)=z(j); 

% % j=j+2; 

% % end; 

% % % for j=1:m 

 % % % for i=1:length(z)/m 
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% % % l(i)=z(j); 

% % % g(i)=z(j+1); 

% % % j=j+m; 

% % % end 

% % % end 

% % figure(2) 

% % plot(t,l);grid on; 

% % figure(3) 

% % plot(t,g);grid on; 

% end 

End 

Function dcgain 

function kp=dcgain(varargin) 

if length(varargin)==1 

 sys=varargin{1}; 

 num=sys.num; 

 den=sys.den; 

end 

if length(varargin)==2 

 num=varargin{1}; 

 den=varargin{2}; 

end 

 kp=num(end)/den(end); 

end; 

Function for transfer function2ss 

function[A,B,C,D]=tf2ss(b,a) 

d=length(a); 

if a(1)~=1 

a=a/a(1); 

end 

m=d-1; 

%%%%%%%%----A MATRIX 

for j=1:m 

A(m,j)=-a(d); 

d=d-1; 

end 

for k=m:-1:2 
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A(k-1,k)=1; 

end 

%%%%%%%%%%%%%%%%%% 

B(m,1)=1;    %B MATRIX 

 

%%%%%%%-----C MATRIX 

g=abs(length(a)-length(b)); 

if length(a)>length(b) 

for i=length(b):-1:1 

b(i+g)=b(i); 

end 

for l=1:g 

b(l)=0; 

end 

 

end 

if length(b)>length(a) 

for i=length(a):-1:1 

a(i+g)=a(i); 

end 

for l=1:g 

a(l)=0; 

end 

 

end 

b 

f=m; 

for p=2:1:m+1 

C(1,f)=b(p)-a(p)*b(1); 

f=f-1; 

end 

D=b(1);      %D MATRIX 

A; 

B; 

C; 

D; 

end 
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Function created to generated bode plot 

function bode(num,den,value,w) 

sys.num = num; 

sys.den = den; 

P=roots(sys.den) 

Z=roots(sys.num) 

%%%%-----------Magnitude 

if length(Z)==0 

magnitude_z=1*sys.num; 

end 

 

if length(Z)~=0 

temp_old_z=1; 

for j=1:length(Z) 

for i=1:length(w) 

temp_new_z(i)=sqrt((w(i))^2+(Z(j))^2); 

end 

temp_old_z=temp_old_z.*temp_new_z; 

end 

 

for i=1:length(temp_old_z) 

magnitude_z(i)=temp_old_z(i); 

end 

end 

 

if length(P)==0 

magnitude_p=1*sys.den; 

end 

 

if length(P)~=0 

temp_old_p=1; 

for j=1:length(P) 

for i=1:length(w) 

temp_new_p(i)=sqrt((w(i))^2+(P(j))^2); 

end 

temp_old_p=temp_old_p.*temp_new_p; 

end 

 

for i=1:length(temp_old_p) 
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magnitude_p(i)=temp_old_p(i); 

end 

end 

if (length(sys.num)==1) 

 z1=1; 

end 

if (length(sys.num)==2) 

 z1=gcd(sys.num(1),sys.num(2)); 

end 

 

if (length(sys.num)==3) 

 z1=gcd(sys.num(1),sys.num(2),sys.num(3)); 

end 

if (length(sys.num)==4) 

 z1=gcd(sys.num(1),sys.num(2),sys.num(3),sys.num(4)); 

end 

if (length(sys.num)==5) 

 z1=gcd(sys.num(1),sys.num(2),sys.num(3),sys.num(4),sys.num(5)); 

end 

 

 

magnitude=z1*(magnitude_z./magnitude_p); 

 

%%%%---------------Phase Angle 

if length(Z)==0 

temp_old_ph_z=0; 

end 

 

if length(Z)~=0 

 

for i=1:length(w) 

for j=1:length(Z) 

temp_new_ph_z(j)=atan(-w(i)/Z(j)); 

end 

z1=cumsum(temp_new_ph_z); 

temp_old_ph_z(i)=z1(end); 

end 

end 
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if length(P)==0 

temp_old_p_ph=0; 

end 

 

if length(P)~=0 

for i=1:length(w) 

for j=1:length(P) 

if P(j)~=0 

temp_new_ph_p(j)=atan(-w(i)/P(j)); 

end 

if P(j)==0 

 temp_new_ph_p(j)=atan(w(i)/P(j)); 

end 

end 

z2=cumsum(temp_new_ph_p); 

temp_old_ph_p(i)=z2(end); 

end 

end 

 

phase_rad=temp_old_ph_z-temp_old_ph_p; 

 

if value ==1 

mag_db=20*log10(magnitude); 

phase_deg=phase_rad*180/pi; %phase done in degrees 

semilogx(w,mag_db) %semilog plot 

xlabel('Frequency [rad/s]'),ylabel('Magnitude[db]'),grid on %xaxis label 

title('Magnitude Plot') 

end 

if value==2 

 phase_deg=phase_rad*180/pi; %phase done in degrees 

 semilogx(w,phase_deg) 

 xlabel('Frequency [rad/s]'),ylabel('Phase angle [deg]'),grid on 

end 

end 
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 Effect of P, PI, PD, and PID Controllers 
A controller is a device, historically using mechanical, hydraulic, pneumatic or 

electronic techniques often in combination, but more recently in the form of a 

microprocessor or computer, which monitors and physically alters the operating 

conditions of a given dynamical system. Controller deals with controlling a dynamic 

system, to get the desired output from the system for given constraints. There are 

different controllers are P, PI, PD, PID. 

Consider transfer function equation and the following code is used to find step 

response for the given equation with respect to the different controller by using Altair 

Compose. 

415.0
1)( 3 ++

=
ss

sG  

Software Code: 

clc; clear; close all; 

sys.num=[1];            % Numerator of the system is defined as a structure 

sys.den=[0.5 1  4];    % Denominator of the system is defined as a structure 

sys1=tf(sys)               % Print  transfer function and store it in sys1. 

sys5.num=[1]; 

sys5.den=[1]; 

[f,G]=feedback(sys,sys5)     % Gives  transfer function of the system with 

unity feedback 

[z,t]=step(G);                    % Step response of the system 

subplot(2,3,1);plot(t,z);grid on; 

title('Step response of given system'); 
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Figure 12.2 : Step Response of the given system 

%Proportional controller 

kp=10; 

sys.num=kp*sys.num;       % Numerator augmented with P controller    

sys2=tf(sys); 

sys6.num=[1]; 

sys6.den=[1]; 

[f,G]=feedback(sys,sys6) 

[z,t]=step(G); 

subplot(2,3,2); 

plot(t,z);grid on; 

title('Proportional contol Kp=10') 

k=dcgain(sys)                % DC gain of the system ( s=0) 

essP=1/(1+k) 
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Figure 12.3 : Step Response with P controller 

% % PD controler 

Kd=10;kp = 10; 

numc=[Kd*kp kp];        

sys.num=conv(numc,sys.num);  % Numerator augmented with PD controller    

sys3=tf(sys); 

[f,G]=feedback(sys,1) 

[m,t]=step(G); 

subplot(2,3,3);plot(t,m);grid on; 

title('PD control Kp=10 and Kd=10') 

 

 

                                                                                        

 

 

 

 

 

 

 

%PI controller 

ki=10;kp = 10; 

sys.num=[kp ki*kp];     % Numerator augmented with PI controller    

Figure 12.4 : Step Response with PD 
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denI=[1 0]; 

sys.den=conv(denI,sys.den); 

sys4=tf(sys) 

sys7.num=[1]; 

sys7.den=[1]; 

[f,G]=feedback(sys,sys7); 

[m,t]=step(G); 

subplot(2,3,4);plot(t,m); 

k=dcgain(G) 

essPI=1/(1+k) 

title('PI control Kp=10 and Ki=10') 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

% %PID controller 

sys.num=conv(numc,[1 ki]);     % Numerator augmented with PID controller    

sys3=tf(sys); 

[f,G]=feedback(sys,1); 

[m,t]=step(G); 

subplot(2,3,5);plot(t,m); 

k=dcgain(G) 

Figure 12.5 : Step Response with PI controller 
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essPID=1/(1+k) 

title('PID control Kp=10,Ki=10 & kd=10') 

 

                                                           

 

 

 

Function defined for feedback command 

function [f,G]=feedback(sys1,sys2) 

num1=sys1.num;      %Numerator of the first system 

den1=sys1.den;       %Denominator of the first system 

num2=sys2.num;     %Numerator of the second system 

den2=sys2.den;       %Denominator of the second system 

[num1,den2]=equal_length(num1,den2);    % to make numerator and denominator 

equal length 

[den1,den2]=equal_length(den1,den2); 

[num1,num2]=equal_length(num1,num2); 

num_n=conv([num1],[den2]);           %Numerator of the feedback system 

d1=conv([den1],[den2]); 

d2=conv([num1],[num2]); 

[d1 d2]=equal_length(d1,d2); 

den_n=d1+d2;         % denominator of the feedback system 

Figure 12.6 : Step Response with PID controller 
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G.num=num_n; 

G.den=den_n; 

f=tf(G); 

s1=find(G.num); 

s2=find(G.den); 

if s1(1)>1 

G.num=[G.num(s1(1):length(G.num))];  % to avoid initial unwanted zeros in the 

numerator 

end 

if s2(1)>1 

G.den=[G.den(s2(1):length(G.den))]; % to avoid initial unwanted zeros in the 

denominator 

end  

end  

Function defined to make numerator and denominator equal length 
function [num1,den1]=equal_length(num1,den1) 

g=abs(length(den1)-length(num1)); %Difference in the length of numerator and 

denominator 

% To make numerator equal length with denominator 

if length(den1)>length(num1) 

for i=length(num1):-1:1 

num1(i+g)=num1(i); 

end 

for l=1:g 

num1(l)=0; 

end 

end 

% To make denominator equal length with numerator 

if length(num1)>length(den1) 

for i=length(den1):-1:1 

den1(i+g)=den1(i); 

end 

for l=1:g 

den1(l)=0; 

end 

end 

num1; 

den1; 
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end 

 

Refer for more example on control system to the below link 

https://altairuniversity.com/learning-library/control-system-lab-

experiments-using-compose-vtu-university-syllabus/  

  

https://altairuniversity.com/learning-library/control-system-lab-experiments-using-compose-vtu-university-syllabus/
https://altairuniversity.com/learning-library/control-system-lab-experiments-using-compose-vtu-university-syllabus/
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13.   Optimization 
This section introduces you to optimization and solving in four cases, which are: 

Unconstrained optimization, constrained optimization, Nonlinear constraints with 

gradients as well as Nonlinear equality and inequality constraints. 

 

 Unconstrained Optimization 
The example below describes how to get a set of values [ 1x , 2x ] that solves 

                     20/)()exp(*50)( 2
2

2
1

2
2

2
1min xxxxxf

x
++−−=  

The given two-dimensional problem is solved below by invoking unconstrained 

minimization routine fminunc. 

Step 1: Define the objective function 

 

Figure 13.1: Define function 

Step 2: Set the required options  

optimset specifies the optimization function options. Options are set to control the 

number of iterations and display intermediate data. 

 

Figure 13.2 : “optimset” command 

Step 3: Solve using fminunc using the options 
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Figure 13.3 : “fminunc” function 

This gives the following output. 

 

Figure 13.4 : Output of “fminunc” 

 Constrained Optimization 
The example below describes how to get a set of values [ 1x , 2x ] with nonlinear 

inequality constraints.  
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                  )265.35)(exp()( 221
2

2
2

11min xxxxxxxf
x

+++=  

Subject to the constraints 

                    5.25.23 2121 −≤−− xxxx  

                   55.2 21 ≤− xx  

 

Figure 13.5 : Define function 

Step2: Define the function for the constraints 

 

Figure 13.6 : Define function 

Step 3: Solve using fmincon routine 

 

Figure 13.7 : “fmincon” command 

fmincon produces the following solution x with function value fval. 

The results of the above code are shown below 

 

Figure 13.8 : Value of x1 and x2 
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 Nonlinear Constraints with Gradients 
The example below describes how to get a set of values [ 1x , 2x ] with nonlinear 

inequality constraints.  

        
)53)(exp()( 2

2
2

11min xxxxf
x

+=
 

Subject to the constraints 

              5.02121 −≤−− xxxx  

               521 ≤− xx  

 

Figure 13.9 : Define function 

Grad contains the partial derivatives of the objective function, f, returned by 

objfun(x) with respect to the elements in x. You have to tell the fmincon 

routine that gradient of the objective function and gradient of the constraints 

are considered by setting ‘GradObj’ and ‘GradConstr’ to ‘on’ state in the 

options. 

Step2: Define the function for nonlinear constraints and the gradients of the 

nonlinear constraints 
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Figure 13.10 : Define function 

Step 3: Solve using fmincon constrained optimization routine 

 

Figure 13.11 : Optimization command 

The results of the above code are shown below. 

 

Figure 13.12 : Result of nonlinear constraints with gradients 

 Nonlinear Equality and Inequality 

Constraints 
The example below describes how to get a set of values [ 1x , 2x ] with nonlinear 

inequality constraints.  

        333)(min zyxxf
x

++=  

Subject to the inequality constraints  
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          0≤− x  

            0≤z                                          

            02 22 ≤− yz  

    And subject to the equality constraints as 

             1222 =++ zyx             

Step1: Define the objective function 

 

Figure 13.13 : Define function 

Step2: Define the function for the constraints 

 

Figure 13.14 : Define function 

Step 3: Solve using fmincon constrained optimization routine 

 

Figure 13.15 : Optimization command 

The results of the above code are shown below 
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Figure 13.16 : Result of nonlinear equality and inequality constraints  
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14.   Application of Altair 

Compose 
 Exercises on System Identification 

14.1.1 Find the Best Fit Curve to Experimental/CAE/Reference 

Data. 

While the way of creating a fit curve with polynomials was discussed in section 4.3, 

this exercise covers least square curve fitting tools available in Altair Compose. The 

steps for this exercise can be listed as follows: 

1. Import the data (CAE/Test/Excel) or create your own sample data. 

2. Define a parameterized model fitting function. 

3. Solve for the non-linear curve fitting to fit the model. 

4. Examine how well the resulting curve fits the original data. 

 

Figure 14.1 : User scenario for curve fitting 

Let’s look that the following steps in Altair Compose. 



 
 

296 
 

 

Step 1: Open Untitled.oml File 

Type close all, clear, and clc in the Command Window to close all open 

plots, clear all variables, and remove previous commands in the Editor 

Window. 

Step 2: Define Parameterized Fitting Function 

Define the function “func” as shown in below figure in the Editor window. 

 

Figure 14.2 : Define a function 

Step 3: Create Damped Sinusoidal Test Data with Noise 

1. Initialize value for time stamps, amplitude, exponential decay, frequency 

and type the processing lines as shown below. 

2. Plot (t,x), type the title, x axis label, y axis label and legend. 
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Figure 14.3 : Damped sinusoidal test data with noise 

 

Step 4: Identify Parameters for the Fitted Curve 

1. Initialize a matrix “p = [5,10,10]” 

2. Type “o = optimset(‘maxIter’,10);” optimset is a optimization function and 

maxIter is maximum number of iterations allowed.  

 

Figure 14.4 : “optimset” command 
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3. To add text on the figure. 

 

Figure 14.5 : To add text on figure 

 
4. To obtain best fit parameters and the length of the residual vector 

“Isqcurvefit” command is used in a while loop and executes condition till it 

returns false. 

 

 

Figure 14.6 : To obtain best fit 

5. Plot the function by typing “plot(t,xf)” and add legend. To add text on the 

figure, type the proceeding line as shown 

 

 

Figure 14.7 : Plot function and add text 
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 Exercises on CAE/Test Data Processing 
Why use Altair Compose for CAE/Test Data Processing. 

• Versatile data importability with support for all common CAE and Test data 

formats. 

• Automatic detection of specific data format (type, request, and component). 

• Easily register function for further use in CAE analysis in HyperWorks. 

14.2.1 Calculate RF on Results from OP2 

Step 1: Data and Objective 

1. Load initially, inspect, adapt path, run: Compose_RF-CBUSH-

force_STATIC.oml 

2. Adapted script, can run in batch mode after adapting the path to the result 

file: 

3. Compose_RF-CBUSH-force_LOOP.oml 

4. Inspect and run an existing script to understand it‘s content and output and 

get used to the GUI of Compose. 

5. Inspect and run a script that got updated with a loop over all CBUSH elements, 

filter for the minimum RF and output of results to a text-file. 

Note: This exercise consists basically of reviewing and running existing scripts – no 

own editing is required apart from updating directory-paths in the scripts. Of course 

you may try on your own to edit version „STATIC“ to arrive at „LOOP“. 
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Figure 14.8 : Script of Compose RF cbush force static 

 

Step 2: Inspect and Run initial Script 

1. Set the input/output directory through the File Browser (1). 

2. Use File > Open or drag&drop to load Compose_RF-CBUSH-force_STATIC.oml 

3. Collapse commands for better overview (2). 

4. Mark commands and use F1 to open their description in the help (3). 

5. Note the Library Browser with commands (4). 

6. Check the structure and functionality of the script. Comments describe the 

content (5). 

7. Update the directory path (variable DIR). Run the script. (6). 

8. Note the output in the Command Window (7). 

9. Check and doubleclick variables (8). 
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Figure 14.9 : Step to run the Script 

10. Set the input/output directory through the File Browser (1). 

11. Use File > Open or drag&drop to load /Compose_RF-CBUSH-

force_STATIC.oml 

12. Collapse commands for better overview (2). 

13. Mark commands and use F1 to open their description in the help (3). 

14. Note the Library Browser with commands (4). 

15. Check the structure and functionality of the script. Comments describe the 

content (5). 

16. Update the directory path (variable DIR). Run the script. (6). 

17. Note the output in the Command Window (7). 

18. Check and doubleclick variables (8). 
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Figure 14.10 : Step to run the Script 

Step 3: Initial Script – Selected Explanations 
 

1. The command readvector reads defined input from FE/CAE result-files (1).  

Note: Use readvectorbuilder in the Command Window to open a tool that builds the 

correct expression for the result type you need. 

2. The command getreqlist returns a list of requests for a given data type (2). It 

is used here to read in the names of the elements (which contain a guiding 

„E“, like „E1234“). Then the „E“ is cut away and the IDs are put into a vector 

named eIDs.  

Note: To know that the „7“ is returning the element names, you can use 

readvectorbuilder for reverse-guessing which number is which data type. 

3. Simple math does the RF calculation (3). 

4. printf is used to output the result in a formatted text to the Command 

Window (4). 
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Figure 14.11 : Script of Compose RF cbush force static 

Step 4: Expand the Script – Loop over CBUSH Elements 

1. With readmultvectors the CBUSH element forces are extracted to a matrix MF 

(1).  

Note: Use readvectorbuilder in the Command Window to open a tool that builds the 

correct expression for the result type you need. 

2. A for-loop (2) is then reading the force values (1/3/5) (3) and calls the 

predefined function with these forces and the user-defined variables to 

calculate the RF results. 

3. Notice, that the vector of element IDs, which was used already in the initial 

script (4), is used here to determine how many elements are read for MF (1) 

and how many loops for is doing (2), through length(eIDs). 
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Figure 14.12 : Logic for Loop over CBUSH Elements 

Step 5: Expand the Script – Filter for minimum RF 

1. Filtering for the minimum value of RF is done through min. 

2. Additionally, the index of the minimum value in the list is requested and 

stored as IDX (1), to be able to track the corresponding element ID from the 

vector eDIs later in result output. 

 

Figure 14.13 : Representing Index of the minimum value 

Step 6: Expand the Script – Output to ASCII-File – Now Run Script from GUI 

1. The initially existing result output to formatted text in the Command Window 

is adjusted by a for-loop to write all results that are now computed (1). 

Additionally output of the minimum RF value plus the corresponding element 

ID is defined (2). 
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2. Finally, using fprintf, the same output as it is already done to the Command 

Window is defined to be written to a file export-RF.txt, to the directory of the 

op2-file that is processed by the script (3). 

3. Hit the Start button to run the script and check it‘s output (4). 

 

 

Figure 14.14 : Run icon 

Step 7: Run adapted Script in Batch 

1. Complete the initial script (STATIC) or open /Compose_RF-CBUSH-

force_LOOP.oml and adjust the variable DIR if you didn’t already. 

2. If the file that is output by the script (export-RF.txt) exists already from 

previous runs, delete it, to verify later that the batch-run of the script was 

successful in writing that file. 

Use the command prompt to call  
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3. Compose_Console.bat from the installation directory of Compose, handing 

over the script to run, with the option -f (1). 

4. Check in the location defined in the script as DIR for the exported file export-

RF.txt, to verify that the script ran successfully. 

5. Additionally, the result output will happen to the command prompt (2). 

 

 

Figure 14.15 : Output in Compose Console 
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Here is the software code 

Compose_RF-CBUSH-force_LOOP 

 

%---------------------------------------------------------------------------

------------ 

% This Script will read the CBUSH Elements and their Force Results from an 

op2-File,  

% calculate the RF respecting your input, filter for the minimum RF value and 

then  

% output the result in the Command Window and to an ASCII-file 

%---------------------------------------------------------------------------

------------ 

% Clear Command Window, Functions, Variables and Figures of COMPOSE 

% 

clc; 

clear all; 

close all; 

 

%---------------------------------------------------------------------------

------------ 

% User Input Definition 

% 

DIR      = '<enter-path>';                % Path to Result File 

filename = 'CBUSHmodel_v1.op2';           % Name of Result File 

Fall     = 4000.0;                        % Allowable Force-Sum 

 

%---------------------------------------------------------------------------

------------ 

% Build Reference to File from DIR and filename 

% 

fileIN = strcat(DIR, '\', filename);          

 

%---------------------------------------------------------------------------

------------ 

% Read the CBUSH-Element Names from the Inputfile and cut the leading "E" to 

get the IDs 

% only then select the first ID 

% 

reqE = getreqlist(fileIN, 1, 7); 
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eNames = regexp(reqE, 'E', 'split'); 

for i = 1 : length(reqE) 

      eIDs(i, :) = str2num(eNames{i}{1, 2}); 

end        

 

%---------------------------------------------------------------------------

------------ 

% Read Force-Results of all CBUSH-Elements and store them in a Matrix 

% 

MF = readmultvectors(fileIN, 1, 16, 1, length(eIDs), 2, 6, 'All'); 

 

%---------------------------------------------------------------------------

------------ 

% Loop over Force-Results of CBUSH-Elements in MF for Calculation of RF 

% Simple Example - Build your own RF Calculation here 

% 

for i = 1 : length (eIDs) 

 Fx(i)    = MF(i, 1); 

 Fy(i)    = MF(i, 3); 

 Fz(i)    = MF(i, 5); 

 Fs(i)    = (Fy(i)^2 + Fz(i)^2)^.5; 

 Fsum(i)  = ((abs(Fx(i)) + 2*Fs(i)) / 3); 

 RF(i)    = (Fall / Fsum(i)); 

end 

 

%---------------------------------------------------------------------------

------------ 

% Filter for the minimum value for RF and store it's index for ID-

Identification 

% 

[minRF, IDX] = min(RF); 

 

%---------------------------------------------------------------------------

------------ 

% Output Results to Command Window 

% 

printf('element # | Fx       | Fy       | Fz       |  All. F Sum  |   RF     | 

\n'); 
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printf('----------|----------|----------|----------|--------------|---------

-| \n'); 

for i = 1 : length (eIDs) 

 printf('%9.0f | %8.2f | %8.2f | %8.2f | %12.2f | %8.3f | \n', 

eIDs(i), Fx(i), Fy(i), Fz(i), Fall, RF(i)) 

end 

printf ('\n ') 

printf('Minimum RF = %6.2f at Element: %8.0f', minRF, eIDs(IDX)); 

 

%---------------------------------------------------------------------------

------------ 

% Write Results to ASCII-File at the same location as the op2-File 

% 

cd (DIR) 

fname = 'export-RF.txt'; 

fid = fopen(fname, 'wt'); 

fprintf(fid, 'element # | Fx       | Fy       | Fz       |  All. F Sum  |   RF     

| \n'); 

fprintf(fid, '----------|----------|----------|----------|--------------|---

-------| \n'); 

for i = 1 : length (eIDs) 

 fprintf(fid, '%9.0f | %8.2f | %8.2f | %8.2f | %12.2f | %8.3f | 

\n', eIDs(i), Fx(i), Fy(i), Fz(i), Fall, RF(i)) 

end 

fprintf (fid, '\n ') 

fprintf(fid, 'Minimum RF = %6.2f at Element: %8.0f', minRF, eIDs(IDX)); 

fclose(fid); 

 

%---------------------------------------------------------------------------

------------ 

 

2 Compose_RF-CBUSH-force_STATIC 

%---------------------------------------------------------------------------

------------ 

% This Script will read the first CBUSH Element from an op2-File, calculate 

the RF for 

% one element, respecting your input, then output it to the Command Window 

%---------------------------------------------------------------------------

------------ 
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% Clear Command Window, Functions, Variables and Figures of COMPOSE 

% 

clc; 

clear all; 

close all; 

 

%---------------------------------------------------------------------------

------------ 

% User Input Definition 

% 

DIR      = '<enter-path>';                % Path to Result File 

filename = 'CBUSHmodel_v1.op2';           % Name of Result File 

Fall     = 4000.0;                        % Allowable Force-Sum 

 

%---------------------------------------------------------------------------

------------ 

% Build Reference to File from DIR and filename 

% 

fileIN = strcat(DIR, '\', filename);          

 

%---------------------------------------------------------------------------

------------ 

% Read Force-Results of the first CBUSH-Element in the List 

% 

Fx = readvector(fileIN, 1, 16, 1, 2); 

Fy = readvector(fileIN, 1, 16, 1, 4); 

Fz = readvector(fileIN, 1, 16, 1, 6); 

 

%---------------------------------------------------------------------------

------------ 

% Read the CBUSH-Element Names from the Inputfile and cut the leading "E" to 

get the IDs 

% only then select the first ID 

% 

reqE = getreqlist(fileIN, 1, 7); 

eNames = regexp(reqE, 'E', 'split'); 

for i = 1 : length(reqE) 

      eIDs(i, :) = str2num(eNames{i}{1, 2}); 

end        
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%---------------------------------------------------------------------------

------------ 

% RF Calculation for the first CBUSH-Element in the List 

% Simple Example - Build your own RF Calculation here 

% 

 Fs   = (Fy^2 + Fz^2)^.5; 

 Fsum = ((abs(Fx) + 2*Fs) / 3) 

 RF   = (Fall / Fsum); 

 

%---------------------------------------------------------------------------

------------ 

% Output Results to Command Window 

% 

printf('element # | Fx       | Fy       | Fz       |  All. F Sum  |   RF     | 

\n'); 

printf('----------|----------|----------|----------|--------------|---------

-| \n'); 

printf('%9.0f | %8.2f | %8.2f | %8.2f | %12.2f | %8.3f | \n', eIDs(1), Fx, Fy, 

Fz, Fall, RF) 

 

%---------------------------------------------------------------------------

------------ 

2 

%---------------------------------------------------------------------------

------------ 

% This Script will read the first CBUSH Element from an op2-File, calculate 

the RF for 

% one element, respecting your input, then output it to the Command Window 

%---------------------------------------------------------------------------

------------ 

% Clear Command Window, Functions, Variables and Figures of COMPOSE 

% 

clc; 

clear all; 

close all; 

 

%---------------------------------------------------------------------------

------------ 
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% User Input Definition 

% 

DIR      = '<enter-path>';                % Path to Result File 

filename = 'CBUSHmodel_v1.op2';           % Name of Result File 

Fall     = 4000.0;                        % Allowable Force-Sum 

 

%---------------------------------------------------------------------------

------------ 

% Build Reference to File from DIR and filename 

% 

fileIN = strcat(DIR, '\', filename);          

 

%---------------------------------------------------------------------------

------------ 

% Read Force-Results of the first CBUSH-Element in the List 

% 

Fx = readvector(fileIN, 1, 16, 1, 2); 

Fy = readvector(fileIN, 1, 16, 1, 4); 

Fz = readvector(fileIN, 1, 16, 1, 6); 

 

%---------------------------------------------------------------------------

------------ 

% Read the CBUSH-Element Names from the Inputfile and cut the leading "E" to 

get the IDs 

% only then select the first ID 

% 

reqE = getreqlist(fileIN, 1, 7); 

eNames = regexp(reqE, 'E', 'split'); 

for i = 1 : length(reqE) 

      eIDs(i, :) = str2num(eNames{i}{1, 2}); 

end        

 

%---------------------------------------------------------------------------

------------ 

% RF Calculation for the first CBUSH-Element in the List 

% Simple Example - Build your own RF Calculation here 

% 

 Fs   = (Fy^2 + Fz^2)^.5; 

 Fsum = ((abs(Fx) + 2*Fs) / 3) 
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 RF   = (Fall / Fsum); 

 

%---------------------------------------------------------------------------

------------ 

% Output Results to Command Window 

% 

printf('element # | Fx       | Fy       | Fz       |  All. F Sum  |   RF     | 

\n'); 

printf('----------|----------|----------|----------|--------------|---------

-| \n'); 

printf('%9.0f | %8.2f | %8.2f | %8.2f | %12.2f | %8.3f | \n', eIDs(1), Fx, Fy, 

Fz, Fall, RF) 

 

%--------------------------------------------------------------------------------------- 

The below result will be output by compose to a text file. 

element # | Fx       | Fy       | Fz       |  All. F Sum  |   RF     |  

----------|----------|----------|----------|--------------|----------|  

     6680 |   -75.11 |  1202.62 | -1260.17 |      4000.00 |    3.372 |  

     6681 |  -106.39 |  1203.48 | -1239.85 |      4000.00 |    3.369 |  

     6682 |   -75.10 | -1202.62 |  1260.14 |      4000.00 |    3.372 |  

     6683 |  -106.39 | -1203.47 |  1239.84 |      4000.00 |    3.369 |  

     6684 |   -75.10 | -1202.62 |  1260.15 |      4000.00 |    3.372 |  

     6685 |  -106.39 | -1203.47 |  1239.83 |      4000.00 |    3.369 |  

     6686 |   -75.10 |  1202.61 | -1260.16 |      4000.00 |    3.372 |  

     6687 |  -106.38 |  1203.49 | -1239.85 |      4000.00 |    3.369 |  

     6688 |   -75.11 |  1260.17 |  1202.62 |      4000.00 |    3.372 |  

     6689 |  -106.39 |  1239.85 |  1203.48 |      4000.00 |    3.369 |  

     6690 |   -75.10 |  1260.14 |  1202.62 |      4000.00 |    3.372 |  

     6691 |  -106.39 |  1239.84 |  1203.47 |      4000.00 |    3.369 |  

     6692 |   -75.10 |  1260.15 |  1202.62 |      4000.00 |    3.372 |  

     6693 |  -106.39 |  1239.83 |  1203.47 |      4000.00 |    3.369 |  

     6694 |   -75.10 |  1260.16 |  1202.61 |      4000.00 |    3.372 |  
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     6695 |  -106.38 |  1239.85 |  1203.49 |      4000.00 |    3.369 |  

 Minimum RF =   3.37 at Element:     6687  

 

14.2.2 Read Von Mises Stress and Plot Value Over Element ID 

Step 1: Data and Task Description  

1. Load initially: Compose_h3d-vM-Plot.oml 

2. Use to extract von Mises stress: Sub-Wall-Cutout.h3d 

3. Read an oml-Script into Compose which was created for a different data-

source. 

4. Use the ReadVector Builder to generate the expression to read the von Mises 

stress results from an h3d-file. 

5. Insert this expression into the original script, replacing the obsolete 

expression. 

6. Run the script to see and inspect the plot of von Mises Stress value over the 

element IDs. 
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Figure 14.16 : Script and output for Von Mises Stress  

Step 2: Read oml-Script and Start the ReadVector Builder 

1. Use File > Open or drag&drop to load Compose_h3d-vM-Plot.oml 

2. Check View > OML Command Window (1) 

3. Type readvectorbuilder (2) in the oml command window and hit enter (note 

the autofill-proposals of commands) 

4. See the ReadVector Builder Window (3) appear. 
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Figure 14.17 : “readvectorbuilder” command 

Step 3: Create and use Expression to read vM Stress 

1. In the ReadVector Builder load /01_data/Sub-Wall-Cutout.h3d (1) 

2. Select the entries as shown right hand (2). 

3. Press Print (3). 

4. Note an expression showing up in the display area (4). 

5. Select and copy that expression (5) 

6. In the Editor Window (6) replace the existing readmultvectors expression by 

the one you just copied. 
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Figure 14.18 : Step to select the path to read vM Stress 

Step 4: Run the Script and Inspect the Plot 

1. Hit the Start button (1) to run the script that is shown in the current Editor 

Window (2). 

2. See a Plot appear in the Figure Window (3). Drag the window borders and 

move the legend to have it approx. look like on the right hand. 

Note the blue crosses showing the value of von Mises stress of elements plus 

horizontal curves added through the script, for maximum, minimum and average 

stress. 

Note there is a gap between some absolute maximum values and the continuous row 

of lower values (4). 

3. You might want to check the location of those elements and refine the mesh 

size there to improve the results. 
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Figure 14.19 : Step to run script 

Code: 

 

% This Script will read von Mises (Z1) Results from an h3d File, sort them and 

identify 

% max, min and average Stress Values, then Plot the Data to one Figure Window 

% Clear Command Window, Functions, Variables and Figures of COMPOSE 

% 

clc; 

clear all; 

close all; 

 

% Read von Mises Stress of all Elements from h3d File to Vector vm 

 

vm=readmultvectors('C:/Users/priyana/Documents/compose_matthias/Compose2017-

3_Basic-Exercises_01-CAE-Reader/01_h3d-vM-plot/01_data/Sub-Wall-

Cutout.h3d','Subcase 1 (pressure load)','Element Stresses (2D & 3D) 

(2D)','E109','E4383','vonMises (Z1)','vonMises (Z1)','All'); 

% Sort and evaluate the Data 

% 

vm = sort(vm);                % sort the stress 
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n_elements = length(vm);      % elements number 

max_stress = max(vm);         % max Von Mises Stress 

min_stress = min(vm);         % min Von Mises Stress 

avg_stress = mean(vm);        % avarage Von Mises Stress 

% Build formatted Plots from the different Data Sets in one Figure Window 

scatter([1:n_elements],vm,'x','markersize',1); 

hold on 

plot([1,n_elements],[max_stress,max_stress],'r-.','linewidth',4); 

plot([1,n_elements],[min_stress,min_stress],'g-.','linewidth',4); 

plot([1,n_elements],[avg_stress,avg_stress],'m:','linewidth',2); 

grid on 

% Name and Format of Axes, Legend and Title 

title('Overall view of the sorted Von Mises Stress'); 

xlabel('generic i_th element'); 

ylabel('VonMises_Stress [MPa]'); 

legend('Element Stress','Max Stress','Min Stress','Average Stress') 

  

14.2.3 Post-processing of Automotive Crash CAE simulation 

Follow the video below for the steps required to complete the exercise. 

https://altair-2.wistia.com/medias/40eavqddze  
 

1. Automatically import the data (CAE/Test/Excel).   

2. Select the angular acceleration vs. time channel (vector). 

3. Design a low pass FIR (moving average) filter to this signal.  

4. Compare original (CAE) results vs. filtered results. 

 

 

Figure 14.20 : Description of above scenario. 

https://altair-2.wistia.com/medias/40eavqddze
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Figure 14.21 : Code for Post-processing of Automotive Crash CAE simulation 
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Figure 14.22 : Plot of CAE data 
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  Mechanical Examples  

14.3.1 Introduction to the Finite Element Method on a Simple 

Truss System 

Problem Statement and Theory of Elasticity 

Let's consider a simple structural problem: A truss system of two joint trusses is 

fixed on the left side and an external force acts on the system on the right side.

 

Figure 14.23 : Truss System 

The geometric properties of the truss system as well as the cross sections, material 

definitions are given, and we are interested in finding out the displacements of the 

nodes. Please note that the system has only one degree of freedom, as indicated with 

the x-direction Figure 14.23. 

As a first step, we want to decompose the system into the elements. For a single truss 

element, the following forces can be identified: 

l1 l2 

Node1 Node 
 

Node 
 

Element 
 

Element 
 

F 

u 
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Figure 14.24 : Truss System Equations 

When determining which force is acting because of the stress in the material, first 

let’s define the positive stress as the tension stress and let's consider the following 

equations.  

𝐹𝐹𝑠𝑠 = 𝜎𝜎 ⋅ 𝐴𝐴 

with 𝐹𝐹𝑠𝑠 as the force acting because of the stress 𝜎𝜎 on the cross-section surface area 

of 𝐴𝐴. With: 

𝜎𝜎 = 𝐸𝐸 ⋅ 𝜖𝜖 

𝐸𝐸 is the Young's module of the material and 𝜖𝜖 is the strain in 𝑥𝑥, the following can be 

stated: 

𝐹𝐹𝑠𝑠 = 𝐸𝐸 ⋅ 𝜖𝜖 ⋅ 𝐴𝐴 

As the strain in this case can be express as the change in displacement divided by the 

initial length of the truss, it follows: 

𝜖𝜖 =
Δ𝑙𝑙
𝑙𝑙0

=
𝑢𝑢2 − 𝑢𝑢1
𝑙𝑙0

 

𝐹𝐹𝑠𝑠 =
𝐸𝐸 ⋅ 𝐴𝐴
𝑙𝑙0

⋅ (𝑢𝑢2 − 𝑢𝑢1) = 𝑘𝑘 ⋅ (𝑢𝑢2 − 𝑢𝑢1) 

F1 F2 

u1 u2 

Node Node 

Node Node 

F1 

u1 

Fs Fs 
F2 

u2 

l0 
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In the last equation, we found a relation between the force and the displacement of 

the nodes. This relation is defined by stiffness 𝑘𝑘.  

Going back to the truss, we can now state the sum of forces on each node. As the 

system is not in motion (static loadcase), the sum of forces on each node (compare 

Figure 14.24) have to be zero. This results in two equations, one for each node. They 

can also be written in matrix form. 

Node1:  

Σ𝐹𝐹𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁1 = 0 → 𝐹𝐹1 + 𝑘𝑘 ⋅ (𝑢𝑢2 − 𝑢𝑢1) = 0 

Node2: 

Σ𝐹𝐹𝑁𝑁𝑁𝑁𝑁𝑁𝑁𝑁2 = 0 → 𝐹𝐹2 − 𝑘𝑘 ⋅ (𝑢𝑢2 − 𝑢𝑢1) = 0 

Matrix Form: 

�𝐹𝐹1𝐹𝐹2
� = � 𝑘𝑘 −𝑘𝑘

−𝑘𝑘 𝑘𝑘 � ⋅ �
𝑢𝑢1
𝑢𝑢2� 

with 𝑘𝑘 = 𝐸𝐸⋅𝐴𝐴
𝑙𝑙𝑜𝑜

. 

Coming back to the original truss system, we have two trusses which are connected 

to each other. We can easily describe the forces and displacement like above for two 

beams. Note, that each beam has its own u1 and u2 as well as F1 and F2. This 

formulation is also known as unbound or local formulation. We will denote the 

element as a superscript on the physical quantities. So e.g. 𝑢𝑢12 indicates the 

displacement of node 1 on element 2. As the two trusses may differ with respect to 

cross section area, length and Young's module, we will use an index for 𝑘𝑘 as well. 
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In order to get this unbound description of our system to the global, connected 

description of our system we have to relate the global and local displacements and 
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forces with each other. This is done by so-called boolean matrices, which indicate 

with a "1" entry, that the two displacements are the same and with a "0" entry if not. 

 

 

 

Look at and think for a bit, before continuing to the equations written below: 
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𝐹𝐹𝑔𝑔𝑙𝑙𝑁𝑁𝑔𝑔𝑙𝑙𝑙𝑙 = 𝐴𝐴𝑇𝑇 ⋅ 𝐹𝐹𝑙𝑙𝑁𝑁𝑙𝑙𝑙𝑙𝑙𝑙 

𝐹𝐹𝑔𝑔𝑙𝑙𝑁𝑁𝑔𝑔𝑙𝑙𝑙𝑙 = 𝐴𝐴𝑇𝑇 ⋅ 𝐾𝐾𝑙𝑙𝑁𝑁𝑙𝑙𝑙𝑙𝑙𝑙 ⋅ 𝑢𝑢𝑙𝑙𝑁𝑁𝑙𝑙𝑙𝑙𝑙𝑙 

𝐹𝐹𝑔𝑔𝑙𝑙𝑁𝑁𝑔𝑔𝑙𝑙𝑙𝑙 = 𝐴𝐴𝑇𝑇 ⋅ 𝐾𝐾𝑙𝑙𝑁𝑁𝑙𝑙𝑙𝑙𝑙𝑙 ⋅ 𝐴𝐴 ⋅ 𝑢𝑢𝑔𝑔𝑙𝑙𝑁𝑁𝑔𝑔𝑙𝑙𝑙𝑙 

𝐹𝐹𝑔𝑔𝑙𝑙𝑁𝑁𝑔𝑔𝑙𝑙𝑙𝑙 = 𝐾𝐾𝑔𝑔𝑙𝑙𝑁𝑁𝑔𝑔𝑙𝑙𝑙𝑙 ⋅ 𝑢𝑢𝑔𝑔𝑙𝑙𝑁𝑁𝑔𝑔𝑙𝑙𝑙𝑙 with: 𝐾𝐾𝑔𝑔𝑙𝑙𝑁𝑁𝑔𝑔𝑙𝑙𝑙𝑙 = 𝐴𝐴𝑇𝑇 ⋅ 𝐾𝐾𝑙𝑙𝑁𝑁𝑙𝑙𝑙𝑙𝑙𝑙 ⋅ 𝐴𝐴 
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Figure 14.25 : Nomenclature of nodal displacments 
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With this equation, we can now begin to implement the boundary conditions. 

External forces only exist at node 3, so 𝐹𝐹1 and 𝐹𝐹2 are zero. For the displacement 𝑢𝑢1 =

0 constraint, the first row and column of the global stiffness matrix are set to zero 

and the top left element is set to one. The final equation, which can be used to 

calculate the displacements based on the external force is obtained as: 
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Now with the theory stated, we can work on the implementation of this equation in 

Altair Compose. 

Implementation with Altair Compose 

The truss system with its cross section, material and geometric parameters has to be 

defined first in order to calculate the displacements of the system. Therefore, one can 

either use default values or ask for user input. Both ways are described below: 
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Figure 14.26 : Setting default parameters (top) or ask for user input (bottom) 

After having set the properties of the system, we can now calculate the stiffness 

matrix and insert the boundary conditions of the system. 

 

Figure 14.27 : Setting up the stiffness matrix of the truss system 

Finally, we can calculate the displacements of our system and give some user output: 

 

Figure 14.28 : Calculation of the displacements and User output 

 

https://www.youtube.com/watch?v=MNme-hHvyWI 

https://www.youtube.com/watch?v=MNme-hHvyWI
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14.3.2 Introduction to the 12 Steps to Navier-Stokes with 

Python 

First, a brief note about Navier Stokes Equations, all non-reacting homogeneous flows 

are governed by the three basic conservation laws which are namely: 

• Conservation of mass 

• Conservation of momentum (Newton’s second law of motion) 

• Conservation of energy  

These are the three equations which encompass the entirety of the foundation of 
fluid dynamics. 

Navier Stokes set of equations, which are a derivative of these basic laws are the 

governing equations for all viscous flows. These equations describe the relationship 

between the various properties of fluids such as the pressure, density, enthalpy, 

temperature, viscosity and velocity with respect to space and time variables. 

The Navier Stokes equations describe a thermodynamically open system which 

accounts for losses due to viscosity but does not always conform to a state of thermal 

equilibrium. It is also necessary to remember that these equations are developed 

following the assumption that fluids are a continuum, neglecting the fact that fluids 

are made of molecules which are discrete particles.  

The analytical solution of the Navier Stokes equations is the flow velocity at every 

instance in time and at every point in the flow field. Other properties of the flow such 

as temperature and pressure can be calculated at the points of interest using 

supplementary relations. 

Legal Notice 

The 12 steps to Navier-Stokes were originally developed by Lorena Barba (The Barba 

Group) and its python notebooks can be found under:  

https://github.com/barbagroup/CFDPython  

The version presented with this study guide have been adapted to fit a non-python-

notebook environment. 

https://github.com/barbagroup/CFDPython
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Introduction to Python and its Libraries Within Altair Compose 

Altair Compose is capable of running python programs out of the box. Python is an 

interpreted, high-level programming language and was created in 1991. It is used 

widely in scientific research today and therefore worth taking a look at and compare 

it to the OML. Part of its broad application comes from its rich libraries, which let you 

do very complex tasks with very few lines of code. The version of python installed 

with Altair Compose has the most important libraries already installed, which are 

referenced down below. These are:  

1) NumPy: Adds support for large, multi-dimensional matrices along with many 

built in high-level mathematical functions. 

2) MatplotLib: Plotting library for python. It lets you create 2D and 3D plots 

easily. 

In case you want to install a library, which is not yet installed with Altair Compose, 

simply open a CMD command window by pressing Windows+R and type cmd.exe. 

Then navigate to the installation folder by typing for example (adapt this to your 

installation directory):  

cd C:\Program Files\Altair\2017\sTAltair Compose2017.3\python\python3.4\win64 

followed by: 

python.exe -m pip install --upgrade pip  

this upgrades the pip installer, which is used to install any third party library. Next you 

want to install the third party library (e.g. Matplotlib) with:  

python.exe -m pip install matplotlib 

or if you want to upgrade matplotlib, you can use do this with: 

python.exe -m pip install --upgrade matplotlib  

You can also watch this video, where you can follow the update process:  
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https://www.youtube.com/watch?v=dTAGxPbbcKk 

This way you can enrich the functionality of the python version already installed with 

Altair Compose. In the following section we will take a look at linear convection and 

how to model it with python in Altair Compose. As it is a very basic problem, you will 

learn the python syntax on this very first example.  

Step 1: Linear Convection 

Linear convection is the simplest differential equation you can find which also tells 

you something about fluid dynamics. You can define linear convection as:  

𝛿𝛿𝑢𝑢
𝛿𝛿𝑡𝑡

+ 𝑐𝑐 ⋅
𝛿𝛿𝑢𝑢
𝛿𝛿𝑥𝑥

= 0 

Where 𝑢𝑢(𝑥𝑥) is a function depending on the single degree of freedom 𝑥𝑥. All the above 

equation is stating is, that the change in time of this function �𝛿𝛿𝛿𝛿
𝛿𝛿𝛿𝛿
� is equal to a 

constant (−𝑐𝑐) times the change in space �𝛿𝛿𝛿𝛿
𝛿𝛿𝛿𝛿
�. So it can be understood as a 

propagating wave with the speed of 𝑐𝑐. Let’s start implementing this equation in 

python.  

 

Figure 14.29 : Linear Convection: Import libraries 

With the first to lines of code, we want to import both numpy and pyplot which is 

taken from matplotlib. As you can guess from the syntax of the second line of code: I 

can use pyplot by simply using plt in my code below, which makes things easier.  

Let’s now consider, how we model this step. We first want to have a discrete grid with 

the length of 2 defined with a number of grid points (𝑖𝑖𝑥𝑥 = 81). The distance between 

https://www.youtube.com/watch?v=dTAGxPbbcKk
https://www.youtube.com/watch?v=dTAGxPbbcKk
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two grid points can be defined as: 𝑑𝑑𝑥𝑥 = 2
𝑗𝑗𝛿𝛿−1

. We also want to define a time step 

(𝑑𝑑𝑡𝑡 = 0.025), the number of time steps we want to calculate (𝑖𝑖𝑡𝑡 = 25) and the 

wave propagation speed (𝑐𝑐 = 1). 

 

Figure 14.30 : Linear Convection: Variables 

As you can see on Figure 14.30, you can use math expressions just like with OML e.g. 

in line 5. 

Next, let’s consider our function 𝑢𝑢, which is an initial wave. As it depends on 𝑥𝑥 we 

now have to define a value for 𝑢𝑢 for each grid point we defined. First, we create an 

array with just ones in it which has as many entries as grid points. We can use the 

function numpy. ones(nx) for this purpose. As this gives us ones everywhere, which is 

not a wave as we wanted, we set all values within this array to 2 for each grid point 

which is between 𝑥𝑥 = 0.5 and 𝑥𝑥 = 1. As we want to see this initial condition for our 

system, we want to plot it, which we can do with matplotlib. 

 

Figure 14.31 : Linear Convection: Initial Conditions 

Now we have to think about how we can calculate the next time step for our equation. 

Derivatives can be calculated with different schemes, like the forward difference 

scheme, the backward difference scheme and the central difference scheme. All 

these schemes have in common that the derivative is calculated as  

𝛿𝛿𝑢𝑢
𝛿𝛿𝑥𝑥

=
Δ𝑢𝑢
Δ𝑥𝑥
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Where in the discrete world Δ𝑥𝑥 is our grid distance and the mentioned schemes differ 

in the definition of Δ𝑢𝑢. For the forward difference scheme, which we want to use for 

out time differential Δ𝑢𝑢 is defined as Δ𝑢𝑢 = 𝑢𝑢(𝑥𝑥 + Δ𝑥𝑥) − 𝑢𝑢(𝑥𝑥). For the backward 

difference scheme, which we want to use for our spatial differential Δ𝑢𝑢 is defined as 

Δ𝑢𝑢 = 𝑢𝑢(𝑥𝑥) − 𝑢𝑢(𝑥𝑥 − Δ𝑥𝑥). This gets us the following discrete equation: 

𝑢𝑢𝑖𝑖𝑗𝑗+1 − 𝑢𝑢𝑖𝑖𝑗𝑗

Δ𝑡𝑡
= 𝑐𝑐

𝑢𝑢𝑖𝑖𝑗𝑗 − 𝑢𝑢𝑖𝑖−1𝑗𝑗

Δ𝑥𝑥
 

Which we can solve for 𝑢𝑢𝑖𝑖𝑗𝑗+1: 

𝑢𝑢𝑖𝑖𝑗𝑗+1 =  𝑢𝑢𝑖𝑖𝑗𝑗 − 𝑐𝑐
Δ𝑡𝑡
Δ𝑥𝑥

(𝑢𝑢𝑖𝑖𝑗𝑗 − 𝑢𝑢𝑖𝑖−1𝑗𝑗 ) 

Note that 𝑖𝑖 denotes the timestep and is not to be understood as an exponent 

whereas 𝑏𝑏 denots the value of 𝑢𝑢 at grid point 𝑏𝑏. 

Implementing this equation, we first have to think about an iterative procedure. As 

we iterate over time, this will be an outer loop. Within one timestep we have to 

iterate through all the values of u and calculate 𝑢𝑢𝑗𝑗+1. As we want to write our results 

in 𝑢𝑢, we have to store the result of the current timestep in a temporary array (𝑢𝑢𝑖𝑖).  

 

Figure 14.32 : Linear Convection: Calculation 

Try changing the numbers of the variables and see what happens. You will notice that 

the wave doesn’t necessarily keep its form, as there is some diffusion happening 

backward difference scheme for the spatial differential.  
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Figure 14.33 : Linear Convection. Diffusion happening with nx = 41 

You can also get unstable behavior when setting the timestep to a larger value. The 

following image is created with nx = 41 and dt = 0.25. 

 

Figure 14.34 : Linear Convection: Unstable behaviour with increasing timestep 
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Navier stokes steps are further described with Videos: 
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14.3.3 Engineering Stress / Strain vs. True Stress / Strain 

Problem Statement 

From mechanics we know that we can calculate the stress by dividing the force acting 

by the area it is acting on.  

𝜎𝜎 =
𝐹𝐹
𝐴𝐴

 

Think about a tensile bar, which is pulled on each side until failure. You are interested 

in calculating the stress in the material but which cross sectional area do you use for 

this calculation. When calculating the so-called engineering stress, the cross section 

of the undeformed bar is used for the calculation during the whole tensile test. As 

plastic hardening occurs, the cross-sectional area shrinks. It can be seen most 

obviously at the necking phase of the tensile test. Look at Figure 14.35, where the 

lower bar shows necking. 

 

Figure 14.35 : Tensile Test, Necking 
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Figure 14.36 : Stress Strain Curves 

The engineering stress/strain curve is displayed on Figure 14.36. Note the different 

phases on the tensile test. First, in the elastic section, there is a linear dependence 

between stress and strain. This is expressed with Hook’s law. After the elastic phase, 

all other phases are plastic. In the yielding phase, there is no significant stress 

increase. In contrast, there is only an elongation of the tensile bar happening. In the 

hardening phase the stress increases again reaching its peak and turning into the 

necking phase before failure.  

The concept of true stress / true strain accounts for the cross-sectional change during 

the tensile phase.  

True Stress / True Strain Calculation 

In this section, the equations for calculating true stress (𝜎𝜎′) and true strains (𝜖𝜖′) are 

derived. The initial cross section and length are denoted with a 0 index.  

At the beginning of the tensile test, the following equation calculates the true stress  

𝜎𝜎′ =
𝐹𝐹
𝐴𝐴
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As there is no material added or subtracted during the process, we can assume for 

constant volume during the whole process. With constant volume, the cross-section 

reduction flows into the elongation. 

𝐴𝐴0 ⋅ 𝐿𝐿0 = 𝐴𝐴 ⋅ 𝐿𝐿 

 

Figure 14.37 : Constant Volume during Cross-sectional reduction 

We can now insert this in the initial stress equation: 

𝜎𝜎′ =
𝐹𝐹 ⋅ 𝐿𝐿
𝐴𝐴0 ⋅ 𝐿𝐿0

 

Finally, with the strain equation:  

𝜖𝜖 =
𝐿𝐿 − 𝐿𝐿0
𝐿𝐿0

 =
𝐿𝐿
𝐿𝐿0
− 1  

we get the true stress equation: 

𝜎𝜎′ =
𝐹𝐹
𝐴𝐴0

⋅ (1 + 𝜖𝜖) = 𝜎𝜎 ⋅ (1 + 𝜖𝜖) 

Engineering strain is defined as taking the length of the bar after the tensile test and 

divide the elongation difference by the initial length:  

𝜖𝜖 =
Δ𝐿𝐿
𝐿𝐿0

 

True strain on the other hand is the integrated change in length divided by the 

corresponding initial length.  

𝜖𝜖′ = �
Δ𝐿𝐿
𝐿𝐿

=  �
𝑑𝑑𝐿𝐿
𝐿𝐿

𝐿𝐿

𝐿𝐿0
= ln(𝐿𝐿) − ln(𝐿𝐿0) = ln �

𝐿𝐿
𝐿𝐿0
� = ln(1 + 𝜖𝜖) 

A0 

L0 L 

A 
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In the following section, we implement the above equations with Altair Compose. 

We start by taking an engineering stress strain curve and aim to plot the true stress 

strain curve.  

Implementation with Altair Compose 

For the implementation in Altair Compose we take an exemplary engineering stress 

/ strain curve as an input. We assume that we have an .xls document with the curve.  

Table 1 Engineering Stress / Strain Curve as Input. Stress is given in MPA 

Strain (Engineering) Stress (Engineering) 

0 0 

0,00146 293,486639 

0,0023 272,928767 

0,0031 264,030583 

0,005 268,939926 

0,007 267,559173 

0,01 264,030583 

0,049 318,64702 

0,125 372,036121 

0,218 394,434997 

0,234 395,048665 

0,306 384,156061 

0,33 360,376432 

0,348 327,545203 

0,36 289,958049 

0,366 266,792088 
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The data listed on Table 1 follows a convention: The first two values denote the linear 

phase. They have to be ignored, as engineering stress /strain and true stress / strain 

are the same in this phase.  

We can use the build in .xls file reader to get the data into Altair Compose. This is 

done with the following code snippet: 

clc; clf; clear all; printf('Import\n') 

inputEng = 

xlsread('F:\Compose\StudyGuide\TensileStressStrainEngineering.xlsx'); 

epsilonEng = inputEng(:,1); 

sigmaEng = inputEng(:,2); 

 

With the first commands, all current variables, the console and the figures are 

cleared. As the .xls document has to columns, the variable inputEng will have two 

columns as well. They are split up into the separate matrices epsilonEng and sigmaEng 

containing the engineering strain and engineering stress respectively. 

%Calculation True Stress 

printf('Calculation\n') 

outPutTrue = zeros(size(inputEng)(1),size(inputEng)(2)); 

epsilonTrue = log(1+epsilonEng); 

sigmaTrue= sigmaEng.*(1+epsilonEng); 

outPutTrue(1:2,1:2)=inputEng(1:2,1:2); % elastic phase 

outPutTrue(3:end,1)=epsilonTrue(3:end); 

outPutTrue(3:end,2)=sigmaTrue(3:end); 

 

Now, let’s implement the calculation. As an output matrix, the variable outputTrue is 

used, having the same size as the input Matrix. The equation taken from the last 

section are implemented with the variables epsilonTrue and sigmaTrue. Note the 

component wise multiplication denoted with “.*”. Both calculations are joint 

together with the before mentioned outputTrue Matrix and the elastic phase is 

overwritten in this matrix to ensure its not changed from the values in epsilonTrue 

and sigmaTrue.  
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%Plotting 

printf('Plotting\n') 

hold on; 

plot(inputEng(:,1),inputEng(:,2)); 

plot(outPutTrue(:,1),outPutTrue(:,2)); 

xlabel('strain'); 

ylabel('stress'); 

title('Stress Strain Curves'); 

legend('engineering stress/strain', 'true stress/strain'); 

hold off; 

%Exporting 

printf('Export\n') 

outputConcat = horzcat(inputEng,outPutTrue); 

xlswrite('F:\Compose\StudyGuide\TensileStressStrainTrue.xlsx',outputConcat) 

 

Finally, we can plot the results and export it as an .xls document. To plot both curves 

into one figure, the “hold on” command is used. As we want to export both curves, 

the input and output matrix are joint together using the horizontal concatenate 

command.  

 

Figure 14.38 : Stress Strain Curves Plotting Result 
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Figure 14.39 : Input and output matrices 

 Electronic Examples 

14.4.1 Rectifier 

A rectifier is an electrical device that converts alternating current(AC), which 

periodically reverses direction, to direct current(DC), which flows in only one 

direction. The process is known as rectification, since it "straightens" the direction of 

current. Rectifiers are used as components of power supplies and as detectors of 

radio signals. Rectifiers may be made of solid state diodes, vacuum tube diodes, 

mercury arc valves, and other technologies 

Half Wave Rectifier 

With Half Wave Rectifiers, when AC supply is applied at the input, the positive half 

cycle appears across the load, whereas the negative half cycle is suppressed. This can 

be done by using the semiconductor PN – junction diode. The diode allows the current 

to flow only in one direction. Thus, convert the AC voltage into DC voltage. 

 

 Figure 14.40 : Circuit of half wave rectifier 
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Assuming that the diode is ideal, the diode conducts when source voltage is positive, 

making V0 = VS    when   VS ≥ 0 

When the source voltage is negative, the diode is cut-off, and the output voltage is V0 

= 0 when VS < 0 

 

 

Figure 14.41 : Input and output waveform of a half wave rectifier circuit. 

Execrise: Write a code in Altair Compose to generate a half wave rectifier output. 

Step 1: Open Untitled.oml File 

Type “close all”, “clear”, and “clc” in the Command Window to close all 

open plots, clear all variables, and remove previous commands in the Editor 

Window 

Step 2: Generate Sine Wave 

Type the following line as shown below 

 

Figure 14.42 : Generation of Sine Wave 
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Step 3: Define Loop with Logic and Plot 

If signal is less than or equal to zero, than the output is zero else output is the signal 

passed through. Type the logic as shown below. 

 

 

 

Figure 14.43 : Plot of half wave rectifier 

Full Wave Rectifier 

A full wave rectifier converts both half cycles of the AC input signal to pulsated DC 

output signal. 
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Figure 14.44 : Circuit of full wave rectifier 

In a full wave rectifier, when Ac supply is applied at the input and point 1 of the 

transformer is positive with respect to c, D1 conducts in the forward direction and the 

positive half cycle appears across the load(Resistor). When point 2 of the transformer 

is positive with respect to c, D2 conducts in the forward direction and the positive half 

cycle appears across the load. As the output voltage cross load(Resistor) is the sum of 

two waveforms combined. A center tap is a contact made to a point halfway along a 

winding of the secondary transformer, it is known as a center tapped transformer. 

 

 

 

Figure 14.45 : Input and output waveform of a full wave rectifier circuit 

 

https://en.wikipedia.org/wiki/Transformer
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Execrise: Write a code in Altair Compose to generate a full wave rectifier output. 

Step 1: Open Untitled.oml File 

Type “close all”, “clear”, and “clc” in the Command Window to close all 

open plots, clear all variables, and remove previous commands in the Editor 

Window. 

Step 2: Generate Sine Wave 

Type the following line as shown below. 

 

Figure 14.46 : Generation of Sine Wave 

Step 3: To polt output 

Type the following line as shown below. 
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Figure 14.47 : Plot of full wave rectifier 

14.4.2 Generation of AM, FM and PWM Waveforms 

Modulation is the process of varying one or more properties of a periodic waveform, 

called the carrier signal, with a modulating signal that typically contains information 

to be transmitted. 

Two types of modulation Techniques. 

1. Analog Modulation 

2. Digital Modulation 

The analog carrier signal is modulated by analog information signal so that 

information bearing analog signal can travel larger distance without the fear of loss 

due to absorption. 

Digital modulation means an analog signal of carrier is converted by a digital data bit 

stream. 

https://en.wikipedia.org/wiki/Waveform
https://en.wikipedia.org/wiki/Carrier_signal
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The Analog modulation is of two types Amplitude Modulation and Angle 

Modulation. The Angle modulation is further classified as Frequency modulation and 

Phase Modulation.  

Amplitude Modulation(AM): In this type of modulation the strength of the carrier 

signal is varied with the modulating signal. 

Frequency Modulation(FM): In this type of modulation the frequency of the carrier 

signal is varied with the modulating signal. 

Pulse Width Modulation (PWM): Pulse width of the carrier signal is varied with the 

modulating signal. 

 

Let’s consider the generation of modulation signals using Altair Compose. 

AM Generation 

clc; clear all; close all; 

f1=1/128;f2=5/128;n=0:255;fc=50/128; 

x=cos(2*pi*f1*n)+cos(2*pi*f2*n);  %Message signal 

xa=cos(2*pi*fc*n);         %Carrier Signal 

xamp=x.*xa;       %Amplitude Modulation 

subplot(3,1,1);plot(n,x);title('Message Signal'); 

xlabel('Time index,n');ylabel('Amplitude'); 

subplot(3,1,2);plot(n,xa);title('Carrier Signal'); 

xlabel('Time Index, n');ylabel('Amplitude'); 

subplot(3,1,3);plot(n,xamp);title('Modulated Signal'); 

xlabel('Time index, n');ylabel('Amplitude'); 
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Simulation Results: 
 

 

Figure 14.48 : Amplitude Modulation 

FM Generation 

clear all; 

close all; 

fm=input('Message Frequency='); 

fc=input('Carrier Frequency='); 

mi=input('Modulation Index='); 

t=0:0.0001:0.1;          %Plotting time 

m=sin(2*pi*fm*t);    %Message signal 

subplot(3,1,1); 

plot(t,m); 

xlabel('Time'); 

ylabel('Amplitude'); 

title('Message Signal'); 

grid on; 

 

c=sin(2*pi*fc*t);         %Carrier signal 

subplot(3,1,2); 

plot(t,c); 

xlabel('Time'); 

ylabel('Amplitude'); 
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title('Carrier Signal'); 

grid on; 

 

y=sin(2*pi*fc*t+(mi.*sin(2*pi*fm*t)));     %FM signal 

subplot(3,1,3); 

plot(t,y); 

xlabel('Time'); 

ylabel('Amplitude'); 

title('FM Signal'); 

grid on; 

 
Simulation Results: 
 

 

Figure 14.49 : Frequency Modulation 

Pulse Width Modulation 

clear all; 

close all; 

F2=input('Message frequency='); 

F1=input('Carrier Sawtooth frequency='); 

A=5; 

t=0:0.001:1; 
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c=A.*sawtooth(t,F1);%Carrier saw tooth 

subplot(3,1,1); 

plot(t,c); 

xlabel('time'); 

ylabel('Amplitude'); 

title('Carrier sawtooth wave'); 

grid on; 

m=0.75*A.*sin(2*pi*F2*t);       %Message amplitude must be less than Saw tooth 

subplot(3,1,2); 

plot(t,m); 

xlabel('Time'); 

ylabel('Amplitude'); 

title('Message Signal'); 

grid on; 

n=length(c);    %Length of carrier saw tooth is stored to ‘n’ 

for i=1:n          %Comparing Message and saw tooth amplitudes 

if (m(i)>=c(i)) 

pwm(i)=1; 

else 

pwm(i)=0; 

end 

end 

subplot(3,1,3); 

plot(t,pwm); 

xlabel('Time'); 

ylabel('Amplitude'); 

title('Pulse Width Modulated signal'); 

axis([0 1 0 2]);        %X-Axis varies from 0 to 1 & Y-Axis from 0 to 2 

 
 
 
 
Simulation Results: 
 
Message frequency=2 

Carrier Sawtooth frequency=10 
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Figure 14.50 : Pulse Width Modulation 

 

For more example on digital Communication refer the link below 

https://altairuniversity.com/learning-library/vtu-syllabus-digital-communications-
lab-model-files/  

https://altairuniversity.com/learning-library/vtu-syllabus-digital-communications-lab-model-files/
https://altairuniversity.com/learning-library/vtu-syllabus-digital-communications-lab-model-files/
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15.   Altair Compose using Visual 

Studio  
 Add Custom/User  Defined Functions 

(Windows) 
Using C/C++ Codes from Visual Studio 2015 in Windows Platform  
Objective:  

 The purpose of this document is to capture the detailed steps involved in adding 

custom user defined functions created in C/C++. This document mainly walks the user 

through the process of using a template toolbox solution provided for Microsoft visual 

studio 2010 and then add custom user defined code as well as compile it to an 

executable .dll format. The dll is then imported into the Altair Compose environment 

and then later could be used in combination with the functions supported in the base 

library. For ease of understanding a simple function to add two variables is taken as 

an example candidate to walk through the entire process.   

Pre-Requisites:   

  
Item No   Description   

1  Microsoft Visual Studio 2015  

2  Altair Compose  

3  “ToolBox Sample “ Visual Studio Project from Altair   

  

 

 

 



 
 

354 
 

 

Procedure:   

Step 1   

• Right click on the zipped file named ‘Tool Box sample’ and select ‘extract 
here’.  

• Double click on the extracted tool box sample folder.  

• Go to the solution file which is named as ‘omlAlt’ (shown below) and double 

click on it. Visual studio 2015 will be opened with the project loaded.  

 

Figure 15.1 : Unzipped files in Tool Box Sample 

Step 2  

Select Debug option and ‘x64’ from the drop-down list as shown below.  

 

Figure 15.2 : Debug option in Visual studio 

 

As you can see the SillyFunction is this case is named “silly” and this is a user created 

name and could be changed. In addition to this to support different data types like 

cell array, matrix, structure, N-Dimensional matrix, different sections are provided to 
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handle them if the user provides any such data type as an input from Altair 

Compose.  

C++ script in Visual Studio Cell Array  

 

Figure 15.4 : Cell Array handling section in C++ scrip 

  
 

 

 

 

Figure 15.3 : Function declaration 
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Matrix  

 

Figure 15.5 : Matrix handling section in C++ script 

Structure   

 

Figure 15.6 : Structure handling section in C++ script 
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Figure 15.7 : N-Dimensional Handling section in C++ script  

 
Step 3  

1. From the option, ‘Build’, select ‘build solution’.  

2. Select the path of the DLL file which has come in the output window and 

copy the path of the dll file as shown below.  

 

Figure 15.8 : dll generation in visual studio 

  
DLL is a dynamic link library file format used for holding multiple codes and 

procedures for Windows programs. DLL files were created so that multiple 

programs could use their information at the same time, aiding memory 

conservation.   
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3. Once the DLL is built it is turn now to import it in sT Altair Compose. Open sT 

Altair Compose and using the command ‘addToolbox’ in the command line 

include the full path to the dll as shown in the snapshot below. Once done 

you could pass the inputs to the functions to check for correctness.  

4. Call the function and check the results. Steps from 3 to 4 are illustrated 
below.  

 

Figure 15.9 : Calling User Defined Function in Altair Compose 
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 Add Custom/User Defined Functions (Linux) 
Using C /C++ Codes from Visual Studio 2015 in Linux Platform  
 

Objective:  

The purpose of this document is to capture the detailed steps involved in adding 

custom user defined functions created in C/C++ language and interfaced with OML 

using the OML public interface on Linux platforms. The procedure explained below 

describes how to generate object file(.o file) and shared object file (.so file) which is 

then used to add the custom defined functions into the sTAltair Compose 

environment and then later could be used in combination with the functions 

supported in the base library.  

Pre-Requisites:   

  
Item No   Description   

1  Altair Compose  

2  The following source Files   

1) AltTboxDefs.h  
2) OMLInterfacePublic.h  

3) AltTboxFuncs.cxx  
4) AltTboxFuncs.h  

 
Source Files :   

 
• AltTboxDefs.h  

          Macros for exporting from the library   

• OMLInterfacePublic.h  
The header file defining the public interface to be used in the toolbox 

creation  

• AltTboxFuncs.cxx  and AltTboxFuncs.h    
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The actual code written to implement the toolbox, using the OML public 

interface  

Compiling a toolbox for Linux :   

In the Windows section, the application note explains how to build a toolbox using a 

Visual Studio solution. Here, the compilation is performed on Linux using the GNU 

gcc/g++ compiler.  

This uses simple compilation commands, not Makefiles. We use the OmlAlt example 

(files provided) to explain the steps.   

Step 1 – Compilation  

g++ -c -o OmlAlt.o -c -g -fPIC -frtti -std=c++11 AltTboxFuncs.cxx    

This is using g++ compiler to compile the source file AltTboxFuncs.cxx 

Header files and other dependencies have to be handled. The snap shot of the Linux 

terminal for the above command execution and the generation of object file 

generation is shown below.  

  

 

Figure 15.10 : Compilation of the C++ script  

Step 2 – Library Creation  

  
  g++ -o libOmlAlt.so -shared OmlAlt.o  
  
This will create the library (shared object .so) called libOmlAlt.so. The snapshot of the 

Linux terminal for the above command execution and generation of .so file is shown 

below.  
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Figure 15.11 : Library Generation 

Step 3 – Loading the Library in Altair Compose  

In Altair Compose, in the OML command window, the toolbox will be loaded as 

follows  

 cd ('<folder where the library resides>  

 addtoolbox(<toolboxname>)  

Note:   

The addtoolbox() command receives the toolboxname, without .so extension, 

without lib prefix. In the example above, just use addtoolbox('OmlAlt')  

 The simple example given below illustrates how to create user defined functions 

for different data types.  

 

Figure 15.12 : C++ script 

 The different data types supported here are cell arrays, Matrices, 

Structures and N-Dimensional matrices  
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Cell Array  

 

Figure 15.13 : Cell Array Handling section in C++ script 

 

Matrix  

 

Figure 15.14 : Matrix Handling section in C++ script 
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Structures  

 

Figure 15.15 : Structure Handling section in C++ script 

N-Dimensional Matrix  

 

Figure 15.16 : Dimensional Matrix Handling section in C++ script 
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 Interrupt Based Serial Communication in 

Altair Compose  
 

Pre-Requisites  

Item No   Description   

1  Microsoft Visual Studio 2015  

2  Altair Compose  

3  “ToolBox Sample” Visual Studio Project from Altair   

4  Arduino Software and Arduino Board  

 

Introduction  

In Telecommunication and Computer Science, serial communication is the process of 

sending/receiving data in one bit at a time. It is like you are firing bullets from a 

machine gun to a target… that’s one bullet at a time! The pictorial representation of 

serial communication is represented below.  

 
Figure 15.17 : Sender-Receiver Concept in Serial communication 

 

Serial communication can be implemented using polling method and Interrupt driven 

method. Interrupt and polling are the two ways to handle events generated by the 

devices that can happen at any moment while CPU is busy in executing another 

process. The basic point that distinguishes Polling and Interrupt is that in polling CPU 

keeps on checking I/O  devices at regular interval whether it needs CPU service 

whereas, in interrupt, the I/O device interrupts the CPU and tell CPU that it need CPU 

service.    
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Purpose  

The purpose of this tutorial is to describe how to send sensor data from Universal 

GPIO Board to Altair Compose using Arduino board through the serial port. It provides 

you a class called PortDataReceived which enables you to implement interrupt based 

serial communication in your application. It also describes how one can continue 

using Altair Compose and execute operations on serial data only when it is available.  

15.3.1 Part 1 – Arduino and Universal GPIO Board  

 

Figure 15.18 : Arduino & GPIO Board 

Step 1  

GPIO board was designed to allow students or engineers to easily exercise and explore 

the capabilities of the various microcontrollers with peripheral devices such as: Led’s, 

Buttons, Temperature sensor and many more. Proper connections must be done 

between Arduino and GPIO Board. Power the GPIO Board using the following 

connections.   

• Connect the Vin of Arduino with the Vcc of GPIO Board.   

• Connect GND of Arduino with GND of GPIO Board.   

• Connect the A0(analog in) of Arduino with SOP of GPIO Board  
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Create a program (shown below) in Arduino which enables you to send the sensor 

data from GPIO board to your system through the serial port.  

 

Figure 15.19 : Arduino Script to receive GPIO Data 
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Step 2  

Select your board. You need to select the entry in the Tools > Board menu that 

corresponds to your Arduino.  

 

Figure 15.20 : Arduino Settings 
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Step 3  

  Select the serial device of the Arduino board from the Tools > Port menu. This is likely 

to be COM3 or higher (COM1 and COM2 are usually reserved for hardware serial 

ports). To find out, you can disconnect your Arduino board and re-open the menu; 

the entry that disappears from the menu. Reconnect the board and select that serial 

port.  

 

Figure 15.21 : Arduino Settings 
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Step 4  

Now, simply click the "Upload" button in the environment. Wait a few seconds - you 

should see the TX led on the board flashing. If the upload is successful, the message 

"Done uploading." will appear in the status bar. (Note: If you have an Arduino Mini, 

NG, or other board, you'll need to physically press the reset button on the board 

immediately before clicking the upload button on the Arduino Software.)  

15.3.2 Part 2 – Visual Studio Part  

 

Step 1  

Open Visual Studio 2015 and load the project/solution which is already prepared 

which implements the serial communication. The interrupt based serial 

communication is implemented in this tutorial by using #using "System.dll" which 

requires the Common Language RunTime Support to be enabled. In-order to enable 

it, go to properties by right clicking on “omlAlt” in the solution explorer. Enable the 

Common Language RunTime Support ( /clr option). Click on Apply and then press ok. 

/clr option creates metadata for the application. The metadata can be consumed by 

other CLR applications, and enables the application to consume types and data in the 

metadata of other CLR components.   
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Figure 15.22 : Visual Studio Properties Settings 

Step 2  

 Make sure that the Visual Studio is working in Release mode with x64 option.  

 

Figure 15.23 : Debug Option in Visual Studio 

Step 3  

This part of the code consists of header files, function declaration and definition of 

user defined function name. In addition to the usual header files coming along with 

the Altair tool box sample, #include “C:\Users\sijog\Desktop\Serial Communication -
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Final\serial_read.h” is added which constitutes the interrupt-based code for serial 

communication.  

 

Figure 15.24 : C++ Script 

The following function triggers the interrupt based concept which is defined under 

the reference class PortDataReceived. The function takes two inputs. One is Baudrate 

(type: scalar) and the other one is COM port name ( type: string). These inputs must 

be given from the Altair Compose.  

 

Figure 15.25 : C++ script to receive data 

The reference class is defined in serial_read.h which contains the definition for 

interrupt based communication. This makes use of two  additional header files #using  
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"System.dll" and #include <fstream>.  'gcnew' allocates memory for a managed type 

(reference or value type) and deallocated by using garbage collection. Baud rate is 

defined by the user. Parity is set None and stop bits and data bits are set to one and 

8 respectively. These values must be set properly in-order to have an effective 

communication with the hardware.  

  

 

Figure 15.26 : Parity, baud rate and stop bit settings 

When handshaking is used, the device connected to the Serial Port object is instructed 

to stop sending data. When there is at least (ReadBufferSize-1024) bytes in the buffer, 

Request to Send (RTS) signal is enabled during serial communication. Default is false  
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Figure 15.27 : Handshaking settings and serial port opening The interrupt concept is 

defined in DataReceiveHandler function (shown below). Whenever there is an incoming 

data stream, it is then appended to a text file named ‘myfile’.  

 

Figure 15.28 : To append the received data into a text file 

The read data function defined below is used to read the incoming data which is 

stored in the text file. The function reads the data from the text file and then exported 

to Altair Compose for displaying purpose and further manipulations.  
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Figure 15.29 : To transfer the received data into Altair Compose 

  

 

The following snapshot shows a part of the data stream which is stored in the text file. 

Since the entire data stream is stored in a text file, one could continue using Altair 

Compose and execute on serial only when the user requires it for further processing. 

The user just wants to call the interrupt function from Altair Compose to enable saving 

the data into the text file.  
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Figure 15.30 : : Received Data 

 The closeport function is used to close the port which is previously opened for 

receiving data from the Arduino Board. The function takes comport name as an input 

(type:string).  
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Figure 15.31 : To close the port 

The function isemptyf is defined to know whether any data is arrived through the 

serial port. The function must be called from Altair Compose. This function returns 

the string “No data” if data is not arrived and returns “Data Arrived” if data is arrived 

through the serial port.  

 

Figure 15.32 : To identify the data is received or not 

Step 4  

• From the option, ‘Build’, select ‘build solution’.  

• Select the path of the DLL file which has come in the output window and copy 

the path of the dll file as shown below.  
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Figure 15.33 : dll generation in Altair Compose 

15.3.3 Part 3 – Altair Compose Part  

Once the DLL is built it is turn now to import it in sT Altair Compose. Open sT Altair 

Compose and using the command ‘addToolbox’ in the command line include the full 

path to the dll as shown in the snapshot below. Once done you could pass the inputs 

to the functions to check for correctness.  

Call the function and check the results. Steps from 1 are illustrated below.  

Adding toolbox to Altair Compose  

 

Figure 15.34 : Adding Toolbox to Altair Compose 

Generation of GUI Part  

 

Figure 15.35 : Creation of GUI to display data 
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GUI Part for Filter Design  

 

Figure 15.36 : Creation of GUI for filter design 

GUI Part for FFT  

 

Figure 15.37 :  Creation of GUI for FFT 

To Close the Port  

 

Figure 15.38 : To Close port 
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Result:  

Original Data  

 

Figure 15.39 : Visualization of data in Altair Compose obtained from GPIO board 

  

Filtered Signal  

 

Figure 15.40 : Filtered Data 
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FFT of the Signal  

 

Figure 15.41 : FFT of the Filtered Data 

  
How can a user continue using Altair Compose and execute on serial data 
only when it is available?  

Reference the dll to the addToolbox function (shown below)  

Call the Interrupt function along with the baud rate and comport name.  Call the 
function isemptyf()   
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The function checks for serial data and if it is available, it displays “Data Arrived”. If 
there is no incoming data stream, it will display “No Data”. If the data is available, 
the user can call the function readdata() for further analysis.  

 

Figure 15.42 : To check whether data is arrived or not  
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16.   Appendix 
 Short Summary/Overview on Compose  

by Andreas Dahlmann - Altair Germany 
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 GUI Creation in Compose 
16.2.1 Using UI Control Functions  

In this exercise, the UI control feature is introduced. It will show how to create various 

control objects in Figure UI and link the objects to events using callback functions. This 

exercise will build up a script step by step. Therefore, all edits should be made in the 

edit window so that when the script is run, all edits are considered.   

All positions and dimensions are defined in normalized units in this exercise. It is 

implemented by setting the property ‘units’ to ‘normalized’ in every graphic function.  

Users should put the plots for this exercise into float mode.  

 

Figure 16.1 : Compose GUI 

Note:  Be sure to use Command Window when requested and Editor Window when 

requested as this exercise mixes the use of both.  
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Step 1: Open a new .oml file   

Begin with the ‘close all’ and ‘clear’ lines to close all figures and clear the variable 

browser.  

Step 2: Initialize the figure window  

1. Create a figure to host the UI using figure. Create and position the plot using axes. 

’position’ sets the size and position of the objects, and the value is specified as a 

vector of the form: [left top width height].   

 

Figure 16.2 : Position of plot  

2. Run the script. You should see a figure initialized as following.   

Figure 16.3 : Figure Window 
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Step 3: Add a pushbutton in UI  

1. Add a button element in the UI using uicontrol.  Since button is the default style 

in uicontrol, we don’t need to specify the style in this argument. The value of 

‘String’ describes the text shown on the button in the UI.   

 

Figure 16.4 : : To add button element 

  

2. Define the callback function ‘plot_sine’ . Input of the callback function should 

follow the signature format, [handle, callbackdata]. This function plots a default 

sine wave at 1Hz.   

 

Figure 16.5 : Plot of sinwave 

3. Run the script. Click the pushbutton we just created. A sine wave should be 

generated.   
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Figure 16.6 :  Sinwave generated by pressing the pushbutton  

Step 4: Add a slider in the UI  

1. Add a slider to the figure UI. Set the ‘style’ property to be slider.  

Tip:  ‘Max’ and ‘Min’ point to the range of the slider. ‘Value’ represents the initial 

position of the slider.  

 

Figure 16.7 : Adding slider in UI  

2. Add text to the UI to describe the slider. Set the ‘style’ property to text.  

 

Figure 16.8 : Description of slider 
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3. Define the callbackfunction ‘slider_callback’. This function should plot a sine wave 

according to the frequency set up by the user on the slider. get(handle,’value’) 

gets the slider position value from UI.   

 

Figure 16.9 : Callback function of slider 

4. Run the oml file and check the result. The Figure Window should look similar to 

the following. Interact with the button and slider to check if they are functional.   

 

Figure 16.10 : Slider is added in figure window 

Step 5: Add checkbox in UI to toggle grids  

1. Add a checkbox to the figure UI. Set the ‘style’ property to be ‘checkbox’. ‘Value’ 

represents the initial state of the checkbox.  Define the text (string) to display.  
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Figure 16.11 : Add checkbox  

2. Define the callback function ‘check_callback’. This function should read the value 

from the checkbox and toggle the grid accordingly.   

 

Figure 16.12 : Callback function of checkbox 

3. Run the oml script and check the result. The Figure Window should look similar 

to the following.  

 

Figure 16.13 :  Checkbox is added in figure window 
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Step 6: Add text editor in UI to change plot title  

1.  Add one-line text to describe the text editor.   

 

Figure 16.14 : Add text editor in UI  

2. Add a text editor to the figure UI. Set the ‘style’ property to be ‘edit’. ‘String’ 

defines the initial text in the text field.  

 

Figure 16.15 : Add text editor in UI  

3. Define the callback function ‘check_callback’. This function should read the string 

from the text field and update the plot title.   

 

Figure 16.16 : Callback function 

4. Run the oml script and check the result. Change the text in the text field and press 

enter.   
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Figure 16.17 : Text editor is added in figure window 

Step 7: Add toggle button in UI  

This section implements the same feature as Checkbox in Step 5, but with a different 

control object.  

1. Add one-line text to describe the toggle button.   

 

Figure 16.18 : Add toggle button 

2. Add a toggle button to the figure UI. Set the ‘style’ property to be ‘toggle’. ‘String’ 

defines the text displayed on the button. ‘Value’ is initialized to one, which refers 

to ‘grid off’ in this example.   

 

Figure 16.19 : Text display for toggle button 
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3. Define the callback function ‘toggle_callback’. This function should read the value 

from the button and toggle the plot title.   

 

Figure 16.20 : Callback function 

4. Run the oml script and check the result.  

Step 8: Add button group in UI to set axes color   

In this section, a control object that groups radio buttons is created to set the axes 

colors.    

1. Call function uibuttongroup to create a button group. ‘string’ defines the text to 

be displayed on the head of the button group. The callback function in 

  

Figure 16.21 : Toggle button is added in figure window 
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uibuttongroup usually refers to the default setup, which will be called during the 

initialization of the figure UI.   

 

Figure 16.22 : Add button group  

2. Define the callback function ‘bg_callback’. Use gca to get the handle of the current 

axes. Use set() to change the color of the current axes. ‘b’ refers to the color code 

of blue.   

 

Figure 16.23 : Callback Function  

Tip:  The two radio buttons in the button group will call the same function ‘AxesColor’. 

Radio 1 should pass string ‘Blue’ to the function while Radio 2 should pass string ‘Red’ 

to the function. The callback function sets the axes color according to the string 

passed into the function.  

 

Figure 16.24 : Text for radio button 

3. Define the callback function ‘AxesColor’. Use gca to get the handle of the current 

axes. Variable ‘color’ stores the string passed by uicontrol. Use strcmp to compare 

the color strings and set up the axes color corespondingly.   
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Figure 16.25 : Callback Function 

5. Run the oml script and check the result.  

 

Figure 16.26 :  Radio buttons is added in figure window 

 

Step 9: Add file selection dialog in UI   

In this section, a control object is created to save the current figure under a user-

defined directory.   

1. Add a button as we did in Step 3.    
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Figure 16.27 : Add push button  

2. Define the callback function ‘savefile’. Use uiputfile to open a file selection dialog. 

This function returns the file name and path of the targeting figure. 

‘SinePlot.bmp’ defines the default filename and format. Use gcf to get the handle 

of the current figure. Us saveas to save the figure with the filename and path 

given by user. disp displays a message in the OML command window.   

 

Figure 16.28 : Callback function to save file 

3. Run the oml script and click the Save Figure as BMP button. A dialog should pop 

out as following. Input a file name and check if the figure has been saved locally.   

 

Figure 16.29 : To select path to save file 
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16.2.2  To Obtain Step Response with a Slider 

For Various Damping Ratios for the Second Order System Provided by the User 
 

Software Code: 

clc; close all; clear 

global num1 

global den1 

figure('units', 'normalized', 'position', [0.25 0.25 0.5 0.5]) 

axes('units', 'normalized', 'position', [0.2 0.05 0.8 0.8]); 

txt1 = uicontrol('Style','text','Position',[1 45 130 30],'String','Num 

coefficients'); 

txt0 = uicontrol('Style','text','units','normalized', 'Position', [0.02 0.010 

0.86 0.04],'String','Response of a second order system for various Damping 

Ratio'); 

% %-------Add a edit box to input numerator coefficients 

txtbox1 = uicontrol('Style','edit','String','Numerator','Position',[1 70 130 

25],'callback',@func1); 

% %------Add a text uicontrol to enter denominator coefficients 

txt2 = uicontrol('Style','text','Position',[1 100 130 45],'String','Den 

coefficients'); 

% %------Add a edit box to input denominator coefficients 

txtbox2 = uicontrol('Style','edit','String','Denominator','Position',[1 135 

130 25],'callback',@func2); 

txt1 = uicontrol('Style','text','position',[320 460 100 20],'string','Damping 

Ratio'); 

txt2 = uicontrol('Style','text','position',[100 460 10 20],'string','0'); 

txt3 = uicontrol('Style','text','position',[590 460 10 20],'string','1'); 

btn=uicontrol('Style','toggle','string','Clear Fig.','Position',[1 180 120 

25],'callback', @clear_axes); 

h=uicontrol('Style','slider','min',0,'max',100,'value',75,'position',[100 

420 500 30],'callback', @uistepr); 

function [btn,h]=uistepr(handle, callbackdata) 

global num1; 

global den1; 

zeta=get(handle,'value')/100; 

time=0:0.002:5; 

num=num1; 

%den=[1 10*zeta 25]; 
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x  = den1(2)*zeta; 

den = [den1(1) x den1(3)]; 

sys = tf(num,den); 

[values,time]=step(sys,[0:0.1:10]); 

plot(time,values); 

title('Step Response') 

xlabel('Time(sec)'); 

ylabel('Amplitude'); 

hold on; 

grid on; 

end 

function func1(handle,callbackdata) 

global num1 

%----To get the numerator 

a=get(handle,'String'); 

%----To convert the numerator string to numeric 

num1 = str2num(a); 

end 

function func2(handle,callbackdata) 

global den1 

%----To get the numerator 

b=get(handle,'string'); 

%----To convert the denominator string to numeric 

den1=str2num(b); 

end 

function clear_axes(handle,callbackdata) 

 val=get(handle,'value'); 

 if val == 1 

  cla; 

 end 

end 

 
 
 
 
 
 
Simulation Results: 
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Figure 16.30 : Step Response for various Damping Ration 

 
16.2.3 Step Response/ Bode Plot/ Root Locus Using GUI 

 
Software Code: 

clc; clear; close all; 

f = figure('units', 'normalized', 'position', [0.25 0.25 0.5 0.5]) 

axes('units', 'normalized', 'position', [0.2 0.05 0.8 0.8]); 

%-------Add a text uicontrol to enter the numerator coefficients 

txt1 = uicontrol('Style','text','Position',[1 45 130 30],'String','Num 

coefficients'); 

% %-------Add a edit box to input numerator coefficients 

txtbox1 = uicontrol('Style','edit','String','Numerator','Position',[1 70 130 

25],'callback',@func1); 

% %------Add a text uicontrol to enter denominator coefficients 

txt2 = uicontrol('Style','text','Position',[1 100 130 45],'String','Den 

coefficients'); 

% %------Add a edit box to input denominator coefficients 

txtbox2 = uicontrol('Style','edit','String','Denominator','Position',[1 135 

130 25],'callback',@func2); 

% %-----Add a text uicontrol to select the response 

txt3 = uicontrol('Style','text','Position',[1 220 140 30],'String','Select the 

response'); 

% %----Add a popup menu to select the type of response the user wants to obtain 
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pop_up=uicontrol('Style','popup', 'String',{'Select','Bode Plot','Root 

Locus','step Response'},'position',[1 250 100 20],'callback',@func); 

global num1 

global den1 

function func1(handle,callbackdata) 

global num1 

%----To get the numerator 

a=get(handle,'String'); 

%----To convert the numerator string to numeric 

num1 = str2num(a); 

end 

function func2(handle,callbackdata) 

global den1 

%----To get the numerator 

b=get(handle,'string'); 

%----To convert the denominator string to numeric 

den1=str2num(b); 

end 

function func3(handle,callbackdata) 

global num1; 

global den1; 

value=get(handle,'value'); 

if (value==1) 

cla; 

w=logspace(-2,4,1000); 

bode(num1,den1,value,w)  

end 

if (value==2) 

cla; 

w=logspace(-2,4,1000); 

bode(num1,den1,value,w)  

end 

end 

function func(handle,callbackdata)  

global num1 

global den1 

sys.num=num1; 

sys.den=den1; 

%---To obtain bode plot  
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value=get(handle,'value') 

if (value==2) 

txt1 = uicontrol('Style','text','Position',[1 290 150 20],'String','Select 

required plot:'); 

list_utility = uicontrol('Style','listbox','string',{'Magnitude Plot','Phase 

Plot'},'Position',[1 310 100 50],'Value',1,'callback',@func3); 

end 

%----To obtain root locus 

if (value==3) 

rlocus(sys)  

end 

%-----To obtain step response 

if (value==4) 

cla; 

system1 = tf(num1,den1); 

[z,t]=step_response(system1);  

plot(t,z); 

grid; 

title('Step Response'); 

xlabel('Time(sec)'); 

ylabel('Amplitude'); 

end 

end 

 

User defined function for bode 

function bode(num,den,value,w) 

sys.num = num; 

sys.den = den; 

P=roots(sys.den) 

Z=roots(sys.num) 

%%%%-----------Magnitude 

if length(Z)==0 

magnitude_z=1*sys.num; 

end 

if length(Z)~=0 

temp_old_z=1; 

for j=1:length(Z) 

for i=1:length(w) 

temp_new_z(i)=sqrt((w(i))^2+(Z(j))^2); 
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end 

temp_old_z=temp_old_z.*temp_new_z; 

end 

for i=1:length(temp_old_z) 

magnitude_z(i)=temp_old_z(i); 

end 

end 

if length(P)==0 

magnitude_p=1*sys.den; 

end 

if length(P)~=0 

temp_old_p=1; 

for j=1:length(P) 

for i=1:length(w) 

temp_new_p(i)=sqrt((w(i))^2+(P(j))^2); 

end 

temp_old_p=temp_old_p.*temp_new_p; 

end 

for i=1:length(temp_old_p) 

magnitude_p(i)=temp_old_p(i); 

end 

end 

if (length(sys.num)==1) 

 z1=1; 

end 

if (length(sys.num)==2) 

 z1=gcd(sys.num(1),sys.num(2)); 

end 

if (length(sys.num)==3) 

 z1=gcd(sys.num(1),sys.num(2),sys.num(3)); 

end 

if (length(sys.num)==4) 

 z1=gcd(sys.num(1),sys.num(2),sys.num(3),sys.num(4)); 

end 

if (length(sys.num)==5) 

 z1=gcd(sys.num(1),sys.num(2),sys.num(3),sys.num(4),sys.num(5)); 

end 

magnitude=z1*(magnitude_z./magnitude_p); 

%%%%---------------Phase Angle 
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if length(Z)==0 

temp_old_ph_z=0; 

end 

if length(Z)~=0 

for i=1:length(w) 

for j=1:length(Z) 

temp_new_ph_z(j)=atan(-w(i)/Z(j)); 

end 

z1=cumsum(temp_new_ph_z); 

temp_old_ph_z(i)=z1(end); 

end 

end 

if length(P)==0 

temp_old_p_ph=0; 

end 

if length(P)~=0 

for i=1:length(w) 

for j=1:length(P) 

if P(j)~=0 

temp_new_ph_p(j)=atan(-w(i)/P(j)); 

end 

if P(j)==0 

 temp_new_ph_p(j)=atan(w(i)/P(j)); 

end 

end 

z2=cumsum(temp_new_ph_p); 

temp_old_ph_p(i)=z2(end); 

end 

end 

phase_rad=temp_old_ph_z-temp_old_ph_p; 

if value ==1 

mag_db=20*log10(magnitude); 

phase_deg=phase_rad*180/pi; %phase done in degrees 

semilogx(w,mag_db) %semilog plot 

xlabel('Frequency [rad/s]'),ylabel('Magnitude[db]'),grid on %xaxis label 

title('Magnitude Plot') 

end 

if value==2 

 phase_deg=phase_rad*180/pi; %phase done in degrees 
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 semilogx(w,phase_deg) 

 xlabel('Frequency [rad/s]'),ylabel('Phase angle [deg]'),grid on 

end 

end 

 

User Defined Function for pzmap 

function pzmap(varargin) 

if length(varargin)==1 

 sys=varargin{1}; 

 num=sys.num; 

 den=sys.den; 

end 

if length(varargin)==2 

 num=varargin{1}; 

 den=varargin{2}; 

end 

z=roots(num); 

p=roots(den); 

for i=1:length(p) 

R=isreal(p(i)); 

switch (R) 

case 1 

p1=[p(i),0]; 

p2=[p(i),0]; 

theta = atan2( p2(2) - p1(2), p2(1) - p1(1)); 

r = sqrt( (p2(1) - p1(1))^2 + (p2(2) - p1(2))^2); 

line = 0:0.01: r; 

x = p1(1) + line*cos(theta); 

y = p1(2) + line*sin(theta); 

plot(x,y,'x'); 

hold on; 

case 0 

p1=[real(p(i)),imag(p(i))]; 

p2=[real(p(i)),imag(p(i))]; 

theta = atan2( p2(2) - p1(2), p2(1) - p1(1)); 

r = sqrt( (p2(1) - p1(1))^2 + (p2(2) - p1(2))^2); 

line = 0:0.01: r; 

x = p1(1) + line*cos(theta); 

y = p1(2) + line*sin(theta); 
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plot(x,y,'x'); 

hold on; 

end 

end 

%%%%-----------------Zeros 

for i=1:length(z) 

S=isreal(z(i)); 

switch (S) 

case 1 

q1=[z(i),0]; 

q2=[z(i),0]; 

theta = atan2( q2(2) - q1(2), q2(1) - q1(1)); 

r = sqrt( (q2(1) - q1(1))^2 + (q2(2) - q1(2))^2); 

line = 0:0.01: r; 

a = q1(1) + line*cos(theta); 

b = q1(2) + line*sin(theta); 

plot(a,b,'o'); 

hold on; 

case 0 

q1=[real(z(i)),imag(z(i))]; 

q2=[real(z(i)),imag(z(i))]; 

theta = atan2( q2(2) - q1(2), q2(1) - q1(1)); 

r = sqrt( (q2(1) - q1(1))^2 + (q2(2) - q1(2))^2); 

line = 0:0.01: r; 

a = q1(1) + line*cos(theta); 

b = q1(2) + line*sin(theta); 

plot(a,b,'o'); 

hold on; 

end 

end 

end 

 

User Defined Function for rlocus 

function rlocus(sys) 

 num=sys.num; 

 den=sys.den; 

%%---------To make numerator and denominator equal length  

g=abs(length(den)-length(num)); 

if length(den)>length(num) 
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for i=length(num):-1:1 

num(i+g)=num(i); 

end 

for l=1:g 

num(l)=0; 

end 

end 

if length(num)>length(den) 

for i=length(den):-1:1 

den(i+g)=den(i); 

end 

for l=1:g 

den(l)=0; 

end 

end 

%%%------------------------- 

d=roots(den); 

n=roots(num); 

P=length(d); 

Z=length(n); 

pzmap(num,den); grid on;hold on; 

i = 1; 

for k=0:0.01:30 

 r3=den+k*num; 

 r2{i}=roots(r3); 

 i = i+1; 

end 

if P==4 && Z==0 

for k=0:2:500 

 r3=den+k*num; 

 r2{i}=roots(r3); 

 i = i+1; 

end 

end 

z2=cell2mat(r2); 

j=1; 

for k=1:length(d) 

for i=P+k:length(d):numel(z2) 

b(j)=z2(i); 
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j=j+1; 

end 

end 

scatter(real(b),imag(b),'b.'); 

title('Root Locus'); 

xlabel('Real Axis'); 

ylabel('Imaginary Axis'); 

end 

 

Simulation Results: 

Step Response: 

 

Figure 16.31 : Step Response for the user provided transfer function 
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Root Locus: 
 

 

Figure 16.32 : Root Locus of the given system 

 
Bode Plot: 
 

 

Figure 16.33 : Magnitude Plot of the given system 
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Figure 16.34 : Phase Plot of the given system 

16.2.4 Signal Operations Using GUI 

 
clc; clear; close all; 

f = figure('units', 'normalized', 'position', [0.25 0.25 0.5 0.5]) 

axes('units', 'normalized', 'position', [0.2 0.2 0.8 0.8]); 

global vector1; 

global vector2; 

%----Creates a text for the Ist sequence 

txt1 = uicontrol('Style','text','Position',[25 5 180 30],'String','Enter I st 

sequence'); 

%----Creates an edit box for the Ist sequence to be entered 

txtbox1 = uicontrol(f,'Style','edit','String','[  ]','Position',[150 5 120 

30],'callback',@func9); 

%----Creates a text for the IInd sequence 

txt2 = uicontrol('Style','text','Position',[25 40 180 30],'String','Enter II 

nd sequence'); 

%----Creates an edit box for the IInd sequence to be entered 

txtbox2 = uicontrol(f,'Style','edit','String','[  ]','Position',[150 40 120 

30],'callback',@func10); 

%---Creates a text for the operation to be selected 

txt3 = uicontrol('Style','text','Position',[400 -8 180 30],'String','Select 

the operation required'); 

%----Creates toggle buttons for various operations in signal processing 

btn1=uicontrol('Style','toggle','string','Linear 

Convolution','Position',[300 20 180 20],'callback',@func1); 

btn2=uicontrol('Style','toggle','string','Circular 

Convolution','Position',[1 150 130 20],'callback',@func2); 
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btn3=uicontrol('Style','toggle','string','Auto Correlation','Position',[1 260 

120 20],'callback',@func3); 

btn4=uicontrol('Style','toggle','string','Addition','Position',[300 50 180 

20],'callback',@func4); 

btn5=uicontrol('Style','toggle','string','Subtraction','Position',[500 50 150 

20],'callback',@func5); 

btn6=uicontrol('Style','toggle','string','Multiplication','Position',[500 20 

150 20],'callback',@func6); 

btn8=uicontrol('Style','toggle','string','Folding','Position',[1 370 80 

20],'callback',@func8); 

%---For circular conv: 

txt2 = uicontrol('Style','text','Position',[1 100 70 30],'String','No. of 

pts'); 

txtbox3 = uicontrol('Style','edit','String','[]','Position',[10 125 30 

20],'callback',@func11); 

%----Creates a text for the sequence to be autocorrelated  

txt1 = uicontrol('Style','text','Position',[1 200 130 30],'String','Seq. to 

autocorrelate'); 

pop_up=uicontrol('Style','popup', 'String',{'Select','Ist sequence','II 

sequence'},'position',[1 230 100 20],'callback',@func12); 

% %----Creates a text for folding  

txt1 = uicontrol('Style','text','Position',[1 310 130 30],'String','Sequence 

to fold');  

% %----Creates a popup menu for the sequence to be selected for folding 

pop_up=uicontrol('Style','popup', 'String',{'Select','Ist sequence','II 

sequence'},'position',[1 340 100 20],'callback',@func13); 

function func9(handle,callbackdata) 

global vector1 

%----To get the first input 

a=get(handle,'String'); 

%----To convert the input string to numeric 

vector1 = str2num(a); 

end 

function func10(handle,callbackdata) 

global vector2 

%----To get the second input 

b=get(handle,'string'); 

%----To convert the input string to numeric 

vector2=str2num(b); 
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end 

%----Implements Linear convolution 

function func1(handle,callbackdata) 

cla; 

global vector1; 

global vector2; 

val1=get(handle,'value');  %Linear convolution 

if val1==1 

x1=vector1; 

x2=vector2; 

f1=conv(x1,x2);       % Convolution of the two sequences 

disp('output of linear conv is'); 

disp(f1); 

stem(f1); 

title('Linearly Convoluted Sequence'); 

xlabel('Time index, n'); 

ylabel('Amplitude'); 

grid on 

end 

end 

global value3; 

function value3 = func11(handle,callbackdata) 

global value3 

%----To get the input 

b=get(handle,'string'); 

%----To convert the input string to numeric 

value3=str2num(b); 

end 

%---Implements Circular convolution 

function func2(handle,callbackdata) 

cla; 

global vector1; 

global vector2; 

global value3 

val2 = get(handle, 'value') 

if val2==1 

x1=vector1; 

x2=vector2; 

n=value3; 



 
 

421 
 

 

n1 = length(x1);   %Length of first sequence 

n2 = length(x2);   %Length of second sequence 

y1=fft(x1,value3);     %DFT of the sequence 

y2=fft(x2,value3); 

y3=y1.*y2; 

y=ifft(y3,n)     %Convoluted sequence in discrete domain  

stem(y);         %Second sequence plot 

title('Circularly Convoluted sequence'); 

xlabel('Time index, n'); 

ylabel('Amplitude');grid on; 

end 

end 

global x; 

function x = func12(handle,callbackdata) 

global x; 

global vector1 

global vector2 

%----To get the input 

b=get(handle,'value'); 

%----To convert the input string to numeric 

if b ==2 

 x = vector1; 

end 

 

if b ==3 

 x = vector2; 

end 

end 

% %-----Implements autocorrelation 

function func3(handle,callbackdata) 

cla; 

global vector1 

global vector2 

global x; 

val3=get(handle,'value');  %Autocorrelation 

if val3==1   

% auto correlate the signal 

Rxx=xcorr(x,x); 

% the axis for auto correlation results 
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nRxx=-length(x)+1:length(x)-1 

% display the result 

stem(nRxx,Rxx) 

title('Auto-correlated sequence') 

ylabel('Amplitude');  

xlabel('Time index,n');grid on; 

end 

end 

% %---Implements Addition 

function func4(handle,callbackdata) 

cla; 

global vector1 

global vector2 

val5 = get(handle,'value') 

if val5==1    

x=vector1;  %FIRST SEQUENCE 

y=vector2;   %SECOND SEQUENCE 

z=x+y; 

disp(z) 

stem(z);    %Added Signal 

grid on; 

xlabel('Time index, n'); 

ylabel('Amplitude'); 

title('Addition of signal 1 & signal 2'); 

end 

end 

% %----Implements Subtraction 

function func5(handle,callbackdata) 

cla; 

global vector1 

global vector2 

val6 = get(handle,'value') 

 if val6==1      

n1=0:length(vector1)-1; 

x=vector1;  %First Sequence 

n2=0:length(vector2)-1; 

y=vector2;   %Second Sequence 

n3 =min (min(n1) ,min( n2 ) ) : max ( max ( n1 ) , max ( n2 ) ); % finding the 

duration of output signal 
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s1 =zeros(1,length (n3) ); 

s2 =s1; 

s1 (find ( ( n3>=min( n1 ) ) & ( n3 <=max ( n1 ) )==1 ) )=x; 

% signal x with the duration of output signal 'sub' 

s2 (find ( ( n3>=min ( n2 ) ) & ( n3 <=max ( n2 ))==1) )=y; 

% signal y with the duration of output signal 'sub' 

sub=s1 - s2; % subtraction 

disp('Subtracted sequence') 

disp(sub) 

stem(n3,sub); 

xlabel ('Time index, n'); 

ylabel ('Amplitude');grid on; 

title('Subtracted sequence'); 

end 

end 

% %----Implements Multiplication 

function func6(handle,callbackdata) 

cla; 

global vector1 

global vector2 

val7 = get(handle,'value') 

if val7==1     

n1=0:length(vector1)-1; 

x=vector1;   %First Sequence 

n2=0:length(vector2)-1; 

y=vector2;    %Second Sequence 

n3 =min (min(n1) ,min( n2 ) ) : max ( max ( n1 ) , max ( n2 ) ); % finding the 

duration of output signal (out) 

s1 =zeros(1,length (n3) ); 

s2 =s1; 

s1 (find ( ( n3>=min( n1 ) ) & ( n3 <=max ( n1 ) )==1 ) )=x; %%signal x with 

the duration of output signal 'mul' 

s2 (find ( ( n3>=min ( n2 ) ) & ( n3 <=max ( n2 ))==1) )=y;  %%signal y with 

the duration of output signal 'mul' 

mul=s1 .* s2;      % multiplication 

disp('Multiplied Sequence')  

disp(mul)  

stem(n3,mul); 

grid; 
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title('Multiplication of two signals') 

xlabel ('Time'); 

ylabel ('Amplitude'); 

end 

end 

function x5 = func13(handle,callbackdata) 

global x5; 

global vector1 

global vector2 

%----To get the input 

b=get(handle,'value'); 

%----To convert the  string to numeric 

if b ==2 

 x5 = vector1; 

end 

 

if b ==3 

 x5 = vector2; 

end 

 

end 

% %Implements Folding 

function func8(handle,callback) 

cla; 

global x5; 

val9 = get(handle,'value') 

if val9==1   

n=0:length(x5)-1;  %given sequence plot 

c=fliplr(x5); 

y=fliplr(-n);     %folded sequence plot 

disp('folded sequence') 

disp(c) 

stem(y,c);  grid on;   %reversed sequence plot 

title('Reversed signal x(-n)') 

end 

end 
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Simulation Results: 

Linear Convolution: 

 

 

Figure 16.35 : Linear Convolution of two sequence 

 
 
Multiplication: 
 
 

 

Figure 16.36 : Circular Convolution of two sequences 
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Addition: 
 

 

Figure 16.37 : Addition of two sequences 

 
 
Subtraction: 
 

 

Figure 16.38 : Subtraction of two sequence 
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Circular Convolution: 
 

 

Figure 16.39 : Circular Convolution of two sequences 

 
 
Autocorrelation of the second sequence: 
 

 

Figure 16.40 : Auto Correlation of the given sequence 
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Folding of the first sequence: 
 

 

Figure 16.41 : Folding Operation on the given sequence 

 

 

 Frequently Asked Questions 
1. How to adjust the font size of text inside a figure. 

Initialize handle of the text and the front size can be adjusted using “set” command. 

Set can be used to set properties of different graphics objects, including root figure, 

axes, line, text, surface. Each type of graphics object has its own properties. A full list 

of properties (like font size and others) can be founded in help of “set” command. 
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Example. 

 

 

Figure 16.42 : To adjust text and the front size  

2. How to call a function in same file or in different oml file. 

Functions can be called using function name along with input arguments. 

Example: 

script 1: save the test function as test.oml 

function out = test(a,b) 

 out = a+b; 

end 

  

Way of calling the function in same file: 

test(1,3) 

out = test(1,3) 

 

To call the "test" in a different file as a script/function: 

function val = test2() 

a = 5 

b =6 

out = test(a,b) 
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val = out; 

end 

 

3. What’s the command for 3D plot? 

Use plot3 for obtaining 3-D plot. For more information Refer section 6.2 and 6.6.3. 

 

4. How to read csv files in Altair Compose. 

An example to read data line by line in Altair Compose.  

 

Figure 16.43 : To read csv file 

For more information watch the video. 

https://altairuniversity.com/learning-library/writing-different-data-types-to-file/ 

https://altairuniversity.com/learning-library/getting-started-reading-different-data-
types/ 

 

 

5. How to avoid repeating of data from previous function when evaluating the 

function for 2nd time. 

Use "clear" before evaluating the function for 2nd time. Once you execute the 

function/script, the function name will be stored in the memory space until you clear 

the memory associated with the function or you close & re- open a new instance and 

evaluate the function.  When you edited the file and saved it, the function name is still 

in memory (from previous evaluation), so when evaluated its taking the previous 

statements. 

 

https://altairuniversity.com/learning-library/writing-different-data-types-to-file/
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Example is illustrated below. 

 

Figure 16.44 : Function example 

When the same function name is used for second time. 

 

 

Figure 16.45 : Function example 
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6. How to write code for a nested function inside a function. 
 
Sample example  

 

Figure 16.46 : Eaxmple of Nested function 
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